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INTRODUCTION 
 
This document is for Consultant and State Employees responsible for working on Capital Projects.  This manual 
covers the preparation, review, and delivery of capital project documents across the whole project timeline 
from project initiation to project completion.  This manual also covers design phase scheduling.   
 
Questions or inquiries regarding the subject matter can be forwarded to the following contacts:  
 
Bruce Bourgoin P.E. 
Transportation Supervising Engineer 
AEC Applications 
HUbruce.bourgoin@ct.gov 
 
Mathew Calkins P.E. 
Transportation Supervising Engineer 
AEC Applications 
Mathew. 
mathew.calkins@ct.gov  
 
 
 
            ___________ 
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1. Definitions 

ACD – The attribute applied to a revision requested by the Processing unit to an ADP discipline subset.   
 
ACD2 – The attribute applied to a revision requested by the Processing unit to an ACD discipline subset.   
 
ADP – The attribute applied to an Addendum discipline subset. 
 
ATLAS – This tool is used to manage the location of various assets, projects, and investigations.  
 
Bluebeam – PDF software. 
 
CIM – Civil Integrated Management 
 
CSI – Construction Special provisions Institute  
 
DCD – The attribute applied to a revision requested by the Processing unit to an FDP discipline subset.    
 
DCD2 – The attribute applied to a revision requested by the Processing unit to a DCD discipline subset.    
 
Discipline Subset – A multi-page PDF document that includes all the contract plan sheets for a discipline.  
Example would be all the structures sheets would be packaged in (1) multi-page PDF document.   
 
DICO – The attribute applied to a design-initiated change order discipline subset. 
 
DPD – Digital Project Development Manual. 
 
EED – Electronic Engineering Data 
 
Engineer of Record – The engineer’s digital signature that is applied to the discipline subsets.  For CTDOT staff 
this would be the Principal Engineer.  
 
FDP –The attribute applied to a final design plans discipline subset. 
 
FIO – The attribute applied to a “for information only” discipline subset.   
 
FPL – The attribute applied to an advertised FDP discipline subset. 
 
O365 – Microsoft Office 365 
 
Project Manager – Lead designer on the project.  For CTDOT staff this is the TE 3 or Supervisor of the lead 
discipline or consultant liaison TE3 or Supervisor.     
  
Set File – Is a consolidated viewer file that is created using Bluebeam.  When this file is opened all the contract 
plans, FDP, Addendum, Change Orders, are sorted by their page labels in the correct order.  
 
S&T – COMPASS Submittals/Transmittals application. 
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2. Prerequisites and Policies 

The following details various requirements and policies that need to be followed when working on a Capital 
project for the Connecticut Department of Transportation (CTDOT).   
 
Software Requirements 

1. Document Management Software – CTDOT uses COMPASS and Office 365 for a document 
management solution.   

2. PDF Software – CTDOT has standardized on Bluebeam its PDF software. 
a. A current license of Bluebeam Revu must be purchased to perform all the procedures in this 

manual.    
b. A CTDOT Bluebeam profile is available in Appendix A.   

 
Digital Signatures Requirements 

1. All contract plans, working drawings, and applicable engineering reports submitted to the Department 
shall be digitally signed by a CT licensed Engineer or CT licensed Architect in accordance with this 
manual.   

2. Digital contract plans, including Final Design Plans (FDP), Design Completion Data (DCD), Addenda, 
Addenda Completion Data (ACD), Design Initiated Change Order (DICO), and Working Drawing (WDP) 
and all engineering reports shall be digitally signed in conformance with this manual. 

a. Digital signatures must meet the requirements of Adobe’s Certified Document Services (CDS) 
or Adobe Approved Trusted List (AATL).   

b. AATL and AATL vendor information is provided at the following website: 
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html  

c. Trial CDS/AATL Signatures will not be accepted by the Department, a signature must be 
purchased from one of the CDS/AATL Vendors.  

3. Bluebeam Revu or Extreme is required for all digital signature processes. After contract plans have 
been advertised, the digital signature is not allowed to be removed.   
 

CAD Standards 
1. Standard Computer Aided Design (CAD) Applications shall conform to those listed on the CTDOT CAD 

Standards Website. 

 
Policies 

1. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using the [Digital 
Submission Procedure set forth in this Manual] has the same force and effect for the purposes of the 
Consulting Engineer’s agreement with the State as a signature and seal of a Connecticut Licensed 
Professional Engineer or Architect as set forth in § 20-300-10 of the Regulations of Connecticut State 
Agencies or § 20-293 of the Connecticut General Statutes, as applicable. Nothing in this DPD serves as 
an authorization for, or endorsement of, the use of this [Digital Submission Procedure] generally by the 
Consulting Engineer, its subcontractor(s), or any Connecticut Licensed Professional Engineer or 
Architect with respect to other work it performs for the State or work it performs for other clients. 

2. When on call consultants are used for CTDOT projects, the title sheet shall be digitally signed by CTDOT 
following the procedure in Digital Signatures section of this manual.     

3. When a document reaches a final status a “Final Status” shall be placed on the document.  This will 
lock for editing and ensure document retention.  

  

https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html
https://portal.ct.gov/DOT/Engineering-Applications/Digital-Project-Solutions---AEC-Main-Page
https://portal.ct.gov/DOT/Engineering-Applications/Digital-Project-Solutions---AEC-Main-Page
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3. Project Creation in COMPASS 

Through the Project Generator, new Capital projects are spatially identified by drawing a polygon on a map in 
CT-Atlas 2.0 (See Section 16). The polygon is given a temporary project identifier with the initial letters of “PP” 
in its name.   
 
For any questions pertaining to CT-Atlas 2.0 or GIS licenses, create a ticket with the Eng. and Const. GIS 
Support section of the COMPASS Support Desk: 
 

 
 
Once all required steps are completed in CT-Atlas 2.0, including pressing the button to Notify Compass that 
project PPxxx-xxxx has been created (See Creating a Proposed Project), a COMPASS project page – including 
document libraries, S&T application, and all other features – will automatically generate. 
 
Note:  Projects are not promoted to a permanent project number until funding has been approved and the 
project is in the Financial Obligation Report (OBL).  Once funding is in place, the temporary project will 
graduate to a permanent project number.  This transition process (from a proposed project to a permanent 
project number) is performed in COMPASS and will be reflected by both the permanent number and proposed 
number shown in COMPASS. 

3.1. Creating a Proposed Project (PP) 
To create a new project in COMPASS, perform the following steps: 
 

1. Create the project polygon and perform all other required actions in CT-Atlas 2.0 following the 
guidance provided (See Creating a Proposed Project). This process for new projects includes all 
projects for the Bureaus of Engineering and Construction and Public Transportation.  See Public 
Transportation and Rail Projects and Planning and Emergency Declaration Projects for unique project 
promotion processes related to these project types. 
 

2. Once all necessary steps are completed in CT-Atlas 2.0, a project site will automatically generate in 
COMPASS.  It can take up to an hour for this process to complete.  Navigate to COMPASS and search 
for the project number.  A red banner will display in the COMPASS project site while the site 
provisioning process is still in progress: “Project provisioning in progress.  Some functionality will be 
limited.” 

 
3. Create a ticket with the COMPASS Support Desk providing the project number and Project Manager 

name. 

 
 

https://ctdotcompass.atlassian.net/servicedesk/customer/portals
https://ctgovexec.sharepoint.com/projects/Pages/Projects.aspx
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
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4. The COMPASS Support team will provide project site owner permissions to the Project Manager.  All 
DOT staff are automatically project site members.  (See COMPASS Project Site Permissions for details.) 
 

5. Populate the Project Staff, including the Project Initiation Staff section. 
 

6. Contact all relevant asset stewards and ensure the Work Types and Work Codes are selected properly 
on the COMPASS Project Assets page.  See ECD-2023-9-Project Asset Form for more details. 

3.2. COMPASS Project Assets 
Project assets are to be maintained for the life of a project, from the conceptual phase through construction.  
See Project Asset Form, Bridge Assets in Project Asset Form, and Traffic Signal Assets in Project Asset Form for 
more details. 
 
To view and maintain the Asset Work Types and Work Codes:   

 
1. From the COMPASS Dashboard or Details page, select the Assets tab. 

 
 

2. The Proposed Project table displays at the top of the Asset page.  The table populates 20 records at a 
time.  If more than 20 assets are listed, use the scroll arrows to advance through the records. 

 
 

3. Select one or more asset records from the Proposed Project table by checking the box(es).  Press the 
Update Asset Info button. 

 
 

https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2023-9_Eng-Cons_Dir_PAF_final_sah.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2023-9_Eng-Cons_Dir_PAF_final_sah.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ECB-2023-4_Eng-Cons_Bulletin_PAF_Bridge_2023_10_01_final_jaf.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ECB-2023-5_Eng-Cons_Bulletin_PAF_Traffic_Sig_jaf.pdf
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4. An Update Bridge Assets window appears.  Select the appropriate Work Type and Work Code(s) from 
the drop-down menus.  Only one Work Type can be selected.  One or more Work Codes can be 
selected, as needed.  Press Save. 

  
 

5. The Work Type and Work Code columns will update to reflect the information selected.  The Updated 
and Updated By columns auto-populate the with the date and name of person who made the most 
recent update.   
 

Additional notes: 

• Columns in the Proposed Project table can be sorted alphanumerically. 

• Assets cannot be added or deleted in the COMPASS project page.  To add or remove project assets, 
make the appropriate revision in CT-Atlas 2.0 (See Managing Assets and Geometry). 

3.3. Proposed Project Information (PPI) Form 
1. Before beginning the PPI process, 

a. Verify the Project Initiation Staff section of the Project Staff information is correct.  The 
individual completing the PPI Form must be included in the Project Initiation Staff. 

b. Verify all COMPASS Project Asset information is correct. 
 

2. Navigate to the Details tab on the COMPASS project site. 

 
 

3. Select Establish Project Number button.  This opens the blank PPI form. 
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4. Populate all the fields in the PPI form.  Ensure all fields in the PPI form are filled out before pressing 
Save Data.  The Title, Description, Justification, and Comments fields have a 255-character limit.  
Press the Save Data button when complete. 

 
 

5. A PPI PDF document will automatically generate and save in the 600 Project Initiation Documents 
folder.   

 
 

6. Route the document for signature via the S&T using the guidance provided in Attach Files to a 
COMPASS S&T Envelope and Correspondence and Memoranda in COMPASS.  For digital signature 
guidance, see Signing and Editing PDFs in Office 365. 

3.4. Cancel a Proposed Project 
To cancel a proposed project, create a ticket with the COMPASS Support Desk, providing: 

• The proposed project number.  Verify that the correct proposed project is provided.  Once the 
project cancellation process is completed, it cannot be undone. 

• The cancellation reason. 

• A request to cancel the project. 
 
Once the cancellation process is complete, the cancelled date will display in the DATES section on the right side 
of the Project Details page.  Click on the cancelled date to view the cancellation reason. 

 

3.5. Promote a Proposed Project to a Permanent Project 
Project assets are to be maintained for the life of a project, from the conceptual phase through construction.  
Once funding is approved and the Engineering and Construction project is in the Financial Obligation Report 
(OBL), it can be promoted to a permanent project.  See Public Transportation and Rail Projects and Planning 
and Emergency Declaration Projects for unique project promotion processes related to these project types. 
 
Do not use the Select a Project Number drop-down field.   

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Attach-Files-to-an-Envelope.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Attach-Files-to-an-Envelope.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Correspondence-and-Memoranda-in-COMPASS.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Signing-in-Office-365.aspx
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
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To request a proposed project be promoted to a permanent project: 
 

1. Verify the scope of the project matches what is portrayed in CT-Atlas 2.0 (e.g., assets, polygons, etc.). 
 

2. Create a ticket with the COMPASS Support Desk, providing: 
a. The proposed project number. 
b. The permanent project number. 
c. The project manager. 
d. A request for project promotion. 

 
 

3. The COMPASS Support team will review and promote if the project passes the necessary criteria or 
provide feedback if any changes are required.  Note:  The project site URL will not change when the 
project is promoted; it will continue to contain the proposed project number (PPxxx-xxxx), not the 
new permanent project number. 
 

4. Once the promotion process is complete, update the name of the MS Project Schedule to reflect the 
permanent project number. 
 

Note:  The COMPASS Project Site Permissions groups and project site URL will continue to reflect the PP 
number for the life of the project, even after promotion to a permanent project number.  For example, if 
PP123-4567 is promoted to permanent project 9876-5432, the site permissions groups for that project will 
remain as PP123-4567 for the duration of the project. 

3.6. Public Transportation and Rail Projects  
For Public Transportation and Rail projects NOT in the CTDOT Obligation Plan, complete the following steps to 
create and promote a project in COMPASS. 
 

1. Complete all necessary steps in CT-Atlas 2.0 as described in Creating a Proposed Project. 
 

2. Once all necessary steps are completed in CT-Atlas 2.0, a project site will automatically generate in 
COMPASS.  It can take up to an hour for this process to complete.  Navigate to COMPASS and search 
for the PP project number.  A red banner will display in the COMPASS project site while the site 

https://ctdotcompass.atlassian.net/servicedesk/customer/portals
https://ctgovexec.sharepoint.com/projects/Pages/Projects.aspx
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provisioning process is still in progress: “Project provisioning in progress.  Some functionality will be 
limited.” 
 

3. Navigate to Public Transportation and Rail Project Data Form.  If you do not have access to this form, 
please put in a request to the DOT.Helpdesk@ct.gov  
 

4. Create the new project using the permanent project number, adding all relevant project data to the 
form. 

   
5. Create a ticket with the COMPASS Support Desk, providing: 

a. The proposed project number. 
b. The permanent project number. 
c. The project manager. 
d. A request for project promotion. 
e. Date when the Public Transportation and Rail Project Data Form was completed.  Note:  It 

takes approximately 48 hours from the time that the Public Transportation and Rail Project 
Data Form is completed until the project promotion process can take place.      

 
 

f. The COMPASS Support team will review and promote to the permanent project number.  
Note:  The project site URL will not change when the project is promoted; it will continue to 
contain the proposed project number (PPxxx-xxxx), not the new permanent project number.  

 
5. Populate the Project Staff, including the Project Initiation Staff section. 

 
6. Contact all relevant asset stewards and ensure the Work Types and Work Codes are selected properly 

on the COMPASS Project Assets page.  See ECD-2023-9-Project Asset Form for more details. 

3.7. Planning and Emergency Declaration Projects in the OBL 
For Planning and Emergency Declaration projects, complete the following steps to create and promote a 
project in COMPASS. 
 

1. Complete all necessary steps in CT-Atlas 2.0 as described in Creating a Proposed Project. 
 

2. Once all necessary steps are completed in CT-Atlas 2.0, a project site will automatically generate in 
COMPASS.  It can take up to an hour for this process to complete.  Navigate to COMPASS and search 
for the project number.  A red banner will display in the COMPASS project site while the site 
provisioning process is still in progress: “Project provisioning in progress.  Some functionality will be 
limited.”   

   
3. Confirm the project is in the Obligation Report (OBL), then create a ticket with the COMPASS Support 

Desk, providing: 
a. The proposed project number. 
b. The permanent project number. 

https://publictrans.dot.ct.gov/
mailto:DOT.Helpdesk@ct.gov
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
https://publictrans.dot.ct.gov/
https://publictrans.dot.ct.gov/
https://publictrans.dot.ct.gov/
https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2023-9_Eng-Cons_Dir_PAF_final_sah.pdf
https://ctgovexec.sharepoint.com/projects/Pages/Projects.aspx
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
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c. The project manager. 
d. A request for project promotion. 
e. Indicate whether it is a Planning or Emergency Declaration project. 

 
 

1. The COMPASS Support team will review and promote to the permanent project number.  Note:  The 
project site URL will not change when the project is promoted; it will continue to contain the 
proposed project number (PPxxx-xxxx), not the new permanent project number. 
 

2. Populate the Project Staff, including the Project Initiation Staff section. 
 

3. Contact all relevant asset stewards and ensure the Work Types and Work Codes are selected properly 
on the COMPASS Project Assets page.  See ECD-2023-9-Project Asset Form for more details. 

3.8. Pause or Complete a Permanent Project 
The project phase displayed for COMPASS projects automatically displays and updates to reflect the phase in 
the CTDOT Construction Management System (e.g., Site Manager, AASHTOWare, etc.).  In some situations, a 
project manager may need to manually pause or compete a project.   
 
To pause or complete a project, any DOT staff can perform the following steps: 
 

1. Go to COMPASS Projects, or the dashboard, details or landing page of any COMPASS project site.  This 
process cannot be performed via the COMPASS S&T page. 

 
2. Navigate to the gear → Site Contents. 

 
 

https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2023-9_Eng-Cons_Dir_PAF_final_sah.pdf
https://ctgovexec.sharepoint.com/projects/Pages/Projects.aspx
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3. Choose Project Phase Override. 

 
 
 

4. Press New. 

 
 

5. Complete the New item field. 
a. Enter the project number in the XXXX-XXXX format (including leading zeroes). 
b. Select either Completed or Paused from the Project End Date Reason drop-down menu. 
c. In the Notes and Details fields, provide the reason for completing or pausing the project, along 

with any other relevant information. 
d. Verify information is correct, then press Save. 
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6. To reactivate a paused or completed project, create a ticket with the COMPASS Support Desk. 
 
 
 
 
 
 
 
 
 
 
  

https://ctdotcompass.atlassian.net/servicedesk/customer/portals
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4. Document Management System 

CTDOT uses COMPASS and Office 365 for document management.  The objective of COMPASS is to provide 
CTDOT with project management processes that work in conjunction with a cloud-based digital Transportation 
Management Solution, utilizing Microsoft Commercial Off-the-Shelf Software (MCOTS) to manage the delivery 
of all capital projects.  Specifically, this solution will provide improved quality and control over complex 
transportation projects by providing: 

• Submittal and Transmittal Ball-In-Court tracking 

• Better collaboration and communication using SharePoint online. 

• Real-time project scheduling capabilities using integrated MS Project  

• Improved resource management 

• Real-time project status dashboards 

• Document control and content management 

• Improved transparency and accountability 

• Improved risk management 

4.1. COMPASS Overview  
COMPASS is a cloud-based application built on Microsoft SharePoint pages.  CTDOT users are provided with a 
CTDOT O365 license which is used to access COMPASS and all other DOT O365 applications.  External user 
invitations are sent to non-CTDOT personnel – such as consultants and contractors – to grant project-specific 
site access. 
 
Presently, COMPASS provides a single place to display the following project information: 

• Rights-of-Way 

• Environmental Permits 

• CORE data 

• Viewport data 

• Composite Project Database (CPD) 

• Submittal/Transmittal Application 

• Project Staff Management 

• MS Project Schedule Integration 

• Document Storage/Control 

• Security/User Management 
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The Microsoft Online sign-in page for CTDOT staff is located at https://www.office.com, or is typically 
associated with CTDOT default browser windows. 

 
 

Sign-In Name 
For CTDOT personnel, user sign-in names match the ct.gov email address. 
 

Sign-In Password 
For CTDOT personnel, user sign-in passwords match email passwords.  If the email password is changed, the 
Microsoft Online password is automatically changed. 

 

COMPASS is supported by the Edge and Chrome browsers. 

 

For CTDOT users, to enter the main COMPASS landing page: 
1. Log-in to Office 365. 
2. Navigate to SharePoint. 

 
3. Search for Projects.  This location can also be accessed directly via COMPASS.  Tip:  Follow this site in 

O365 or save the site as a bookmark/favorite in an internet browser window. 

https://www.office.com/
https://ctgovexec.sharepoint.com/projects/Pages/Projects.aspx
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4.2. Project Folder Structure and Required Documents for Capital Projects 
This section details the project folder structure and the required project documents that must be submitted 
for each project.  The figure below illustrates a CTDOT project folder structure for a Capital Project.  See 
COMPASS Permissions Model for details on folder permissions. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/COMPASS-Permissions-Model(1).aspx
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Note:  In the case where two or more projects are combined or advertised as one project, all contract 
documents for these projects will be submitted into the lowest numbered project in COMPASS. 
   

Project Folder Structure and List of Project Documentation 

DESIGN LIBRARY 

The folders in the Design Library are intended to store CAD files and working documents for designers. 
For more information on working with CAD files stored in COMPASS, please see the CTDOT Digital Design 
Environment (DDE) Guide Section 3 - Configuration and Worksets.   

CONTRACT DOCUMENTS LIBRARY 

100_Contract_Plans (PDF) – This folder is in the Contract Documents library and contains only final Contract 
Plans, which includes the following.  There shall not be any working documents uploaded into this folder. 

• Final plans 

• Addendum plans  

• Design Initiated Change Order plans. 

• As-Built plans 

• Electronic Engineering Data (EED) – Final Prepared by AEC Applications 

110_Contract_Documents – This folder is in the Contract Documents library and shall only contain the 
following final documents.  The only working file allowed in this folder is the Contractor Submittal List.  This list 
is to be maintained through the life of the project per ECD-2020-1_Contractor_Submittals.pdf. 

• Signed Contract 

• Pre-Bid Questions and Answers 

• Contract Special Provisions – Final, Addendum, and Design Initiated Change Order special provisions.   

• State and Federal Minimum Wage Rates and Classifications. 

• SOM (Source of Materials) 

• Insurance documents 

• Pre-Award DBE Review – Specific Contractor 

• Bonds  

• Contractor Submittal List 

125_Completed_Submittals – This folder is in the Contract Documents library.  Contractor submittals – with 
the exceptions of Payrolls – automatically relocate to this folder from the 120_Contractor Submittals (PDF) 
folder when marked complete.  This folder is read-only.  Documents cannot be directly updated to or modified 
in this folder.  

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-001---Overview/Section-3---Configuration-and-Worksets#WORKSETS
https://portal.ct.gov/-/media/DOT/documents/AEC/Contractor-Submittal-List.xlsx
https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2020-1_Contractor_Submittals.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/Contractor-Submittal-List.xlsx
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Project Folder Structure and List of Project Documentation 

130_Final _Engineering Reports – This folder is in the Contract Documents library and contains all the final 
engineering reports.  There shall not be any working documents uploaded into these folders.  Note: Ensure file 
names in this folder: 1) do not include any special characters and 2) accurately and intuitively describe the 
document. 

• Hydraulic  
o Hydraulic Report and Hydraulic Report Data 
o Scour Report and Scour Report Data 
o Floodway Report and Floodway Report Data 
o Final Drainage Reports and Final Drainage Report Data 
o USGS Bridge and Channel Assessment Reports 
o Miscellaneous Technical Data, Studies, Investigations or Reports 

• Environmental Compliance  
o Task 110 
o Task 210 
o Task 310 
o Underground Storage Tank System Closure Reports 

• Bridge 
o Load Rating 

• Geotechnical 
o Geotechnical Report Project files - including test boring, laboratory testing data file, and 

computations 
160_Project Photos – This folder is in the Contract Documents library and is where all project photos and 
videos shall be stored.  Both engineering and construction photos shall be stored in this folder.    

INTERNAL DOCUMENTS LIBRARY 

120_Contractor_Submittals (PDF) – This folder is in the Internal Documents library and contains the following: 

• Shop Drawings 

• Product Data Sheets 

• Product Samples 

• Coordination Drawings 

• Working Drawings 

• Requests for Entitlement 

• Correspondence from Contractor 

• RFIs 

• RFCs 

• Schedules 

• Payrolls 

• Material Testing 

• Quality Assurance Submittals 

• Operation and Maintenance Manuals 

• Spare Parts Transmittals 

• Landscape Submittals 
When contractors create submittals, all documents automatically uploaded to this folder. 

140_Project_Administration – This folder is in the Internal Documents library and is the storage location for 
final permanent milestone project administration documents.  These project administration documents can be 
defined as, but not limited to, deliverables such as agreements, project approvals, project scope, regulatory 
documents, design phase schedules, etc.  There shall not be any draft documents uploaded into this folder.    

• Agreements – Utility, Railroad, Municipal, etc.  
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Project Folder Structure and List of Project Documentation 

• Categorical Exclusion 

• Certification Acceptance Checklist 

• Commitment list 

• Consultant Selection Documents – Scope of Services, Notice to Proceed, etc. 
• Construction Incidental Cost Establishment Report 

• DBE/SBE Approval with percentage, participation level 

• Design Approval 

• Design Exceptions 

• Design Phase Microsoft Project Schedule - COMPASS 

• Draft Noise Analysis Report 

• Environmental Impact Study – EIS 

• Final Design Report 

• Final Noise Analysis Report 

• Finding of No Significant Impact - FONSI 

• Lighting Agreement 

• Record of Decision – ROD 

• Rehabilitation Study Report 
• Risk Management Documents 
• RPM – Request for Project Memorandum  

• Sidewalk Maintenance Agreement 

• Standalone Transportation Management Plan Document, taken from the final design report. 
• Stewardship Agreement 
• Structure Type Study 
• Waiver to Obligate Funds 

• White Papers  

142_Project Administration Correspondence – This folder is in the Internal Documents library and is for all 
final project correspondence documents.  This is defined as any request memos, response memos, letters, etc., 
and does not include any documents that are defined in the 140_Project Administration folder.  This folder 
shall not include any working/draft documents.   

• Meeting Minutes 

• Request Memos – Survey Request, Design Reviews, Support unit design.    

• Response Memos – Response to the Request Memos 

150_Quantity Calculations – This folder is in the Internal Documents library and is where all the final quantity 
calculations for contract items shall be stored. 

• FDP Estimate Quantity Computations 

151_Final Design Calculations – This folder is in the Internal Documents library and is where all the final design 
calculations shall be stored. 

170_ROW Files - This folder is in the Internal Documents library and is where the final property maps shall be 
stored until they are uploaded into the IRMS.   Also, the project polygons and parcel polygons file shall be 
stored here. 

210_Construction – This folder is in the Internal Documents library.  See Construction Documentation for more 
information. 

• 01 – Project Documents 
o Semi and Monthly Payment Estimates 
o Construction Orders with Backup 
o Copies of Cost-Plus Sheets with backup 
o All Delivery Tickets, Bituminous Concrete, Processed Aggregate Base, Concrete, etc. 
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Project Folder Structure and List of Project Documentation 

o Material Certifications, etc. (All Laboratory Reports) 
o Nuclear Density Test and Data Sheets (CON-125, 133) 
o Pile Driving Logs (CON-87) 
o Environmental Correspondence, Logs, etc. 
o Utility Forms (CON-40 and 41) 
o Contractor Payrolls 
o EEO/AA Reports (30-60-90s) 
o Labor Wage Checks (CON-131) 
o Hazardous Waste Manifests 
o Stores Requisitions and Transfer Vouchers 
o Purchase Orders and Requisitions 
o Correspondence 
o Computer Disks - properly labeled. 
o Any Other Related Records 
o Town Correspondence File - Includes: 

▪ General Material 
▪ Request for and response to matters concerning highway, bridge, signing, lighting, etc. 

by town officials. 
▪ Written commitments to first officials and/or elected, appointed state, federal 

officials. 
▪ Mapping Prepared by district or filed with district. 

• 02 – Internal Documents 
o Consultant Ratings 
o Other Sensitive Documents 
o This folder has unique permissions.  See COMPASS Permissions Model for details. 

• 03 – Measurements and Payments 
o Field Books (all) Volumes 1,2,3, & 4s 

• 04 – Consultant Negotiations 
o Consultants Billings with Backup 
o Sensitive documents pertaining to CEI negotiations. 
o This folder has unique permissions.  See COMPASS Permissions Model for details. 

• 05 – Environmental  
o USACE Work Start Notification Form 

o USACE Compliance Certification Form 

o APA/Watershed Resource Maps 

o CTDEEP De Minimis Change Request 

o CTDEEP De Minimis Change Approval 

o CTDEEP Notice of Non-Compliance/Notice of Violation 

o CTDEEP Non-Compliance Monitoring Reports 

o CTDEEP Work Commencement Form 

o CTDEEP Compliance Certification Form 

o CTDEEP Permit Notification Correspondence 

o CTDEEP Site Inspection Reports & ROM’s 

o CTDEEP/USACE Permit Extension Request 

o CTDEEP/USACE Permit Extension Approval 

o CTDEEP/USACE Time-of-Year Waiver Request 

o CTDEEP/USACE Time-of-Year Waiver Approval 

https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fctgovexec.sharepoint.com%2Fteams%2FAEC%2FSitePages%2FCOMPASS-Permissions-Model(1).aspx&data=05%7C01%7CLynne.Hassey%40ct.gov%7C734ec1c4b0d8437b75d908db41043557%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638175258550919470%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=88C8qFkPpn9XCCWl9mfl2Wm1REiPB6oswbs7DQrLXBo%3D&reserved=0
https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fctgovexec.sharepoint.com%2Fteams%2FAEC%2FSitePages%2FCOMPASS-Permissions-Model(1).aspx&data=05%7C01%7CLynne.Hassey%40ct.gov%7C734ec1c4b0d8437b75d908db41043557%7C118b7cfaa3dd48b9b02631ff69bb738b%7C0%7C0%7C638175258550919470%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=88C8qFkPpn9XCCWl9mfl2Wm1REiPB6oswbs7DQrLXBo%3D&reserved=0
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Project Folder Structure and List of Project Documentation 

o CTDEEP/USACE Emergency Authorization Request 

o CTDEEP/USACE Emergency Authorization Approval 

o CTDEEP Emergency Authorization Extension 

o Complaints 

o OEP Routine Inspection Report 

o OEP Semifinal Inspection Report 

o District Weekly / Routine Inspections (CSEIR) 

o CTDEEP Stormwater Notice of Termination Form 

o Wetland Mitigation As-Builts 

o USCG Deviation Letters 

o Submittals Satisfying CTDEEP/USACE Special Conditions 

211_Materials Testing – This folder is in the Internal Documents library.  Follow guidance provided in the 
Materials Evaluation and Specifications Unit (MESU) COMPASS Construction Bulletin. 

220_FHWA – This folder is in the Internal Documents library and is used by the FHWA for their purposes. 

230_Contract_Administration – This folder is in the Internal Documents library and is used by the CTDOT 
Contracts unit. 

240_Contract_Development – This folder is in the Internal Documents library and is the location where the 
Designer uploads the following supplemental contract documents: 

• All contract special provisions and Notice to Contractors (NTC), in Word format, both final and 
addendum special provisions.  All contract special provisions shall be uploaded to the subfolder FDP 
Specs.  No other documents shall be uploaded to the FDP Specs subfolder except the contract special 
provisions and NTCs in Word format. 

• If the project contains CSI specifications, the designer is to create a sub-folder to the 240_Contract 
Development folder named CSI Specs and upload all CSI specifications to this location.  No other 
documents shall be uploaded to the CSI Specs subfolder except the CSI specifications NTCs in Word 
format.  See Design Review Phase for instructions on how to create the CSI Specs folder. 

• Estimator Proposal Estimate  

• Calendar Day Estimate 

• Electronic Engineering Data Files uploaded by the Designer. 

• Permit Applications and Approvals 

310_Milestone_Submissions – This folder is in the Internal Documents library and is the location where the 
designer shall submit all milestone submission documents.  This includes plans, special provisions, reports, 
estimates, etc. This folder has sub-folders for 30, 60, 90, and 100 submissions. 

320_Permit_Development – This is in the Internal Documents library and can be used to store documents for 
the development of permits.  Note: At FDP, the permit applications and approvals must be uploaded into the 
240 Contract Documents folder.   The processing unit then adds the permits and applications to the contract 
and uploads the contract into the 110 Contract Documents folder.  

• Permits Needs Determination Form (PNDF) 

• Wetland Flagging Coordination  

• Natural Diversity Database (NDDB) Coordination  

• CTDEEP Fisheries Correspondence   

• LEAN Meeting Minutes 

• Project Manager Meeting (PMM) Minutes  

• Permit Review Comments 

• Responses to Permit Review Comments 

600_Project Initiation Documents – This folder is in the Internal Documents library and is where any project 

https://portal.ct.gov/-/media/DOT/documents/AEC/CB-2023-5_MESU-COMPASS-Workflows_final_signed.pdf
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Project Folder Structure and List of Project Documentation 

initiation documents can be stored.  This would include any plans developed by the Project Concepts unit or 
any other documents created in the project concepts phase.   

CONFIDENTIAL DOCUMENTS LIBRARY 

131_Engineering_Reports_Confidential –This folder is in the Confidential Documents library and is only seen 
by a select number of people.  

• Bid Analysis 

141_Project_Administration_Confidential – This folder is in the Confidential Documents library and shall be 
used for documents that only CTDOT should have access to.   

• Consultant Payroll information 

231_Contract_Administration_Confidential – This folder is in the Confidential Documents library.  Access is 
limited to the CTDOT Contracts Unit. 

241_Contract_Development_Confidential – This folder is in the Confidential Documents library and contains 
the final engineers estimate and calendar day estimate developed by the cost estimating unit. 

• Final Engineers Estimate 

• Final Calendar Day Estimate 

4.3. COMPASS Project Site Permissions 
Access to COMPASS project sites is provided using site permission groups.  Each permission group has a unique 
set of rights and restrictions. 
 
CTDOT personnel and FHWA are automatically added to all COMPASS site members groups.   
 
The Project Manager will be added to the site owners permissions group (full control of site) when a ticket is 
created during the project creation process (see Creating a Proposed Project (PP)).  The Project Manager (PM) 
is responsible for granting and maintaining project site access for all consultants, contractors, and 
stakeholders.  The PM may also choose to invite another team member(s) to the site owners group and 
delegate the site permissions management role to that individual(s).   
 
It is recommended to limit the number of staff in the site owners group.  The majority of CTDOT and 
consultant staff will remain in the site members permissions group. 

 

There are four permissions group per project:  Site Owners, Site Members, Site Stakeholders and Site 
Contractors.  There is a program-wide Compass Owners group which is not to be edited or changed by project 
staff. 
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4.3.1.1 Site Owners Group – xxxx-xxxx Owners 
Staff added in this group have full control of the site, including the ability to add, edit or delete documents.  
Site owners are responsible for maintaining site permissions.  It is recommended that two staff from design 
and two from construction are in the project site owners’ group.  If staff rotates off of a project, the site owner 
leaving the project should be removed and the replacement added to this permissions group.  All site owners 
should review the Restricted Elements to ensure actions are not taken which compromise the project site. 

4.3.1.2 Site Members Group – xxxx-xxxx Members 
Site Member is the most common group used for CTDOT staff and consultants.  Individuals who need to review 
submittals and access document folders should be added to the site members group.  Construction 
Contractors should not be added to the site members group; they should be added to the Site Contractors 
Group.  External users invited to join a project should follow the instructions provided in Accepting an 
Invitation (External Users).  CTDOT and FHWA personnel automatically have access to all COMPASS project 
sites and do not need to be invited individually.  CTDOT staff have access via the DOT-CompassDOTUsers 
group; FHWA has access via the DOT Compass – Regulatory Partners Members group.  These groups are added 
to every project site members group and should not be deleted or modified by the site owners. 

4.3.1.3 Site Contractors Group – xxxx-xxxx Contractors 
Users in the Site Contractors permissions group can create new submittals in the COMPASS S&T application 
and respond to requests to revise and resubmit.  Contractors cannot access the Comments/Log or document 
version history.  Contractors are limited to viewing submittals in the Submittals / Transmittals table that a 
member of the Contractors group created, or for which that individual is the Ball in Court (BIC).  If multiple 
members are included in this group, they will see each other’s submittals in the S&T table.  The project 
Contractor(s) should be added to this group.  The COMPASS Contractor's User Manual provides instructions to 
Contractors on how to accept invitations and use the COMPASS S&T application. 

4.3.1.4 Site Stakeholders Group – xxxx-xxxx Stakeholders 
Users in the Site Stakeholders permissions group can create new submittals in the COMPASS S&T application 
and respond to requests to revise and resubmit.  They cannot the Comments/Log or document version history.  
Stakeholders are limited to viewing submittals in the Submittals / Transmittals table that they individually 
create.  Typical stakeholders include railroad representatives, towns, utilities, and other agencies. 

4.3.1.5 Compass Owners 
Compass Owners are a limited number of program-wide administrators representing various design units and 
construction districts.  To add or remove a Compass Owner, please create a ticket with COMPASS Support.  Do 
not add or remove individuals from this group.   

4.3.1.6 COMPASS Permissions Model 
See COMPASS Permissions Model for design library and folder permissions. 

https://portal.ct.gov/-/media/DOT/documents/AEC/COMPASS-Contractors-User-Manual.pdf?la=en
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/COMPASS-Permissions-Model(1).aspx
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4.3.1.7 Site Permissions Summary Table 
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Invite or remove users from site permissions groups X X    

Delete a submittal as the submittal owner X X X   

Delete a submittal on behalf of another user (proxy) X X    

Reopen a complete S&T envelope (internal CTDOT staff only) X X    

Start, edit, revise & resubmit, or complete a review cycle as the submittal owner X X X   

Start, edit, revise & resubmit, or complete a review cycle on behalf of another user (proxy) X X    

Start or finalize a Bluebeam Studio Session as the submittal owner X X X   

Start or finalize a Bluebeam Studio Session on behalf of another user (proxy) X X    

Modify the Approval Matrix X X    

View the Approval Matrix X X X   

Function as submittal owner per the Approval Matrix for Contractor submittals X X X   

Function as submittal owner for internal-internal or internal-external submittals X X X   

View and add posts to the submittal Comments/Log X X X   

Access the Dashboard and Details pages* X X X   

Create a submittal X X X X X 

Replace a submittal document in response to an R&R X X X X X 

Review a submittal (Submittal Reviewer Section) X X X X X 

Contribute documents to a submittal at any time in the review workflow X X X   

Reassign or add reviewers to a review assignment (Submittal Reviewer Section) X X X   

Approve or Reject Uploads as the submittal owner X X X   

Approve or Reject Uploads on behalf of another user (proxy) X X    

Delink files from a submittal envelope as the submittal owner X X X   

Delink files from a submittal envelope on behalf of another user (proxy) X X    

View document version history X X X   

Modify/edit files in the 125_Completed_Submittals folder X     

*Pre-approved consultants who cannot access the Dashboard and Details pages should fill out the form Getting Started 
with SharePoint for Consultants (ct.gov) to gain access to these pages and enable improved collaboration in COMPASS. 

 

The project manager or delegated staff member is responsible for maintaining the site permissions throughout 
the duration of the project.  There are two ways to access the project site permissions. 

4.3.2.1 Site Settings Gear 
To access the Site Settings menu via the gear: 

1. Navigate to the project Submittals/Transmittals page. 

https://portal.ct.gov/DOT/Engineering-Applications/Getting-Started-with-SharePoint-for-Consultants
https://portal.ct.gov/DOT/Engineering-Applications/Getting-Started-with-SharePoint-for-Consultants
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2. Click the Gear in the upper right-hand corner of the Submittals/Transmittals page. 

 
 

3. Select Site Settings. 

 
 

4. Select Site Permissions. 
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5. Select the xxxx-xxxx Contractors, xxxx-xxxx Members, xxxx-xxxx Owners or xxxx-xxxx Stakeholders 

permissions group, as appropriate.  Do not make any changes to the Compass Owners group.  Note:  

Projects which begin in COMPASS as proposed projects (PPxxx-xxxx) will display the proposed 

project number in the site permissions groups, even after site promotion.  For example, if PP123-

4567 is promoted to permanent project 9876-5432, the site permissions groups for that project will 

remain as PP123-4567. 

 
 

6. To add a new member to the group, press New → Add Users. 

 
 

7. Invite users to the project site as follows: 

a. CTDOT personnel:  CTDOT staff already has access to all project sites and does not need to be 

individually invited, unless they are being granted site owner permissions.  Please see Site 

Members Group – xxxx-xxxx Members for more details. 

b. FHWA personnel:  FHWA staff already has access to all project sites and does not need to be 

individually invited.  Please see Site Members Group – xxxx-xxxx Members for more details. 

c. Pre-Qualified Consultants:  There are two methods of inviting consultants (including CLE, 

design consultants, and CE&I) to COMPASS project sites.  See  Managing Pre-Approved BOEC 

Consultant Project Site Permissions for details. 

d. Other external users, including Construction Contractors, Stakeholders, etc.:  Invite the user 

via their company email address.   

 

Multiple users can be invited at a time.  By default, an email invitation will be sent to new users that 

includes an optional personal message.  To avoid sending an email notification, click Show Options and 

uncheck the box “Send an email invitation.”   Email invitations should not be forwarded between 

users; a separate invitation should be sent to each external user who requires site access. 

 

Once the names, email addresses, optional personal message and optional email invitation selection 

are complete, press Share.   
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4.3.2.2 Site Settings URL 
Site permissions can also be maintained by navigating directly to the site permissions URL address for a given 
project.   
 
For proposed projects and permanent projects which began in COMPASS as proposed projects, go to the 
below URL, replacing the numbers highlighted in red with the relevant proposed project number.  The URL 
does not change when the project is promoted to a permanent project; it remains as the PP proposed 
project number: 
 

https://ctgovexec.sharepoint.com/projects/PP033-0008/_layouts/15/user.aspx 
 
For permanent projects that did not start in COMPASS as proposed projects, replace the numbers highlighted 
in red with the relevant project number: 
 

https://ctgovexec.sharepoint.com/projects/0055-0130/_layouts/15/user.aspx 
 

Follow steps 5-7 as described in the Site Settings Gear section to add users to the appropriate permissions 

groups. 

 

Tip:  Site owners responsible for maintaining permissions on multiple project sites may choose to 

bookmark/favorite the above URLs to their browser.   

4.3.2.3 Restricted Elements 
Site owners should not make any restricted changes to project sites. 

4.3.2.3.1 Restricted Element – Settings Menu 
Do not use any of the functionality under the Settings menu. 

https://ctgovexec.sharepoint.com/projects/PP033-0008/_layouts/15/user.aspx
https://ctgovexec.sharepoint.com/projects/0055-0130/_layouts/15/user.aspx
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4.3.2.3.2 Restricted Element – Permissions Ribbon 
Do not use the menu items in the Inheritance, Grant, Modify or Manage sections of the ribbon.  Do not delete 
permissions, grant new permissions, or create new permissions groups.  The Check Permissions button can be 
used to query the permission of an individual for that project site. 

 
 

4.3.2.3.3 Restricted Element – Modifying Site Styles 
Do not use the Browser, Page, or Publish option in the ribbon.  Best practice:  Keep the ribbon hidden to avoid 
accidentally selection one of these options.   

 
 
To hide the ribbon, go to the Gear -> Hidden Ribbon. 
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4.3.2.3.4 Restricted Element – Unique Permissions 
Do not remove the two groups included in all project site members groups: 

• CTDOT staff:  DOT-CompassDOTUsers group 

• FHWA staff (Connecticut):  DOT Compass – Regulatory Partners Members 
 
Do not modify any of the unique folder permissions established program-wide, as noted in the COMPASS 
Permissions Model (sharepoint.com). 

 

External users (e.g., Contractors, Consultants, Stakeholders, etc.) invited to join a COMPASS project site will 
need to take the following steps to accept a COMPASS invitation.  External users should never forward their 
invitations to other users.  A unique invitation needs to be sent to each user requiring project site access. 
 
If other individuals need access to a COMPASS project site, a request should be sent to the PM.   
 
Note:  Depending on the user’s email settings, the email notification may route to the SPAM or Junk folder or 
display in the “Other” section in Outlook. 
 

1. The external user will receive an email invitation with a direct link to the project page. 

 
 

2. On the SharePoint Online invitation acceptance page,  

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/COMPASS-Permissions-Model(1).aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/COMPASS-Permissions-Model(1).aspx
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a. External users with an existing work / company Office 365 account should click Organizational 

Account and log-in using their company Office 365 username and password. 

b. External users without an existing Microsoft account should select “Create a Microsoft 

account” and follow the steps to set-up a new, free account using the email address to which 

the invitation as sent. 

 

 

Consultant staff is typically invited to the Site Members Group on a given COMPASS project site.   

4.3.4.1 Managing Pre-Approved BOEC Consultant Project Site Permissions 
COMPASS project site owners have two options for managing pre-approved BOEC consultant site access. 

4.3.4.1.1 Inviting Individual Consultants to a Project Site 
Individual consultants can be invited to project sites in the same manner as CTDOT staff or other external 
users.  Consultants should be invited via their company email address. 

4.3.4.1.2 Inviting Consultants by Company Using Dynamic Groups 
Project site owners have the option of inviting pre-qualified consultants via unique domain name.   
 
Only use this option for the site members permissions group.  Do not user for the site owners group. 
 
To use this option, the following elements are required: 

• Company is a pre-qualified BOEC consultant.  Please see Prequalified Consultants for Year 2024 
(ct.gov) for list. 

• Individual consultant staff must complete Getting Started with SharePoint for Consultants (ct.gov). 
 

https://www.dotdata.ct.gov/consultant/consult.aspx
https://www.dotdata.ct.gov/consultant/consult.aspx
https://portal.ct.gov/DOT/Engineering-Applications/Getting-Started-with-SharePoint-for-Consultants
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4.3.4.2 BOEC Consultant Access – Required Forms 
All consultants:  To better collaborate in COMPASS and view some frequently requested documentation, pre-
approved Bureau of Engineering and Construction (BOEC) Consultants should follow the instructions provided 
in Getting Started with SharePoint for Consultants (ct.gov).  Completing this form provides access to many 
resources, including: 

• COMPASS Dashboard, Details and Asset tabs 

• Access to CTDOT Owned Special Provisions 

• Access to DOT BOEC Consultants - Home (sharepoint.com) 

• Ability for CTDOT Site Owners to manage permissions via company domain. 
 
For OneDrive sync only:  For consultants who need to sync to OneDrive for use of CAD files or other needs, 
please see guidance provided at M2.1 Obtaining Access to SharePoint (ct.gov). 

4.4. Navigating COMPASS 
For CTDOT users, follow the instructions provided in COMPASS Overview to log-in to Office 365 and access 
COMPASS. 

 

4.4.1.1 Searching for Projects 
Once on the COMPASS Home Page, search or filter by Project Number, Project Name, Project Manager or 
Schedule Phase.   

• Multiple Project Managers and / or Schedule Phases can be selected at the same time.   

• Click Reset Filters to clear all filters and begin a new search. 

https://portal.ct.gov/DOT/Engineering-Applications/Getting-Started-with-SharePoint-for-Consultants
https://ctgovexec.sharepoint.com/sites/DOTBOECConsultants
https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-001---Overview/Obtaining-Access-to-SharePoint
https://ctgovexec.sharepoint.com/projects/Pages/Projects.aspx
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• Click the Filter / Search Projects arrow to collapse or expand the filtering section. 

 
 

• If a search produces multiple results, scroll between the Project Landing Pages by using the up and 

down arrows located on the upper-right hand side of the page. 

 

 

 

The following resources can be accessed from each Project Landing page: 
1. Project Dashboard 

2. Project Details   

3. Copy Project URL – Copies the project site URL to the clipboard. 

4. COMPASS Submittal/Transmittal Application 

5. MS Project Schedule   – The MS Project schedule button will only be active if there is an associated 

schedule and if the user has an MS Project Online license.  See COMPASS Software License 

Requirements for details.   
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The following information resides on each Project Landing page: 

• Project Description 

• Schedule details including number of tasks remaining, overall schedule health and current Schedule 

Phase   

• Permit and ROW status. 

• Key dates for the project – Open in CORE and FDP 

• Staff assigned to the project with their contact details. 

• Budget donut graphs – Roll over the graph sections to view monetary details. 

• Funding data 

 

4.4.3.1 Accessing the Project Dashboard 
The Project Dashboard can be reached from the Project Landing page, Project Details page, or Submittals / 
Transmittals page by clicking the Project Dashboard button. 

 

4.4.3.2 Project Dashboard Contents 
The following resources can be accessed from the Project Dashboard: 

1. Project Menu 

2. Project Details 

3. Submittals/Transmittals 

4. Assets 
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The following information resides on each Project Dashboard: 

• Project Description 

• Project Value – roll over graph sections to view monetary details. 

• Project Schedule FDP dates – obligation date, MS Project Schedule date and the associated delta 

• Project Expenditures Graph (PEG) (under construction) 

• Permitting status 

• Rights of Way status 

 

4.4.4.1 Accessing the Project Details Page 
The Project Details page can be reached from the Project Dashboard, Project Landing page, Submittals / 
Transmittals page, or Assets page by clicking the Project Details button. 

 

4.4.4.2 Project Details Contents 
The following resources can be accessed from the Project Details page: 

1. Project Menu 

2. MS Project Schedule  – The MS Project schedule button will only be active if there is an associated 

schedule and if the user has an MS Project Online license.  See COMPASS Software License 

Requirements for details.   

3. Staff 
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4. Assets 

5. Related Projects – Programs that include multiple projects provide links to the Related Project(s) on 

the Details page. 

6. Collapsibility – Various sections of the Project Details page can be collapsed and expanded for ease of 

viewing.  

 
 
The following information resides on each Project Details page: 

• Town(s) 

• Project Description 

• Schedule details including number of tasks remaining, overall schedule health and current Schedule 

Phase   

• MS Project schedule milestone details 

• Permitting and ROW details 

• Budget donut graphs – Roll over the graph sections to view monetary details. 

• Funding data 

 

Project staff is to be regularly maintained in COMPASS per the Managing Project Staff in COMPASS Engineering 
& Construction Directive.  See Managing Project Staff in COMPASS for more information. 

 

The Project Menu – located on the left side of Dashboard and Details pages – is comprised of the following 
sections.  For the four document libraries, Project Folder Structure and Required Documents for Capital 
Projects and COMPASS Permissions Model (sharepoint.com) for more details. 

• Contacts:  The Contacts list can be used to add contact information for project staff, stakeholders, 

agencies, or other relevant users. 

• Design:  Document library.   

• Contract Documents:  Document library.   

• Internal Documents:  Document library.   

• Confidential Documents:  Document library.   

https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2019-12_Compass.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2019-12_Compass.pdf
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Managing-Project-Staff.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/COMPASS-Permissions-Model(1).aspx
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• Project Emails:  Project-related emails that need to be memorialized can be saved to the Project Emails 

folder.  The contents of this folder are viewable to those with project site access.  Highly confidential 

project emails that require more restricted access should not be stored in this location. 

• OneNote:  The OneNote tab provides a project-specific OneNote notebook.  Project staff can use this 

OneNote to document project notes, meeting minutes, action items, or other information as needed. 

 

4.5. CTDOT Staff Contact, Organization, and Status Information 
For easy access to CTDOT staff information and communication links, click on the staff name in the Ball In 
Court column of the S&T table, or the assigned reviewer name in the Workflow section of an S&T envelope.  
Information that displays for CTDOT staff, in a manner similar to Outlook, includes: 

• Contact information 

• Organization (org chart) information 

• Automatic replies as established in Outlook (e.g., out of office replies, if relevant) 

• Quick links to send an email or start a Teams chat with the CTDOT staff 
 

 
For non-CTDOT staff, information is more limited and typically includes name and email address. 
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5. Digital Project Processes  

5.1. Processes by Project Phase 
The following shows the processes included in this manual separated by project phase.  Also included in this 
table is a link to the process map that corresponds to each document/process:    

Project Initiation Phase 
Document/Process Requirements 

Project Schedule • Project Schedule should be set up in accordance with Design Phase Project 
Scheduling    

Preliminary Design Phase 

Preliminary 
Contract Plans 

• Plans shall be grouped in accordance with Contract Plan Grouping 

• Plans shall be formatted in accordance with Contract Plan Format   
 

Preliminary 
Contract Special 

Provisions 

• Contract Special Provisions shall be prepared in accordance with Contract Special 
Provisions 

Cost Estimate • Cost Estimates shall be prepared in accordance with Estimates and Quantity 
Calculations     

Preliminary Design 
(30%) Review 

• Design Reviews shall be accomplished in accordance with Section 10 Digital Review 
and Commenting      

Project Schedule • Project Schedule should be set up in accordance with Section 11 Design Phase 
Project Scheduling          

Permit 
Applications/ 
Documents 

• Shall be uploaded and formatted in accordance with Environmental Permits     

Rehabilitation 
Study Reports 

• Shall be uploaded and formatted in accordance with Engineering Reports   

Structure Type 
Studies 

• Shall be uploaded and formatted in accordance with Engineering Reports   

Categorical 
Exclusion 

• Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents       

Design Exception • Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents       

Design Approval 
Letter 

• Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents       

Project 
Correspondence 

• Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents       

Project Polygon • Shall be prepared and uploaded in accordance with Project Location (Geo-Spatial 
Boundary or Route ID and Mileage) 

Final Design Phase 
Document/Process Requirements 

Contract Plans • Plans shall be grouped in accordance with Contract Plan Grouping 

• Plans shall be formatted in accordance with Contract Plan Format   

Contract Special 
Provisions 

• Special Provisions shall be prepared in accordance with Contract Special Provisions 

Engineering 
Reports 

• Engineering Reports shall be prepared in accordance with Engineering Reports   
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Project Schedule • Project Schedule should be set up in accordance with Design Phase Project 
Scheduling   

Cost Estimate • Preliminary Cost Estimates shall be prepared in accordance with Estimates and 
Quantity Calculations 

Permit 
Applications/ 

Approvals 

• Shall be uploaded and formatted in accordance with Environmental Permits     

Design Calculations • Design Calculations shall be submitted in accordance with Design Calculations 

Semi Final (60%) 
and Final Design 
(90%) Reviews 

• Design Reviews shall be accomplished in accordance with Section 10 Digital Review 
and Commenting 

Quantity 
Calculations 

• Quantity Calculations shall be submitted in accordance with Estimates and Quantity 
Calculations     

Final Design Report • Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

Final Design 
Statement 

• Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

Sidewalk 
Maintenance 
Agreement 

• Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

Lighting Agreement • Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

DBE/SBE Goals • Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

Commitment List • Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

Waivers • Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

Standalone 
Transportation 

Management Plan 

• Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

Project 
Correspondence 

• Shall be uploaded and formatted in accordance with Project Administration and 
Project Correspondence Documents        

Contract Processing Phase 
Document/Process Requirements 

FDP 

Contract Plans • Plans shall be grouped in accordance with Contract Plan Grouping 

• Plans shall be formatted in accordance with Contract Plan Format 

• Plans shall be checked by the PDF Checker 

Contract Special Provisions • Special Provisions shall be prepared in accordance with Contract 
Special Provisions 

Proposal Estimate • Preliminary Cost Estimates shall be prepared in accordance with 
Estimates and Quantity Calculations 

Federal Estimate • Preliminary Cost Estimates shall be prepared in accordance with 
Estimates and Quantity Calculations 

Calendar Day Estimate • Calendar Day Estimate shall be prepared in accordance with Estimates 
and Quantity Calculations 

Permit Applications/ • Shall be uploaded and formatted in accordance with Environmental 
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Approvals Permits     

Ordering Paper Copies of 
Contract Documents 

• Paper copies of contract documents can be ordered in accordance with 
Paper Plans 

EED • Shall be prepared and uploaded in accordance with Electronic 
Engineering Data (EED) 

Project Polygon • Shall be prepared and uploaded in accordance with Project Location 
(Geo-Spatial Boundary or Route ID and Mileage) 

DCD 

Contract Plans • Plans shall be grouped in accordance with Contract Plan Grouping 

• Plans shall be formatted in accordance with Contract Plan Format 

• Plans shall be checked by the PDF Checker 

Contract Special Provisions • Special Provisions shall be prepared in accordance with Contract 
Special Provisions 

Proposal Estimate • Preliminary Cost Estimates shall be prepared in accordance with 
Estimates and Quantity Calculations 

Federal Estimate • Preliminary Cost Estimates shall be prepared in accordance with 
Estimates and Quantity Calculations 

Calendar Day Estimate • Preliminary Cost Estimates shall be prepared in accordance with 
Estimates and Quantity Calculations 

Permit Applications/ 
Approvals 

• Shall be uploaded and formatted in accordance with Environmental 
Permits     

Addendum 

Contract Plans • Plans shall be prepared in accordance with Contract Plan and Special 
Provision Revisions (Addenda and Design Initiated Change Order) 

Contract Special Provisions • Special Provisions shall be prepared in accordance with Contract Plan 
and Special Provision Revisions (Addenda and Design Initiated Change 
Order) 

EED • Shall be prepared and uploaded in accordance with Electronic 
Engineering Data (EED) 

Award Phase 
Signed Contract • Signed Contract will be uploaded into COMPASS in accordance with 

section xx. 

Construction Phase 
Document/Process Requirements 

Contractor 
Submittals 

• Contractor submittals shall be uploaded in accordance with Contractor 
Submittals 

Contract Plans • Plans shall be prepared in accordance with Contract Plan and Special Provision 
Revisions (Addenda and Design Initiated Change Order) 

Contract Special 
Provisions 

• Special Provisions shall be prepared in accordance with Contract Plan and Special 
Provision Revisions (Addenda and Design Initiated Change Order)  

DICO Memo • DICO memo shall be prepared in accordance with Design Initiated Change Order 
(DICO) 

Plan As-Builts • Plan As-Builts shall be accomplished in accordance with As-Built Comments - 
Final Plans 

Project 
Correspondence 

• Shall be uploaded and formatted in accordance with  Project Administration and 
Project Correspondence Documents        

EED • Shall be prepared and uploaded in accordance with Electronic Engineering Data 
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(EED) 

Project Polygon • Shall be prepared and uploaded in accordance with Project Location (Geo-Spatial 
Boundary or Route ID and Mileage) 

 

The Department’s Print Shop has closed. The following alternative duplicating methods are available, if 

necessary: 

• All routine photocopies can be performed on the multifunction copiers throughout the Department. 

• Specialized duplication services and business cards can be ordered through DAS Printing 

Services.  https://portal.ct.gov/DAS/Services/For-State-Employees/Print-Mail-and-Courier-Services 

• Project plans/specs and wide-format prints should be printed on the wide-format printers located 

throughout the Department or utilize State Contract 19PSX0006, Document Imaging Services.  

https://webprocure.proactiscloud.com/maincontractboard/contractviewdoc.do?docid=696&eboid=51

&&mimeType=application/pdf&docName=Contract%20Award.pdf&docUniqueName=Contract%20Aw

ard.pdf&contract=463 

Questions can be addressed to Deb Ello at debra.ello@ct.gov or 860-594-2257. 

  

https://portal.ct.gov/DAS/Services/For-State-Employees/Print-Mail-and-Courier-Services
https://webprocure.proactiscloud.com/maincontractboard/contractviewdoc.do?docid=696&eboid=51&&mimeType=application/pdf&docName=Contract%20Award.pdf&docUniqueName=Contract%20Award.pdf&contract=463
https://webprocure.proactiscloud.com/maincontractboard/contractviewdoc.do?docid=696&eboid=51&&mimeType=application/pdf&docName=Contract%20Award.pdf&docUniqueName=Contract%20Award.pdf&contract=463
https://webprocure.proactiscloud.com/maincontractboard/contractviewdoc.do?docid=696&eboid=51&&mimeType=application/pdf&docName=Contract%20Award.pdf&docUniqueName=Contract%20Award.pdf&contract=463
mailto:debra.ello@ct.gov
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6. Document Preparation and Format 

6.1. Contract Plan Grouping 
Contract plans shall be grouped by discipline into individual multiple page PDF files called discipline subsets.  
The project manager is tasked with determining the discipline subset numbering and grouping and whether to 
use a single volume or multiple volumes for the project.   Discipline subset file sizes shall be a maximum of 
60MB.  The following details each of these options: 
 
Single volume digital contracts are used when each discipline or consulting firm designing the project is 
responsible for 3 subsets or less.  The following is an example of a single volume project.   

Note:  The first and second subsets shall always be 01-General and 02-Revisions.  The 03 subset does 
not always need to be 03-Highways, the 04 does not always need to be 04-Structure, etc.  FIO subsets 
shall be numbered at the end of the project before the standard subsets.   The Standards subsets shall 
not be numbered.   

 
Multiple volumes are used if the project has 1 or more of the following characteristics: 

a. Most of the discipline/firm designers are responsible for more than 3 subsets each.  This allows the 
individual designers to number their subsets independently of the other disciplines. 

b. There are multiple sites on the project.  Splitting these sites up into volumes will provide better 
organization of the project.   

c. Combining multiple projects into one project.  
The larger the project is, typically the more subsets will be required, and their labels will be more specific.   The 
subsets shall be split up by volume and each volume shall be controlled by its assigned designer.   For example, 
all the subsets designed by the highway designer shall be in the same volume (02) and each subset shall have a 
unique subset number. 

Note:  The first and second subsets when using multiple volumes shall always be 01.01-General and 
01.02-Revisions.  The 01.03 subset does not always need to be 01.03-Highways, the 01.04 does not 
always need to be 01.04-Structure, etc.  FIO subsets shall be numbered at the end of the project 
before the standard subsets.   The Standards subsets shall not be numbered.   

Combining Projects 
In the event 2 or more projects are combined into one project, the following shall be done: 

• Each project shall be given its own volume. 

• The lowest project shall always be volume 1.   

• Each project shall have its own title sheet, which reference each other with a note.   

• There shall only be (1) Revisions subset.  This subset shall be in volume 1 and named 01.02 – Revisions. 

• The Revisions subset shall be the responsibility of the project manager on the projects.   

• Each project shall have its own detailed estimate sheets.   

• There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when the projects are 
combined.   

• There shall not be any duplicate special provisions after the projects are combined.  

• There shall only be (1) calendar day chart. 
 
The next two figures show examples of the single volume and multiple volume options.   

Single Volume Option 
 

Label 

(Discipline Subset) 

File contents 

(but not limited to) 

01-General Title Sheet  
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Detail Estimate Sheet 

02-Revisions 

Index of Revisions Sheets  

03-Highways 

Index of Plans 

Survey Data 

Alignments 

ROW 

Typ. Sections 

Misc. Details 

Intersect Grading 

Boring Logs 

Highway Plans 

Breakout Drainage 

Highway Profile 

Highway X-Sections 

Landscape Plan 

Wetland Mitigation 

04-Structure 

Index of Drawings 

All Structure Sheets  

Note: Multiple subsets may be required for multiple Sites 

Ex: 04_Structure_Br.No.1266 

05-Traffic 

Index of Drawings 

Signing 

Pavement Markings 

MPT 

Traffic Signal Plans 

Etc. 

06-Environmental 
Index of Drawings 

All Environmental Compliance Sheets required 

07-Utiltiy Utility Design plans.  For example, 07_AT & T, 07_CL & P, 07_MDC, 
etc.   

08-CL&P FIO** CL & P For Information Only plans 

09-AT&T FIO** AT & T For Information Only plans 

 CTDOT Highway STD CTDOT Highway Design Standard Index and Sheets required 
CTDOT Traffic STD CTDOT Traffic Engineering Standard Index and Sheets required 

 
* If a discipline must be broken up into more than one subset, keep the label the same with the addition of “1” 
at the end of the first subset, “2” at the end of the second subset, etc.  
** For Information only discipline subset shall be submitted as individual pdf files based on the entity providing 
the information only.   
 

Multiple Volume Option 
  

Label 

(Discipline Subset) 

File contents 

(but not limited to) 

Designer/ 

Firm 

01.01-General Title Sheet, Detail Estimate Sheet Lead 

01.02-Revisions Index of Revision Sheets Lead 

01.03-Wtlnd Re-establish Wetland Reestablishment plans Designer 1 

01.04-Stg Acc. Staging and Access Plans Designer 1 

02.01-Typ Sections Typical Sections Designer 2 

02.02-Alignments Alignment Geometry Designer 2 

02.03-Plan Plans Designer 2 

02.04-Profiles Profiles Designer 2 

02.05-ROW Brk Right of Way Breakout Designer 2 

02.06-Drain Drainage Plans Designer 2 
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03.01-Retaining Wall 1 Retaining wall details Designer 3 

03.02-Retaining Wall 2 Retaining wall details Designer 3 

03.03-Bridge 00456 Bridge_456 Designer 3 

03.04-Bridge 01983 Bridge_1983 Designer 3 

03.05-Bridge 01984 Bridge_1984 Designer 3 

04.01-Stage 1 Stage Construction Details 1 Designer 4 

04.02-Stage 2 Stage Construction Details 2 Designer 4 

04.03-Stage 3 Stage Construction Details 3 Designer 4 

05.01-SPM Signing and Pavement Marking Site 1 Designer 5 

05.02-SPM Signing and Pavement Marking Site 2 Designer 5 

05.03-SPM Signing and Pavement Marking Site 3 Designer 5 

06.01-IMS IMS Plans and Details Site1,2,3 Designer 6 

07.01-Env 1 Environmental Details Site 1 Designer 7 

07.02-Env 2 Environmental Details Site 2 Designer 7 

07.03-Env 3 Environmental Details Site 3 Designer 7 

08.01-” Utility Utility Design plans.  For example, 07_AT & T, 07_CL & P, 07_MDC, etc.   Designer 8 

09.01-CL&P FIO CL & P For Information Only plans Designer 8 

09.02-AT&T FIO AT & T For Information Only plans Designer 8 

CTDOT Highway STD *CTDOT Highway Design Standard Index and Sheets required Designer 1 

CTDOT Traffic STD  CTDOT Traffic Engineering Standard Index and Sheets required Designer 5 

6.2. Contract Plan Format 
Digital contract plans (preliminary, semi-final, FDP, ADP, DICO, etc.) shall be formatted in accordance with the 
following: 

1. Contract Plans shall be in submitted to CTDOT in PDF format. 
2.  PDF Plans must be sized either 36” x 24” for projects created before June 2007 or sized 34” x 22” for 

projects created after June 2007 
3. PDF plans shall be measurable to scale in the PDF. 
4. PDF plans shall be able to be printed to paper and scaled appropriately. 
5. Text must be searchable. 
6. All levels must have the ability to be displayed on or off, unless approved otherwise.   
7. All information on the digital contract PDF plans shall have been created from Bentley Software or an 

approved alternate.  The only information that shall be added to the plans using a PDF editing 
software are as follows: 

• Page labels   

• Sheet numbers  

• Watermarks and flatten comments.  

• Any digital signature fields.  

• Digital Signature  
8. Discipline subsets shall be published directly from a CAD application. Scanned images or raster image 

formats will not be accepted except For Information Only sheets, these can be scanned.    See 
Publishing CAD Files  for more instructions on how to publish from Bentley Software.    

9. Each discipline subset shall contain bookmarks; one for each page. 
10. The first page of each subset shall be a subset cover sheet, this includes FIO subsets.  This cover sheet 

shall contain both; an index of drawings contained within the subset that includes both drawing 
numbers and drawing titles and the form field place holder(s) which receives the digital signatures.  

https://portal.ct.gov/-/media/DOT/documents/AEC/CAD_SelectSERIES/publishingmicrostationpdf.pdf
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This table must include the subset name and number displayed as a heading in the table as shown in 
the figure below.   

 
 

11. The first page of the subset 01_General shall be the CTDOT digital project title sheet which includes an 
index of the subsets contained within the project, sheet count totals for all subsets, a list of drawings 
for the 01_General Subset, and an area(s) reserved for applying the digital signature(s).  Consultants 
will need to delete the CTDOT signature blocks on the title sheet and place a digital signature 
placeholder. 

12. The 01-General subset shall include all detailed estimate sheets.   
13. The 02_Revisions subset must be included in each digital project and there shall only be (1) revision 

subset.    
14. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions.”  These revision 

sheets are used for tracking all sheet changes due to addenda and design-initiated change order 
(DICO) with respect to the entire project. These sheets are originally blank and unsigned and shall be 
managed and updated as needed by the Project Manager. The CTDOT Revision Contract Sheets can be 
obtained here: 

  CTDOT Designed Projects – 02-Revisions 
  Consultant Designed Projects – 02-Revisions 

15. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based on the entity 
providing the information, Amtrak, CL & P, AT&T, Designer etc.  These subsets do not require a digital 
signature, but each sheet in the subset shall be labeled; “For Information Only”. The subset numbers 
shall be selected by the lead designer so that the FIO subsets are last.  Each sheet shall be numbered 
correctly.  

16. Utility drawings shall be submitted in accordance with the following:   

• Utility plans For Information Only (FIO) shall be submitted in a utility subset based on the 
utility company, AT&T subset, CL&P subset, etc.  These subsets do not require a digital 
signature, but each sheet shall be labeled; “For Information Only”.  FIO utility subsets shall be 
numbered so that they are the last subsets. Example Labels; 10_CL&P_FIO, 11_AT&T_FIO.  
These subsets must have page labels assigned. 

• Utility company designed plans that include work being done by the State’s Contractor shall be 
submitted in a utility subset based on the utility company, AT&T subset, CL&P subset, etc.  
These subsets do not require a digital signature.  Example Labels; 10_CL&P, 11_AT&T.  These 
subsets must have page labels assigned. 

https://portal.ct.gov/-/media/DOT/documents/AEC/02-revisions.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/02-revisions.pdf
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• Utility plans that are designed by a Consultant firm that include work being done by the States 
Contractor shall be submitted in a utility subset based on the utility company, AT&T subset, 
CL&P subset, etc., and shall be digitally signed in accordance with this manual. Example Labels; 
10_CL&P, 11_AT&T.  These subsets must have page labels assigned. 

17. CTDOT Standard sheets shall also be delivered digitally.   
18. Footers, displaying the sheet number, shall be placed on each page of each PDF subset.  
19. As-built information shall be digitally applied to the contract subsets by District Personnel after the job 

is complete using Bluebeam.   
20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section, but do not 

need to be digitally signed.  These review documents shall be uploaded into the 
310_Milestone_Submission folders in COMPASS. 

21. A Bluebeam set file shall be created at FDP and updated for any addendums or change orders. 
22. Contract Plan subsets, FDP, DCD, DCD2, ADP, and DICO, must be checked by the Discipline Subset PDF 

Checker. 

6.3. CTDOT For Information Only Sheets 
Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets based on the entity 
providing the information, Amtrak, CL & P, AT&T, Designer etc.  These subsets do not require a digital 
signature, but each sheet in the subset shall be labeled; “For Information Only”.  The first sheet of each FIO 
subset shall be a subset cover sheet.  These sheets shall be placed on a border and numbered.   
 
The subset numbers shall be selected by the Project Manager so that the FIO subsets are last.  for uploading 
and attributing FIO Plans. Information only sheets may be scanned, but must conform to the following:  

• Minimum Size 22”x34” 

• Minimum dpi = 300.   

6.4. CTDOT Standard Plan Sheets 
Standard sheets shall also be delivered digitally into COMPASS using the Submittals/Transmittals application. 
The following shows how to obtain the latest version of the CTDOT Standard Sheets and how to prepare them 
for a digital project. 

1. Download the latest standards from the following link for the project:  CTDOT Standard Drawings 
Website 

2. Upload the standard subset into COMPASS in accordance. 
3. Next open the standards from COMPASS by double clicking on it.  Once it opens click on the index 

sheet. 

 
 

4. Then enter the project number and check the standards to be included in the project.   

http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
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5. Delete the standards that are not included in the project as shown below: 

 
6. Next digitally sign all index sheets. 
7. Then upload the standards into the 100_Contract Plans folder in COMPASS. 

6.5. Contract Special Provisions  
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1. Digital Contract Special provisions shall be submitted in MS Word format.  See Contract Development 
to access Owned Special Provisions and Instructions and Templates for Special Provisions.  CSI special 
provisions shall be submitted in pdf format.  

2. FDP and Addendum special provisions and CSI special provisions shall be submitted to CTDOT in 
accordance with the following: 

• The complete specification section or special provision shall be reissued when a specification 
section or special provision is modified.  A vertical line in the right margin, to allow for quickly 
identifying changes or deletions made, shall appropriately mark all revisions. 

• FDP, revised FDP special provisions, Addendum special provisions, and revised addendum 
special provisions shall be uploaded into the 240_Contract_Development folder under the 
project in COMPASS. 

3. Design Initiated Change Order special provisions shall be prepared and submitted in accordance with 
the following: 

• The complete specification section or special provision shall be reissued when a specification 
section or special provision is modified.  A vertical line in the right margin, to allow for quickly 
identifying changes or deletions made, shall appropriately mark all revisions. 

• On each sheet of the revised specification, “C#” shall be placed in the bottom right corner of 
the footer.   For example, “C1” 

• The consultant or state design Project Manager shall follow guidance for submission of DICO 
specifications. 

6.6. Estimates and Quantity Calculations 
Estimates 
Cost Estimates shall be prepared in accordance with the procedures detailed on this website: 
Cost Estimating 
 
Preliminary cost estimates shall be uploaded into the 310_Milestone Submissions folder under the applicable 
project. 
 
Final Proposal and Federal Estimates shall be uploaded into the 240_Contract_Development folder under the 
applicable project. 
 
Calendar Day estimates shall be uploaded into the 240_Contract_Development folder under the applicable 
project. 
 
Quantity Calculations 
Quantity Calculations shall be formatted and submitted in accordance with the following: 

• Shall be native PDF whenever possible. 

• Scanned pages shall be readable and have a minimum resolution of 200 dpi.    

• Pages in the PDF can be any size.  8.5” x 11” is recommended. 

• Shall be uploaded into the 150_Quantity Calculations folder under the applicable project in COMPASS. 

6.7. Environmental Permits 
Environmental permit applications, permit approvals, and other permit documents shall be uploaded into 
COMPASS and formatted in accordance with the following: 
Permit Need Determination Form (PNDF) and Other Permit Documents 

• Shall be native PDF whenever possible. 

• The PNDF shall be uploaded into the 320_Permit_Development Folder under the project in COMPASS. 
Environmental Permit Applications: 

http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
https://portal.ct.gov/DOT/Engineering-Applications/Submissions---Cost-Estimating


Connecticut Department of Transportation – Digital Project Development Manual

46 
 

• Shall be native PDF whenever possible. 

• Scanned pages in the application must have a maximum resolution of 200 dpi and a minimum of 125 
dpi. 

• All pages, except plans sheets, shall be sized 8.5” x 11”.  Plan sheets can be sized up to 34” x 22”.    

• Before FDP, each permit application shall be in an individual multi-page PDF file.  Each permit shall be 
then uploaded into the 320_Permit_Development Folder under the project COMPASS. 

• At FDP, all approved individual multi-page PDF files shall be uploaded into the 
240_Contract_Development folder under the project in COMPASS. 

Environmental Permit Approval 

• Shall be native PDF whenever possible. 

• Scanned pages in the permit must have a maximum resolution of 200 dpi and a minimum of 125 dpi. 

• Shall be sized 8.5” x 11”. 

• Before FDP, each permit approval shall be in an individual multi-page PDF file.  Each permit shall be 
then uploaded into the 320_Permit_Development Folder under the project in COMPASS. 

• At FDP, the individual multi-page PDF files be uploaded into the 240_Contract_Development folder 
under the project in COMPASS. 

6.8. Contractor Submittals  
See Contractor Submittals for format, submittal, and review requirements for Contractor Submittals such as 
Working Drawings, Shop Drawings, Product Data Sheets, RFIs, and RFCs.  

6.9. Engineering Reports 
Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in accordance with the following: 

• Shall be native PDF whenever possible. 

• Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi. 

• All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 34” x 22”.  

• Shall be digitally signed and watermarked. 

• Any data files that must accompany the PDF report shall be uploaded into COMPASS in a zipped folder.   

• The reports and zipped folder for any data files shall be submitted into the 130_Engineering_Reports 
folder under the applicable project. 

• The final status shall also be applied. 

• Preliminary reports shall be uploaded into the 310_Milestone_Submissions folder in COMPASS.  
Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be formatted in accordance 
with the following.  The content of the report shall be in accordance with the Scope defined by the Division of 
Environmental Compliance: 

• Shall be native PDF whenever possible. 

• Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi. 

• All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 34” x 22”.  

• Shall be digitally signed. 

• These reports shall be submitted into the 130_Engineering_Reports folder under the applicable project 
in COMPASS. 

• Preliminary reports shall be uploaded into the 310_Milestone_Submissions folder in COMPASS.  
Rehabilitation Study Reports and Type Study Reports:  Shall be created and formatted in accordance with the 
Bridge Manual: 

• Final reports shall be uploaded into the 140_Project_Administration folder in COMPASS.    

• Preliminary reports shall be uploaded into the 310_Milestone_Submissions folder in COMPASS.   
Bridge Load Ratings:  Shall be created and formatted in accordance with the Bridge Load Rating Manual: 

• Final load ratings shall be digitally signed. 

https://portal.ct.gov/-/media/DOT/documents/dpublications/bridge/Division-1/Division-1-Standard-Design-Practices-Complete.pdf?la=en
https://portal.ct.gov/DOT/State-Bridge-Design/Load-Rating/Load-Rating
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• Final reports shall be uploaded into the 130_Engineering_Reports folder in COMPASS.    

• Preliminary reports shall be uploaded into the 310_Milestone_Submissions folder in COMPASS.   
Geotechnical Reports: 

• Shall be native PDF whenever possible. 

• Scanned sheets in the reports must have a maximum resolution of 200 dpi and a minimum of 125 dpi. 

• All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized up to 34” x 22”.  

• These reports shall be submitted into the 130_Engineering_Reports folder under the applicable 
project. 

• Preliminary reports shall be uploaded into the 310_Milestone_Submissions folder in COMPASS.  

6.10. Project Administration and Project Correspondence Documents 
Project Administration Documents 
Final project administration documents shall be stored in the 140_Project_Administration folder under the 
project in COMPASS in accordance with the following: 

• Shall be in PDF Format. 

• Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125 dpi. 

• The document must be uploaded into COMPASS.   

• Draft project administration documents can also be created and worked on in COMPASS.  These files 
shall be located under the user’s discipline the Design library in COMPASS.  

Project Correspondence Documents 
Project correspondence documents shall be stored in the 142_Project Administration Correspondence folder 
under the project in COMPASS in accordance with the following:    

• Shall be in PDF Format. 

• Scanned documents must have a maximum resolution of 200 dpi and a minimum of 125 dpi. 

• The document must be uploaded into COMPASS. 
 
This folder is for all final project correspondence documents.  This is defined as any request memos, response 
memos, emails, letters, etc. and does not include any documents that are defined in the 
140_Project_Administration folder.  This folder shall not include any working/draft documents.   

• Emails – The sender of the email is required to store a PDF of the email message in COMPASS.   

• Letters 

• Meeting Minutes 

• Request Memos – Survey Request, Design Reviews, Support unit design.    

• Response Memos – Response to the Request Memos 

6.11. Project Location (Geo-Spatial Boundary or Route ID and Mileage) 
The project location shall be prepared and submitted in accordance with CT Asset Tracking & Location System 
(ATLAS). 

6.12. Design Calculations 
Design Calculations for all structural elements on a project shall be formatted and submitted in accordance 
with the following: 

• Shall be native PDF format whenever possible.   

• Scanned pages shall be readable and have a minimum resolution of 125 dpi.    

• Pages in the PDF can be any size.  8.5” x 11” page size is recommended. 

• Shall be uploaded into the 151_Final Design Calculations folder under the project in COMPASS. 

6.13. Electronic Engineering Data (EED) 
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Electronic Engineering Data shall be prepared and submitted in accordance with Electronic Engineering Data 
(EED). 

6.14. Contract Plan Drawing and Sheet Numbering 

 

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited to section 
details, section cuts, and detail callouts. Drawing numbers in digital contracts shall consist of the discipline 
designator followed by a hyphen and the sheet number.  Examples of discipline designators are HWY, PRO, 
IND, XSC, S, TR, A, E, etc.   
 
The first sheet in a discipline subset shall have “01” in the drawing number as shown below: 

 

 

Page labels and sheet numbers are applied to the discipline subset after the contract plans are published to 
PDF. 
 
Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the number pages 
and header and footer tools within Bluebeam.  Page labels and sheet numbers shall be applied to all 
submissions of contract plans. 
 
The first sheet in every subset shall start out at 01.  For example, the first sheet in the 05-Traffic subset shall be 
05.01.  

 
The page label and sheet number place holder shall be determined by the total estimated sheet count. For less 
than 100 sheets two place holders is adequate. For greater than or equal to 100 sheets three place holders are 
necessary.  For subsets less than 10 sheets, two placeholders shall be used i.e., 01.01 thru 01.04 for a four-
sheet subset. 
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The page labels and sheet numbers must be placed correctly because it is used to correctly assemble the 
contract plans into a properly ordered consolidated set that District Construction takes advantage of during 
construction of the project.  
 
Single Volume Projects: 
The page labels and sheet numbers, for single volume projects shall be a concatenation of the discipline subset 
number, a decimal point, and the sheet number. For example, the page labels and sheet numbers for subset 
“4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03, etc. or Greater than 100 sheets 04.001, 
04.002, 04.003 etc.  
The Project Manager should determine the total number of subsets and give each discipline their 
corresponding subset number. 
 
Multi Volume Projects: 
For a multi volume project the page labels and sheet numbers shall be a concatenation of the volume number, 
a decimal point, the discipline subset number, a decimal point, and finally the sheet number. Example: Volume 
2, Subset 5; 02.05.01, 02.05.02, 02.05.03.  
 
Volume numbers shall be used on large projects. They are effective because the Project Manager only must 
deliver to the other engineers their perspective volume numbers, allowing them to manage their subset 
numbers independently of the other discipline volumes and subset counts. 
 
Subset numbers shall start at 01 for all volumes. 
 
BLUEBEAM - Applying Page Labels and Sheet Numbers  
To apply page labels and sheet numbers in Bluebeam follow the figures below: 

1. First page labels must be applied to the discipline subset.  Go to the thumbnail pane as shown below, 
right click on a thumbnail and select Number Pages: 
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For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at once.  In the 
case where there are 10 or more sheets in the subset the following will have to be done twice to get the 
correct number of place holders.   
  

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply to the correct 
pages.  For example, if the 04 subset has 99 sheets the prefix shall be “04.0” for sheets 1-9 and “04.” 
For sheet 10 through 99. 

 

 
 

3. Now the pages will be labeled: 

 
 

4. Next, we will apply the sheet numbers.  From Bluebeam select the Document tab and then “Header & 
Footer” 
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5. Place the sheet numbers, as shown below:  Note the margins may have to be adjusted as necessary.  
After you select the font, set the margins, and type in <<PageLabel>> as shown below.  Then click save 
for save settings.  The next time you are going to apply sheet numbers to a subset, you can simply 
select the saved settings.  Then click OK. 
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Page labels and sheet numbers for an Addendum need to have “.A##” at the end and Change Orders need to 
have “.C##” at the end. 
 
To apply page labels and sheet numbers in Bluebeam follow the figures below: 

1. First page labels must be applied to each sheet in the addendum or change order.  This can only be 
done one sheet at a time.   

2. Go to the thumbnail pane as shown below and then double click on the page label.  Then type in the 
correct page label for the sheet. 

 
 

3. After all page labels have been applied, the sheet numbers can be applied.  From Bluebeam select the 
Document tab and then “Header & Footer” 



Connecticut Department of Transportation – Digital Project Development Manual

53 
 

 
 

4. Select your sheet numbers saved settings from before and click OK.  Note the margins and size may 
have to be adjusted as necessary.   

 

 
 

 

6.15. Consolidating Contract Plan Discipline Subsets   
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The consolidation of the contract plan discipline subsets is accomplished using the Set feature in 
Bluebeam.  This feature creates a single viewer file called a “Set File” that allows users to take multiple digitally 
signed files, sort them by their sheet numbers, and view them in order without combining the files.    
  
The project manager shall create a Set file for the project at DCD that contains all the discipline subsets, DO 
NOT include the highway and traffic standard subsets.  When an Addendum or Change Order is required for 
the project, the project manager shall update the set file to include the Addenda or Change Order subsets.  
  
The following shows when and how a set file will be created and updated throughout the life of a project.   
  

See Appendix C for general use of a set file.  Note:  To use a set file the contract plans folder 
must be synced to the user’s computer.  For outside consultants that are unable to 
sync in COMPASS please contact mathew.calkins@ct.gov for assistance in creating 
the set file.  
  
Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature in 
Bluebeam.    
  
Also, the PDF checker must be run on the subsets, and they must receive a PASS status for the Set 
File to sort the subsets correctly.  See section 6.3 information on the PDF checker.   

 

Set File Creation   
1. The project manager shall create a set file of all the discipline subsets at DCD, see Section 
4.15.2  

Set File Updates  
2. If any Addendum subsets are required for the project, these Addendum subsets shall be added 
to the set file by the project manager.   
3. If any Design Imitated Change Order subsets are required for the project, these Design 
Initiated Change Order subsets shall be added to the set file by the project manager.   

See Section 4.15.3 for updating the set file.  

 

Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature in 
Bluebeam.    
  
Also, the PDF checker must be run on the subsets, and they must receive a PASS status for the Set 
File to sort the subsets correctly.  See section 6.3 information on the PDF checker.   
  
After all the discipline subsets have been submitted into COMPASS for DCD the project manager shall create 
the project’s set file in accordance with the following:    

1. Sync the contract documents library from COMPASS.   

bookmark://_Appendix_C_-/
mailto:mathew.calkins@ct.gov
bookmark://_Appendix_A/
bookmark://_Creating_a_Set/
bookmark://_Creating_a_Set/
bookmark://_Updating_a_Set/
bookmark://_Appendix_A/
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2. Launch Bluebeam from the desktop icon on your computer.   
3. Next Click on the Set Icon and select New Set as shown below:  

  
 

4. Then click Add and then My Computer and OK as shown below:  
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5. Next browse out to your project’s 100 Contract Plans folder in the synced folders on your 
computer and select all plans except the standard subsets.  Then click Open:  After you click Open 
it may take a minute for Bluebeam to load all the files into the set, please be patient.    

  
6. Next Click on Relative Paths and then click options:  
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7. Next on the sorting tab, make sure all the options shown below are set:  

 
 

  
8. Then on the Categories Tab make sure the categories are turned off:  
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9. Then on the Tags Tab make sure nothing is checked and then click OK:  

  
  

10. Next click Save, this may take a while depending on how big the project is, please be 
patient.  When the box pops up choose My computer and click OK:  
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11. Save the file in the 100 contract plans folder of the project and name the file “Set File”.  

  
12. When the Tags box pops up just click OK:  
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13. Now the set file has been created.  As you see below all the sheets from the files are listed and 
crossed out accordingly.  For use of the Set File see Appendix C:

  
 

 

Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature in 
Bluebeam.    
  
Also, the PDF checker must be run on the subsets, and they must receive a PASS status for the Set 
File to sort the subsets correctly.  See section 6.3 information on the PDF checker.   
The following will show how to update a set file.  When an Addendum or Change Order is required for the 
project, the set file shall be updated by the project manager.    

 

1. Double click on the set file from the sync folders on your computer.  This may take a while 
depending on how big the project is, please be patient.  

  

bookmark://_Appendix_A/
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2. Next click on the Set icon and click Add as shown below:  

  
3. Next browse out to your project and select the files to add to the set and click Open.  This may 
take a minute to add the additional file to the set so please be patient.  After it finishes click OK.    

  
4. Now the file will be added to the set, scroll down and you will see it.   
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Note:  Steps 1-5 of Appendix A must be followed to create and use the Set File feature in 
Bluebeam.    
  

1. Double click on the set file from the synced folders on your computer. 
  

2. Next click on the Set Icon.  Then select the file to remove from the set and click delete:  

  

  

bookmark://_Appendix_A/
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7. Digital Signatures for Contract and Other Engineering Documents 

The following contract documents must be digitally signed when submitted to the Department in accordance 
with the following section: 

• Contract Plans – FDP, Addendum, Change Orders 

• Engineering Reports 
o Hydraulic Report 
o Scour Report 
o Floodway Report 
o Final Drainage Reports 
o Bridge Inspection Reports 
o Bridge Load Ratings 
o Task 110 
o Task 220 
o Underground Storage Tank System Closure Reports 

• Working Drawings for Permanent and Temporary Structures – Plans and Calculations 
 
This manual refers to digital signatures in two ways: certifying signatures and signing signatures. The Engineer 
of Record or document signer will always digitally sign using a visible certifying signature.  If multiple signatures 
are required per document, the second signer or sub-engineers shall always digitally sign using a visible signing 
signature after the primary signer or engineer has applied his certifying signature.  Certifying signatures allow 
controlled changes, to the now certified document.  These controlled changes include allowing PDF digital 
comments, and the application of additional signatures.  Signing signatures should always be accompanied by 
a note listing the sheets the signer is responsible for within a subset.   
 
To digitally secure a PDF document, the signer(s) applies a digital signature(s) to only the first sheet of the 
document, regardless of the number of pages the document contains. This digital signature secures the entire 
document.  
 
A graphic image of the signer’s signature must be created, and shall be used for the following purposes:    

• It shall be attached to the digital signature and displayed when the digital signature is applied.  

• It shall be placed as a watermark on all contract plan sheets a particular engineer of record is 
responsible for (digitally signing for).   

• It shall be placed on the first sheet by the preparer and checker of an engineering report. 

• The watermark shall be placed on all contract plan sheets and all plan sheets contained in a working 
drawing submittal. 

 
A digital ID must be purchased to apply a digital signature.  Digital ID’s must meet the special provisions of 
Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List (AATL).  The necessary hardware 
and software needed to apply the required digital signatures may be purchased from the vendor list provided 
at the following website: HUhttp://www.adobe.com/security/partners_cds.htmlUH, additional information on 
Adobe’s CDS is also available at this website. 
 
Before digitally signing any document, Bluebeam must be set up as detailed in Appendix A. 

7.1. Graphic Image of Signature 

 

https://helpx.adobe.com/acrobat/kb/certified-document-services.html
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The following figures display an example of both a state designer and a consultant designer’s digital signatures, 
and their accompanying graphic image(s) of their signature(s). See Section 5.2. for instructions on how to 
create a graphic image.    
 
The consultant engineer’s graphic image must contain his companies name and address, his signature, his 
Professional Engineers stamp, or his Professional Architecture Stamp. The state employee’s graphic image 
must contain only his signature. See Below. 
 

      
 
In addition to a digital signature being placed on the first sheet of any contract plan, working drawing plans, 
and working drawing calculations, CTDOT also requires that all subsequent pages be watermarked with a copy 
of the engineer of records graphic signature before they are digitally signed. Watermarks containing these 
signatures are applied using Bluebeam and are always placed in the border of contract plans and working 
drawings for permanent structures. This is to prove validation of a digital document if printed. 
 

         
 

        

 

Hydraulic, Scour, Floodway, and Final Drainage Reports 
The following shows the watermarks that need to be placed on the first sheet of a Hydraulic, Scour, Floodway, 
or Final Drainage Report by the Preparer and the Checker and the digital signature of the Approved Hydraulic 
Engineer.  The digital signature must include the graphic image of the signer’s PE stamp and signature as 

 

 

1st page of Subset 

Watermark of State Design Graphic 
Signature 

Watermark of Consultant Designers  
Graphic Signature 
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shown below, Section 5.2. for instructions on how to create a graphic image.  These reports shall be digitally 
signed in accordance with Section 5.6.7   
 

 
 
Bridge Inspection Reports 
The following shows how Bridge Inspection reports are to be digitally signed in the bottom right-hand corner 
of the report. The digital signature must include the graphic image of the signer’s PE stamp and signature as 
shown below, Section 5.2. for instructions on how to create a graphic image.  These reports shall be digitally 
signed in accordance with Section 5.6.7   
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Bridge Load Ratings 
The following shows how Bridge Load Ratings are to be digitally signed. The digital signature must include the 
graphic image of the signer’s PE stamp and signature as shown below, Section 5.2. for instructions on how to 
create a graphic image.  The load ratings shall be digitally signed in accordance with Section 5.6.1  
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Environmental Compliance Reports 
The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure Reports must 
include a graphic image of the Professional engineer’s signature or a graphic image of the signer’s signature 
where applicable, see Section 5.2. for instructions on how to create a graphic image. These reports shall be 
digitally signed in accordance with Section 5.6.7   

 

Working Drawings for Permanent and Temporary Structures 
The following shows the digital signature and Professional Engineering watermark requirements for the 
engineer who prepares the working drawing submittal.   These types of submittals shall be digitally signed. 
Note:   Working Drawing for Temporary Structures only require that the first sheet in the submittal be digitally 
signed, watermarks are not necessary.  See Creating Graphic Image of Signature for instructions on how to 
create a graphic image. 
 
Working Drawing Plans 
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The first plan sheet in the submittal shall have a digital signature and a watermark placed on it as shown 
below. All other sheets will only have the watermark.  A place in the border of the plan sheets shall have a spot 
for this watermark.  
 

 
 
Working Drawing Calculations 
The first sheet of the calculations shall have a digital signature as shown below: 
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Documents that do not require to be signed by a Professional Engineer shall have a graphic image of the 
signer’s signature attached to their digital signature. See Creating Graphic Image of Signature for instructions 
on how to create a graphic image. 

7.2. Creating Graphic Image of Signature 

 

The graphic signature will be used by CTDOT employees and signers that are not signing as a Professional 
Engineer.   
 
CTDOT graphic signatures shall be created as follows: 
 

1. Signer must sign a blank piece of paper. 
2. Scan this signature. 
3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.  
4. Save the images, in PDF to an area on your PC. 

 

 

Consultant Engineers shall create two different graphic signature images: one that shall accompany their 
digital signatures and a different one that shall be placed as a watermark on all the plan sheets the engineer is 
signing for.  
 
This section shows an example of a Professional Engineer preparing their graphic image of their signature; 
Architect’s shall follow this section when they are preparing their digital signature.   
Graphic Appearance Attached to Digital Signature 
The graphic signature that accompanies the digital signature only needs to include the designer’s signature and 
P.E. Stamp., and shall be created as follows:   
 

1. Stamp and sign a blank piece of paper. 
2. Scan this signature. 
3. Crop the image to approximately 250 pixels wide by 250 pixels high. 
4. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in 

the signature set-up procedure.  

 
 
Graphic Appearance used as a Watermark  
In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a watermark shall 
also include the designer’s company name and address, and shall be created as follows:   
 

1. On blank paper – Print company name and address. 
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2. Place P.E. stamp next to company name and address. 
3. Sign P.E. Stamp.  
4. Scan the image created in steps 1 thru 3 above.   
5. Crop the image to approximately 500 pixels wide by 250 pixels high. 
6. Save the image, in PDF to an area on your PC or server, where you can easily access it for later use in 

the watermarking procedure.   
 

 
 
Once the graphic images have been properly created and saved, the digital signature appearance preferences 
must be set as follows: 

7.3. Setting Digital Signature Appearance Preferences 
Once the graphic signatures are created the digital signature appearance settings must be defined as follows: 
Bluebeam Digital Appearance 

1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the Document 
tab and select Signatures>Digital ID’s: 

 
 

2. Next click on your ID and click Manage Appearances: 
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3. Next follow the figure below: 

 
 

4. Now the digital appearance will be saved and can be used to digitally sign. 

7.4. Watermarking Plans with Graphic Image of Signature 
The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a copy of their 
graphic signature as a watermark on each sheet of each discipline subset, or working drawing submittal (Plans 
and Calculations) that they are responsible for.  For Engineering Reports the preparer and checker of the 
report shall place a copy of their graphic signature as a watermark only on the cover of the report.   
 
Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant Designed) 
There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2.  The following shows 
an example of a CTDOT signature, but the procedure is the same for a consultant when they are placing their 
PE stamp in the border or on the first sheet of an engineering report. 
 
Watermarking Workflow: 
Option 1 
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1. The watermark in Bluebeam is placed using the stamp function.  First go to the Markup tab and select 
Stamp and then choose your stamp.  If your Principal’s or PE stamp is not in the list follow Appendix A.  
If your stamp is in the list go to step 2. 

 
2. Next place the stamp in the border on the first sheet.   

 
 

3. Next, right click on the stamp and select “Apply to all pages”.  If you are watermarking an engineering 
report, you do not need to apply to all pages.   

 
 
If more than one group must watermark this subset, browse to the pages the other group is responsible for 
and delete the watermark.  Then they can come in a place their watermark on these sheets.   
Flatten Markups 

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF document.  
Go to Document>Flatten Markups.  Use the default settings and click OK.   

1. After the watermarks have been placed on the subset, the watermarks must be “flattened” to the PDF 
document.  Go to Document>Flatten Markups.  Use the default settings and click OK.   

7.5. Digital Signature Fields  
Contract Plans 
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Digital signature fields are form fields created using Bluebeam and are used to house the digital signatures. 
Digital Signature form fields shall be placed within the form field place holders. The form field place holders 
are cells that are placed in the Bentley Software file on the title sheet and the subset cover sheets and, on any 
Addendum, or Change Order Subset.  The figure below shows a CTDOT designed project with the form field 
place holders (circled) on the title sheet and the discipline subset cover sheet.    
 

 
 
The figure below shows a consultant designed project’s title sheet and discipline subset cover sheet with their 
form field place holders.     

 
 
Place holders determine the location and size of the digital signature form field.  
 
Form field place holding cell library: CT_Digital_Sigs.zip  
 
The digital signature place holder and form fields shall be created on the first page of each discipline subset for 
each required digital signature. 
 
Note:  All signature form fields need to be created for both certifying and signing signatures before any 
digital signatures is applied to the document. 
 
Contractor Submittals 
Contractor submittals will not be required to have a digital signature place holder.   
 
Engineering Reports 
Engineering reports will not be required to have a digital signature place holder.   

 

The following example shows how to place the (3) digital signature form fields on the 01-General title sheet of 
a CTDOT designed project.  For a discipline subset or a consultant designed 01-General title sheet, only one 
digital signature form field needs to be placed.    

 

 

 

https://portal.ct.gov/-/media/DOT/documents/AEC/ct_digital_sigs.zip
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1. To place signature fields, click X. 

 
2. Next place three signature fields in the appropriate location and hit save as shown below: 

 

7.6. Applying Digital Signatures 
This section describes how to apply digital signatures for contract plans, engineering reports, working drawing 
plans, and working drawing calculations.   
 
Contract Plans 
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic Standard drawing 
subsets have unique requirements as described in the following sections.   
 
CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded into 
COMPASS because the Principal Engineer will be looking in COMPASS to digitally sign documents.   
 
Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of record, using a 
single visible certifying signature, applied to the signature form field located on the first page of each subset. 
 
Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of Record who is 
responsible for the most sheets in the subsets.  This engineer will apply a visible certifying signature in the 
topmost form field. The next Engineer of Record shall apply their signing signatures in the subsequent form 
fields. This Engineer shall also include a reason, when applying their digital signatures, listing the pages they 
are responsible for.  
 
Digital signatures must be applied to digital signature form fields, previously.   
 
Engineering Reports 
Engineering Reports shall be digitally signed, by the Engineer of Record using a certifying.   

 

CTDOT DESIGNED PROJECTS: 
The following procedure applies to both the 01_General subset at FDP and any 01_General_A# subset.   
 
The project title sheet of the 01_General subset shall first be digitally signed by the lead discipline’s Principal 
Engineer, using a certifying signature.  The Principal Engineer should make sure that all three digital signature 
form fields (blue boxes in the signature block) are placed before signing, as these forms cannot be added after 
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the document is digitally certified.  After processing has approved the 01_general subset for Advertising, the 
Manager, and the Transportation Engineering Administrator shall digitally sign the same sheet directly below 
the principal’s signature, using a signing signature while the plans are in the Manager and Engineer Admin. 
Sign state.   
 
Processing shall notify the lead designer when the 01-General subset is placed in the Manager and Engineer 
Admin. Sign state.  The lead designer shall then coordinate the digital signing by the Manager and Engineering 
Administrator of the 01_General subset.  When both signatures are applied to the plans, the lead designer 
shall then notify processing that the 01-General subset has been signed.     
 
See Section 5.7 Applying Digital Signature Workflows 
Note: When digitally signing the 01_General subset all signers shall leave the reason code blank. 
The following image shows a typical project title sheet from the 01_General subset that is digitally signed: 

 
 
CONSULTANT DESIGNED PROJECTS: 
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant, using a 
certifying signature.  
 
See Section 5.7 Applying Digital Signature Workflows 
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When more than one consultant works on a CTDOT digital project the project manager (prime consultant) shall 
apply a visible certifying signature to the first page of the 01_General subset.  By applying this signature, the 
prime consultant is accepting responsibility for the entire set of digital contract plans.  However, the individual 
subsets shall be signed by the corresponding firms.    
Note: When applying certifying or signing signatures leave the reason code blank.  

 

This section applies to both CTDOT designed projects and Consultant designed projects.  The figures 
contained in this section show a CTDOT signature, but the workflows are the same.   
 
This subset does not need to be signed at FDP.  This subset must be signed when the sheet is filled out for 
an Addendum or design-initiated change order, whichever comes first.   
 
The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed by the lead 
designer, using a certifying signature.   
 
1. The lead designer shall apply a certifying signature as described in Section 5.7 Applying Digital 

Signature Workflows with the following EXCEPTION: the option “No Changes Allowed” must be 
selected to eliminate unauthorized changes after certifying the document. See the figure below: 
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This section applies to both CTDOT designed projects and Consultant designed projects.  The figures contained 
in this section show a consultant signature, but the workflow is the same.   
 
Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the responsible 
design engineer. As shown below. 
 

 

 

This section applies to both CTDOT designed projects and Consultant designed projects.  The figures contained 
in this section show a consultant signature, but the workflow is the same.   
 
Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need to be digitally 
signed with a visible certifying signature, by the responsible design engineer that submits the subset to 
COMPASS.  For example, in the case where the Traffic unit is submitting a Highway standards subset, the 
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Traffic Principal Engineer is responsible for digitally signing the index sheets, not the Highway Principal 
Engineer.   

 

This section applies to both CTDOT designed projects and Consultant designed projects.  The figures contained 
in this section show a consultant signature, but the workflow is the same for CTDOT designed projects.    
 
Multiple signatures per a single subset are required where two or more disciplines/firms are responsible for 
one subset. 
 
The lead designer that is responsible for most of the pages within a discipline subset shall digitally sign the 
subset using a certifying signature and leave the reason code blank.  
Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset using a signing 
signature and complete the reason code with a note stating which pages, contained in this subset, that they 
are responsible for.  See table 2-1 below: 
 

Designer Certify or 
Sign 

Responsible Sheet 
Numbers 

Reason Code 

Lead Designer Certify   

Sub-Designer 1 Sign 03.78 Thru 03.88 I am Signing for Sheet Nos. 03.78 thru 03.88 

Sub-Designer 2 – etc. Sign 03.88 Thru 03.98 I am Signing for Sheet Nos. 03.88 thru 03.98 

 

Working drawing submittals shall be digitally certified in accordance with Single Signatures Visible Digital 
Signature using a Certifying signature, of this manual.   

 

Engineering Reports shall be digitally signed, by the applicable person using a certifying.  See Single Signatures 
for instructions on how to apply a certifying signature to an engineering report.  If a report needs to be digitally 
signed by more than one person, the first person must apply a certifying signature as shown in Single 
Signatures and any subsequent signature will be a signing signature as shown in Single Signatures. 

 

Load Ratings shall be digitally signed, by the applicable person using a certifying signature with the No Changes 
Allowed option selected as shown below: 
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7.7. Applying Digital Signature Workflows  
This section applies to both CTDOT designed projects and Consultant designed projects.  See also Signing and 
Editing PDFs in Office 365 for instructions and related troubleshooting tips.  If a signature is required by the 
Chief Engineer, Assistant Chief Engineer, Engineering Administrator or Construction Administrator on project 
documents, please see Management Signatures in COMPASS for guidance on how to assign the review in 
COMPASS.          
 

Certifying Signature: 
1. Left click on the signature field and then update the settings as shown below.  Examples below are for 

a CTDOT designed project’s title sheet and the first sheet of an Engineering Report: 
 

Discipline Subsets 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Signing-in-Office-365.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Signing-in-Office-365.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Signatures-from.aspx
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Engineering Reports or Documents that Require (1) Digital Signature 

 
 

2. Next, for documents located in COMPASS or SharePoint, save to the appropriate SharePoint Library as 
shown below: 
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3. Then select yes to create a new version of the file in COMPASS or SharePoint. 
 

Digital Signing Signature: 
Once the prime engineer applies his certifying signature the additional signing signatures can be applied by the 
sub-consultants as follows:  
 

1. Left click on the signature field and then update the settings as shown below: 
 

 
2. Next, for documents located in COMPASS or SharePoint, save to the appropriate SharePoint Library as 

shown below: 
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3. Then select yes to create a new version of the file in COMPASS SharePoint. 
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8. Submitting Documents to CTDOT 

The S&T application can be used for Ball in Court (BIC) tracking of any document workflow in COMPASS.  
Examples of typical workflows are provided in this section.    

8.1. Correspondence and Memoranda in COMPASS 
Please see Correspondence and Memoranda in COMPASS for a sample workflow for generating, reviewing and 
distributing project memoranda using the COMPASS Submittals/Transmittals (S&T) application.   

8.2. Correspondence to Contractor 
Please see Correspondence to Contractor in COMPASS for a sample workflow for sending correspondence to 
Construction Contractors using the COMPASS Submittals/Transmittals (S&T) application. 

8.3. Request for Work 
Please see Request for Work for a sample workflow for sending and responding to a Request for Work using 
the COMPASS Submittals/Transmittals (S&T) application. 

8.4. PS&E Milestone Reviews in COMPASS 
Please see PS&E Milestone Reviews in COMPASS for a sample workflow for conducting a PS&E Milestone 
Review using the COMPASS Submittals/Transmittals (S&T) application. 

8.5. FDP Workflow in COMPASS 
The below sections delineate how to complete an FDP workflow in COMPASS. 

 

1. Lead Designer creates a new submittal envelope in COMPASS by pressing the New Submittal button. 

 
 

2. Lead Designer manually keys in Submittal Name and selects Submittal Type, then presses the blue 
Submit button to create the submittal envelope. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Correspondence-and-Memoranda-in-COMPASS.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Correspondence-to-Contractor-in-COMPASS.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Request-for-Work.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Milestone-Design-Reviews-in-COMPASS.aspx
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3. The submittal populates in the S&T table, listing the Submittal Creator (Lead Designer) as the Ball in 
Court.  Lead Designer opens the submittal envelope by clicking on the submittal name or review 
status. 

 
 

4. Lead Designer uploads FDP documents to envelope by selecting the appropriate destination folder 
from the drop-down, then selecting the file(s).   

a. Attach the necessary documents to the envelope by following the guidance provided in Attach 
Files to a COMPASS S&T Envelope. 

b. Ensure file names 1) do not include any restricted characters and 2) accurately and 
intuitively describe the document.    

 

FDP Document  File Type Destination Folder 

Contract Plans PDF Contract Documents > 100_Contract_Plans 
(PDF) 

Final Engineering Reports PDF Contract Documents > 
130_Final_Engineering_Reports 

FDP Design Review Request Memo PDF Internal Documents > 142_Project 
Administration Correspondence 

Contract specifications and NTCs Word Internal Documents > 240_Contract 
Development > FDP Specs 

CSI specifications Word Internal Documents > 240_Contractor 
Development > CSI Specs  
**Folder created by designer, as needed. 

Estimator Proposal Estimate Digital Estimator 
Format 

Internal Documents > 240_Contract 
Development 

Calendar Day Estimate  Internal Documents > 240_Contract 
Development 

Permit Applications and Approvals PDF Internal Documents > 240_Contract 
Development 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Attach-Files-to-an-Envelope.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Attach-Files-to-an-Envelope.aspx
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Electronic Engineering Data Files 
uploaded by the Designer 

 Internal Documents > 240_Contract 
Development 

 
 

 
 

 
 

5. The PDF checker will automatically run on any documents uploaded to the 100_Contract_Plans (PDF) 
folder.  If the document passes the PDF checker, it will upload to the folder.   If the document fails the 
PDF checker, detailed failure reasons will display in the submittal Comments/Log.  See PDF Checker in 
COMPASS (sharepoint.com) for more details. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/PDF-Checker-in-COMPASS.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/PDF-Checker-in-COMPASS.aspx
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a. If the document passes the PDF checker, close out of the informational window.  

 
 

b. If the document fails the PDF checker, it will still upload to the 100_Contract_Plans (PDF) 
folder.  Review the Submittal Comments/Log for details for the failure.  Depending on business 
requirements, either modify the PDF document to correct for the failure or leave as-is.   
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6. All NTCs and specifications are to be uploaded as individual Word documents in the folder FDP specs.  
No other documents should be uploaded to this folder. 
 

7. If a project contains CSI specs, the Lead Designer is to create a sub-folder to the Internal Documents > 
240_Contract_Development folder named “CSI Specs.”  All CSI specifications are to be uploaded to this 
location (if relevant).  To create this folder: 

a. Navigate to the Internal Documents > 240_Contract Development folder for the project. 

 
 

b. Select New > Folder 
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c. Name the folder CSI Specs and press Create. 

 
 

d. The CSI Specs folder will now be available in the Document Destination drop-down in the 
submittal envelope.   

 
8. Once all documents are added, press Save to attach all documents to the submittal envelope. 

 
 

9. Lead Designer requests sub-designers submit their FDP documents by adding sub-designers as 
Submittal Reviewers.  Set the appropriate due date, order of review, and task for each sub-designer.  
Typically, the Lead Designer will assign all staff who need to upload FDP documents as parallel 
reviewers with the Task “Contribute.”  Users may save frequently used reviewer lists to be applied in 
the future.  Once all staff is added according to business needs, press the Start button to initiate the 
automated Ball-In-Court workflow. 

a. Name:  Select the appropriate DOT or consultant staff.  Users must have permissions to the 
project site to be assigned as a reviewer. 

b. Due Date:  Set the due date for each person. 
c. Order of Review:  Set the order of review in series, parallel, or any combination thereof, in 

accordance with the business need.  Multiple review steps can be set for the same due date, if 
needed. 
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d. Task:  Select the appropriate comment from the drop-down menu.  This comment will display 
in the S&T envelope and populate in the recipient’s email notification. 

i. Review:  Default comment.  Assignee is expected to add comments or review stamps 
to documents. 

ii. Contribute:  Assignee is expected to upload one or more files to the submittal 
envelope. 

iii. Sign:  Assignee is expected to apply a digital signature. 
iv. Concur:  Assignee is expected to verify viewing the submittal documents but may not 

need to take any action on the documents directly. 
v. Distribute:  Assignee is expected to distribute links to the envelope. 

vi. Custom:  Option to provide customized task guidance. 
 

 
 

10. An email will send to all Submittal Reviewers in Order of Review 1, and the BIC in the S&T table will 

automatically update. 

11. Sub-designers upload their FDP documents to the appropriate folders in the same manner as the Lead 
Designer.  To transfer or add a member of the project team to one’s review step, follow Reassign or 
Add to a Review.  The PDF checker will automatically run on any documents uploaded to the 
100_Contract_Plans (PDF) folder.   

a. Once all documents are selected, the sub-designer presses the Save button to upload the 
documents. 

 
 

b. After uploading all FDP plans and completing ones BIC tasks, the sub-designer presses the gray 
complete button.  The sub-designer’s name will drop from the BIC and automatically progress 
to the next assigned BIC. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/How-to-Transfer-or-Add-to-a-Review.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/How-to-Transfer-or-Add-to-a-Review.aspx
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12. Lead Designer reviews the sub-designers plans, specs and estimates for content and completeness and 

checks they have passed the format compliance.  If the documents are accepted, the Lead Designer 

selects Approve Upload from the Actions drop-down menu.  If the plans are not accepted, the Lead 

Designer selects Reject Upload from the Actions drop-down menu.  For more information, see S&T 

Document Grid Management.  

 
 

13. If the sub-designer / contributor’s document(s) are rejected, an email notification will be sent.  The 

user can then replace the original document with a corrected one.   

 
14. Once all documents are accepted by the submittal owner / Lead Designer, the Lead Designer may 

begin a Bluebeam Studio Session, if needed, for a collaborative review.  Note:  Users require a 

Bluebeam Prime account to start and finalize Bluebeam Studio Sessions in COMPASS.  If a user does not 

have a Prime account, please request one by putting in a ticket with the COMPASS Support Desk. 

 
 
 Note:  If a PDF document is a PDF/A, or has other restricted security settings restricting editing, it will 

not be included in the Bluebeam Studio Session.  In the Bluebeam status column of the document grid, 
it will display as “Not Eligible (Locked).”  If the Start Bluebeam Session button is pressed, a message 
will display noting the security restriction. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/S&T-Document-Grid-Management.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/S&T-Document-Grid-Management.aspx
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
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15. After starting the Bluebeam Studio Session, the submittal owner assigns reviewers with the 

appropriate due date, order of review and task for each to meet the business need.  Multiple review 

steps can be set for the same due date, if needed.  Users may save frequently used reviewer lists to be 

applied in the future. 

Lesson Learned:  Lead Designers may find it useful to assign all staff who need to perform the initial 
review in parallel as order of review 1, then those who will need to review/respond to comments as 
order of review 2.  The same staff member can be assigned more than once, if needed, in a review 
workflow. 
 

16. Each assigned reviewer performs the review per the business need and presses Complete when done 

to advance the Ball in Court.  To transfer or add a member of the project team to one’s review step, 

follow Reassign or Add to a Review.   

 

17. If documents need to be replaced, the submittal owner can press the Revise and Resubmit button to 

enable contributors to replace their files. 

 
 

18. Once the FDP documents are complete, the submittal owner transfers ownership to contract 

processing by pressing Transfer Owner and inputting the email address of the processing staff assigned 

to the project. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/How-to-Transfer-or-Add-to-a-Review.aspx
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19. Once the Transfer Owner process is complete, no changes should be made to the FDP submission 

unless requested by the contract processing unit.   

a. If plans need to be revised or replaced, do so using the replace file function in the submittal 

envelope (instructions above). 

b. If NTCs, specs, or CSI specs need to be added or revised, upload the documents directly in the 

appropriate folder. 

i. Navigate to Internal Documents → 240_Contract Development → FDP Specs (or CSI 

Specs, if relevant).  The folder should be empty. 

 
 

ii. To upload the new or replacement specs as requested by contract processing: 

1. If the document is not stored in the COMPASS project site, then either drag 

and drop the files or select Upload → Files: 
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2. If the document is stored in a different working folder in the COMPASS project 

site and needs to be moved, navigate to the document, and select the Move to 

option: 

 
 

3. Navigate to the Project Number → Internal Documents → 

240_Contract_Development → FDP Specs and press Move here. 

 
 

4. Notify contract processing that the requested FDP Spec update is complete by 

sharing the folder back to the requesting staff.  Include a message in the pop-

up window indicating that the requested changes are complete. 
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After receiving the submittal from the lead designer, the contract processing unit proceeds as follows. 

1. The lead (submittal owner) from the contract processing unit may now facilitate a review of the 

contract documents. 

 
2. To review plans in the 100 folder: 

a. If needed, start a Bluebeam Studio Session to perform a collaborative review.  Note:  Users 

require a Bluebeam Prime account to start and finalize Bluebeam Studio Sessions in COMPASS.  

If a user does not have a Prime account, please request one by putting in a ticket with the 

COMPASS Support Desk.  

https://ctdotcompass.atlassian.net/servicedesk/customer/portals


Connecticut Department of Transportation – Digital Project Development Manual

95 
 

 
 

b. Assign reviewers, due dates, order of review and tasks as needed.  Users may save frequently 
used reviewer lists to be applied in the future.  Once all staff is added according to business 
needs, press the Start button to initiate the automated Ball-In-Court workflow. 

i. Name:  Select the appropriate DOT or consultant staff.  Users must have permissions 
to the project site to be assigned as a reviewer. 

ii. Due Date:  Set the due date for each person. 
iii. Order of Review:  Set the order of review in series, parallel, or any combination 

thereof, in accordance with the business need.  Multiple review steps can be set for 
the same due date, if needed. 

iv. Task:  Select the appropriate task from the drop-down menu.  This task will display in 
the S&T envelope and populate in the recipient’s email notification. 

1. Review:  Default comment.  Assignee is expected to add comments or review 
stamps to documents. 

2. Contribute:  Assignee is expected to upload one or more files to the submittal 
envelope. 

3. Sign:  Assignee is expected to apply a digital signature. 
4. Concur:  Assignee is expected to verify viewing the submittal but may not 

need to take any action on the document itself. 
5. Distribute:  Assignee is expected to distribute links to the envelope. 
6. Custom:  Option to provide customized task guidance. 



Connecticut Department of Transportation – Digital Project Development Manual

96 
 

 
 

c. To save a reviewer group to apply in the future, press the “Create Reviewer Group” button.  

When prompted, key in the group name and press Submit to save the list. 

 
 

 
 

d. If revisions to the documents are required, in the submittal envelope press Revise and 

Resubmit.  This will return the submittal to the original submittal owner / lead designer. 
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e. The lead designer will receive an automatic email notification and can view the comments.  

The Lead Designer can replace any files uploaded by oneself.  If any sub-designers need to 

replace documents, the Lead Designer needs to inform those team members. 

 
f. To replace documents, select the red “Replace File” icon next to the appropriate document, 

then upload the replacement file and press Submit. 
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g. Once all the rejected documents are replaced, the lead designer presses Submit to return the 

submittal to the point of contact in processing. 

 
3. To process NTCs and specs in the 240_Contract_Development folder: 

a. Contact processing navigates directly to the 240_Contract_Development → FDP Specs folder. 

 
b. Select individual documents to download, or click the top toggle (highlighted in yellow below) 

to select all files: 

 
 

c. Select Download from the menu.  The documents will download and be available for 

processing per existing business processes. 
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d. After downloading all documents, delete the Word documents from the folder.  Toggle to 

select all documents, then press Delete. 

 
 

e. Optional:  To receive notifications if a new document is added to this folder, follow instructions 

on how to Create an alert to get notified when a file or folder changes in SharePoint 

(microsoft.com).  If setting up alerts, it is recommended to set the Send Alerts for These 

Changes option to “Someone else changes a document.”  If the “Anything changes” alert is 

selected, alerts will be sent for all actions taken on the folder / document, including by oneself. 

 
 

f. If any revised or additional FDP specs are required from the designer, contact via email.  The 

designer will upload any new or replacement documents directly in the FDP Specs or CSI Specs 

folder.  When the designer has completed the revision to the FDP Specs and/or CSI Specs 

folder, a share link will be sent by the designer to the appropriate staff in contract processing, 

linking to the correct folder where new requested documents are uploaded. 

 
4. To process CSI Specs in the 240 folder, follow the same process as for FDP Specs.  The CSI Spec folder 

will be created on an as-needed basis by the lead designer.  If the folder does not exist in the 

240_Contract_Development folder, then there are no CSI Specs associated with the FDP submission. 

 
5. To process estimates uploaded to the 240 folder, click the file and proceed according to existing 

business processes. 

 
6. Once the FDP submission is finalized, press the blue Complete button in the submittal envelope: 

 

8.6. Stakeholder Submittals in COMPASS 

https://support.microsoft.com/en-us/office/create-an-alert-to-get-notified-when-a-file-or-folder-changes-in-sharepoint-e5a79e7b-a146-46da-a9ef-d65409ba8918
https://support.microsoft.com/en-us/office/create-an-alert-to-get-notified-when-a-file-or-folder-changes-in-sharepoint-e5a79e7b-a146-46da-a9ef-d65409ba8918
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1. Sign into the COMPASS project site Submittals/Transmittals page.  

2. Click New Submittal button.  

 
 

3. Complete the submittal form: 

a. Submittal Name:  Input a submittal name that accurately describes the document(s) being 

submitted.  Follow any naming conventions provided by CTDOT. 

b. Submittal Type:  Select Engineering Correspondence or Construction Correspondence.  This 

selection determines to whom the submittal is routed so it is important to choose accurately. 

c. Attach File(s):  Attach one or more files to the submittal.   

 
 

4. When ready, press the blue Submit button.   

 
 

5. The submittal will automatically route to the DOT staff who is designated for the selected Submittal 

Type.  This name will be reflected in the Ball in Court column of the S&T table.   

 
6. The DOT will press Complete to confirm receipt of the submittal document(s). 

8.7. Document Distribution in COMPASS 
Please see Document Distribution in COMPASS. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Document-Distribution-in-COMPASS.aspx
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8.8. PDF Checker 
Please see PDF Checker in COMPASS. 

8.9. S&T File and Document Grid Management 
Please see S&T File Management - Rename and Move Files and S&T Document Grid Management for details. 

8.10. Reopen Complete Submittal / Transmittal Envelope 
Internal CTDOT staff in the COMPASS Owners or xxxx-xxxx Owners permissions group have the ability to 
reopen any completed project Submittal / Transmittal envelope.  This feature is not available to external users, 
even if they are invited to the xxxx-xxxx Owners permissions group. 
 

1. If an S&T has a review status of Complete but needs to be reopened to meet a business need, 
authorized users may press the Reopen button at the bottom of the envelope. 

 

 
 

2. A mandatory pop-up window appears, requiring the user to enter a justification for reopening.  This 
justification will be recorded in the Comments/Log and included in an automated email notification.  
After adding the justification, press Reopen.   
 

 
 

3. After confirming the Reopen: 

• An email notification will send to the original submittal creator, the final submittal owner, and all 
reviewers from the workflow, notifying them of the change.  

• The action will record in the Comments/Log, including the date, time, user who re-opened, and the 
justification reason. 

• For documents that originated in the 120_Contractor_Submittals (PDF) folder and were 
automatically relocated to the 125_Completed_Submittals folder when Complete, those 
documented will automatically return to the 120_Contractor_Submittals (PDF) folder. 

• The review status of the reopened submittal will initially display as Send Back. 

• The final reviewer list with the completed BIC workflow information displays with the same read-
only data. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/PDF-Checker-in-COMPASS.aspx?source=%2Fteams%2FAEC%2F_layouts%2F15%2Fnews.aspx%3FnewsSource%3D1%26instanceId%3D43493f2d-45a7-452b-8505-efb3aa95a530%26webPartId%3D8c88f208-6c77-4bdb-86a0-0c47b4316588%26serverRelativeUrl%3D%2Fteams%2FAEC%26pagesListId%3D36d1eb75-11a7-4719-8dea-14b0216d1d6d&promotedState=1
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/S%26T-File-Management---Rename-and-Move-Files.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/S%26T-Document-Grid-Management.aspx


Connecticut Department of Transportation – Digital Project Development Manual

102 
 

• The user who performed the reopen action becomes the new envelope owner, the Ball In Court, 
and can start a new workflow or make any other changes, as needed. 

• The workflow can proceed as it would if the S&T envelope had never been completed. 
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9. Contract Plan and Special Provision Revisions (Addenda and Design 
Initiated Change Order) 

9.1. Addenda 
Contract plans that are revised or added due to addenda shall be submitted in digitally signed PDF discipline 
subsets containing only the changed sheets.  The sheets being revised or deleted shall not be included in the 
Addenda submittal. The first sheet of each addendum subsets shall be digitally signed in a digital signature 
place holder, that is placed in Bentley Software. Addendum subsets DO NOT need an index of drawings sheet.   
Once digitally signed, the addendum subsets shall be submitted to CTDOT using COMPASS, as described in 
Addendum Plans in COMPASS. 
 
Addenda sheets from different subsets cannot be combined and submitted as one subset, they must be 
submitted per their respected subsets.   
 
The addenda subset shall have the same COMPASS label as the original final plan subset with the addition of 
(_A##) added to the end, where the ## equals the addenda number.  See example below: 

 
COMPASS FILE NAMES 
 

Original Discipline Subset:  04-Traffic 
Addenda Discipline Subset:  04-Traffic_A01 
2nd Addenda    04-Traffic_A02 
6th Addenda    04-Traffic_A06 

 
The contract sheets (previously submitted final plans or earlier addenda plans), being revised by addenda shall 
UNOT be modified except; the Engineer of Record shall place addenda stamp on the affected sheets.  This 
addenda stamp crosses out the entire sheet with a red X and adds the following note: "THIS SHEET REPLACED 
BY ADDENDUM NO."Y"; where "Y" equals the addendum number. This stamp is placed over digital signatures; 
therefore, removal of the signatures is not required prior to placing the addenda stamp.   
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
   
The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the project manager 
for all addenda.  A new subset must be updated for each addendum.   
 
A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants) shall be 
placed on all added or revised sheets.   

 

Bentley Software Processes 
For revised sheets the drawing numbers shall not be modified.  
 
The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be placed 
somewhere on the line of the cloud.  A like numbered triangle shall be placed in the revision block of the 
changed sheet, accompanied by a description of the revision itself. The revision number is specific to a 
particular sheet and increases in consecutive order per revision and per addenda. If a sheet is changed for the 
first time under Addendum #2 then the sheets revision number is 1 since this is the first change.  If the next 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Addendum-Plan.aspx
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time it is changed again is under Addendum #5 the revision number becomes 2 since this is the second change 
to the sheet. 
 
Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a clear manner, 
do not void out the existing sheet and create a new sheet.  In these instances, the designer shall place a 
cloud just inside the border of the revised addendum sheet. 
 
Note:  When preparing an Addendum that will change quantities on a project that includes a "Detailed 
Estimate Sheet", never revise the "Detailed Estimate Sheet."  A "Detailed Estimate Sheet" is never included in 
an addendum.  Also, the "Quantities" box shown on the General Plan sheet for any structure is never to be 
revised. 
 
Bluebeam Processes 
A note shall be placed, in the bottom left-hand side of the border, on the replacement sheets stating, 
“ADDENDUM NO. “Y”, where “Y” equals the addenda number.   This note is a stamp in the CTDOT 
Miscellaneous tools in the Bluebeam tool chest that needs to be added and edited.  If you do not have these 
tools in the tool chest you can find them in Appendix A of this manual.   
 
Sheet numbers for revised plans shall be as follows: 
Original Final Plan Sheet. 
 
 Original:  02.25 
 Addenda 1:  02.25.A1 
Previous Addenda Sheet. 
  

Original:  02.25.A2  
Addenda 4:  02.25.A4 

 
If a sheet requires further revisions by a subsequent addendum, the addendum shall be prepared, as detailed 
above. The previously revised sheet shall now be stamped using Bluebeam after addendum approval, see 
Section 7.4.   

 

Bentley Software Processes 
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, 
as follows:  
  

1. If the new sheet does not have to be placed in a specific location within the discipline subset, the new 
sheet shall be placed last, and numbered sequentially from the last sheet of the discipline subset.  The 
total number of sheets noted on the project plans and discipline subsets stays the same.  The revision 
block on the added sheet, shall not be filled out. 

 
2. If the designer determines that the new sheet must go in a specific location within the discipline 

subset, the new sheet number shall be the number of the previous sheet followed by (-1. A#), where # 
is the Addendum Number.  For example, if the new sheet must be placed in a discipline subset right 
after sheet 02.57, the new sheet shall be numbered 02.57-1. A1, if an additional sheet needs to be 
added, in this case it would be 02.57-2.A1.  The total number of sheets noted on the project plans 
stays the same.  
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When adding a new sheet, a new drawing number is also required. As with the sheet number the 
drawing number of the new sheet shall be the drawing number of the previous sheet plus a dash and 
the sheet count.  For example, if the new drawing must be placed in the project plans right after 
drawing number S-5, the drawing number shall be S-5-1. 

 
Bluebeam Processes 
A note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals 
the addendum number.  This note shall be placed in the bottom left-hand side of the border.  This note is a 
stamp in the CTDOT Miscellaneous tools in the Bluebeam tool chest that needs to be added and edited.  If you 
do not have these tools in the tool chest you can find them in Appendix A of this manual.   
 
Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows: 

 
Original Final Plan Sheet; 
 
 Original:  04.31 
 Addenda 3:  04.31-1.A3 
 
Previous Addenda - Added Sheet. 
 
 Original:  03.24.A1 
 Addenda 4:  03.24-1.A4 
 
Previous Addenda - Revised Sheet. 
 

Original:  05.14-1.A1 
 Addenda 2:  05.14-1.A2 
 
Previous Addenda - Added Sheet. 
 

Original:  05.14-1.A1 
 Addenda 2:  05.14-2.A2 
 
If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet 
number plus .A#, where # equals the addenda number. 
 
Original Final Plan Sheet: 
 
 Original Last Sheet:  04.31 
 Addenda 3:   04.32.A3 

 

The new subset shall be submitted by an Addendum and be prepared the same way as an FDP discipline 
subset, with the addition of an A# in the sheet numbers and a note shall be placed, in the bottom left-hand 
side of the border, on the sheets stating, “NEW SHEET ADDED BY ADDENDUM NO. “Y”, where “Y” equals the 
addenda number.  This note is a stamp in the CTDOT Miscellaneous tools in the Bluebeam tool chest that 
needs to be added and edited.  If you do not have these tools in the tool chest you can find them in Appendix A 
of this manual.  The label attribute on the new subset shall contain a “_A##”.   The first sheet of a new subset 
to the contract will be a subset cover sheet and contain an index of drawings.   Also, the DO NOT update the 
project title sheet in the General subset to show the addition of new subsets to the project.   
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Sheets submitted within final design plan subsets and addenda subsets shall UNOT be deleted; but shall voided 
by the engineer of record with an addenda stamp, using Bluebeam. This addenda stamp crosses out the entire 
sheet with a red X and adds the following note: "VOIDED BY ADDENDUM NO.”Y"; where "Y" equals the 
addendum number.   

 

Contract Special provisions that are revised or added due to addenda shall be submitted digitally. 

 

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance with the 
following. 
 
The Addendum for a standard subset shall only include the added sheets, do not include all the standards for 
the project.   
 
When uploading to COMPASS, add an “A##” to the end of the label attribute.   
 
Update the 02-Revision subset to record this change.  

9.2. Design Initiated Change Order (DICO) 
Design Initiated Change Orders (DICO) are change order requests in which the designer alters the original contract 
by: 

• A revision to an existing plan sheet(s) or specification(s) 

• The addition of a new plan sheet(s) or specification(s) 

• The deletion of an existing plan sheet(s) or specification(s) 
 
The creation and management of DICO’s shall be as specified in this section. 
 
Contract plans changed or added due to DICO’s shall be submitted in a digitally signed PDF discipline subset(s) 
containing only the added or changed sheets. The sheets being revised or deleted shall not be included in the 
Change Order submittal. The first sheet of each DICO subset shall be digitally signed in a digital signature place 
holder, that is placed in Bentley Software as described in Section 5 of this manual, DO NOT ADD a cover sheet. 
Once digitally signed the DICO subset(s) shall be submitted to the CTDOT using COMPASS.   
 
The contract sheets (previously submitted final plans, addenda plans, or DICO plans), being revised by DICO 
shall NOT be modified except when the Engineer of record places a DICO stamp on the revised sheets.  This 
digital DICO stamp crosses out the entire sheet with a red X and adds the following note: “THIS SHEET 
REPLACED BY DESIGN INITIATED CHANGE ORDER NO. “Y” where “Y” equals the Design Initiated Change Order 
number.  This stamp is placed over digital signatures.  
 
Warning:  When placing the stamps, removing the digital signature is not allowed. 
 
The Index of Revision Sheet(s) located in the 02-Revisions subset shall be updated by the project manager for 
all DICOs.  A new 02-Revisions subset shall be submitted for each DICO.   
 
A watermark of the signer’s signature; signature only for CTDOT-designed plans; or PE Stamp for Consultant-
designed plans shall be placed on all DICO sheets.   
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9.2.1.1 Bentley Software Processes 
The areas on the sheet that are being revised shall encircled by a cloud and a numbered triangle shall be 
placed somewhere on the line of the cloud.  A like-numbered triangle shall be placed in the revision block of 
the changed sheet, accompanied by a description of the revision itself.  The revision number is specific to a 
particular sheet and is specific to the number of times a sheet is changed, including addenda changes. It starts 
with one and increases by one for each revision or change to the sheet.  If a sheet is changed for the first time 
under DICO #5 then the sheets revision number is 1 since this is the first change.  If the next time it is changed 
again is under DICO #7 the revision number becomes 2 since this is the second change to the sheet. 
 
Details shown on the original sheet, but are no longer required, shall not be deleted but shall only be crossed 
out with an “X” on the revised sheet.  Engineering judgment must be used to produce clear and concise 
information for the contractor. 
 
If the number of changes to the sheet cannot be clouded in a clear and concise manner, the existing sheet 
should be voided. 

9.2.1.2 Bluebeam Processes 
A note shall be placed in the bottom left-hand side of the border of the replacement sheets stating, “DESIGN 
INITIATED CHANGE ORDER NO. “Y” where “Y” equals the Design Initiated Change Order number.  This note is a 
stamp in the CTDOT Miscellaneous tools in the Bluebeam tool chest that needs to be added and edited.  If you 
do not have these tools in the tool chest you can find them in Appendix A of this manual.   
 
Sheet numbers for revised plans shall be as follows: 

Description Sheet No. 
Original Final Plan Sheet 02.25 
DICO 1 02.25.C1 

 
Previous Addenda Sheet 02.25.A2 
DICO 4 02.25.C4 

 
Previous DICO 2 Sheet 02.25.C2 
DICO 4 02.25.C4 
  

Drawing numbers shall not be modified on revised sheets. 
 
Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp (Consultant) 
and the first sheet of the subset shall be digitally signed. 

 

9.2.2.1 Bentley Software Processes 
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one of two ways, as 
follows: 

1. If the new sheet does not have to be placed in a specific location within a discipline subset, the new 

sheet shall just be added to the end and numbered sequentially from the previous last sheet of the 
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discipline subset.  The total number of sheets noted on the project plans and discipline subsets stays 

the same.   

 
2. If the designer determines that the new sheet belongs in a specific location within a discipline subset, 

the new sheet number shall be the number of the sheet it most closely relates to followed by (-1.C#).  

For example, if the new drawing should reside in the 03-Highway discipline subset right after sheet 

03.57 but before sheet 03.58, the new sheet shall be numbered 03.57-1.C#. 

 
When adding a new sheet, a new drawing number is also required.  The drawing number of the new 
sheet shall be the drawing number of the sheet it most closely relates to followed by (-#).  For 
example, if the new drawing must be placed in the project plans right after drawing number HWY-10, 
the drawing number shall be HWY-10-1. 

9.2.2.2 Bluebeam Processes 
A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER 
NO. “Y”.  This note shall be placed in the bottom left-hand side of the border.  This note is a stamp in the 
CTDOT Miscellaneous tools in the Bluebeam tool chest that needs to be added and edited.  If you do not have 
these tools in the tool chest you can find them in Appendix A of this manual.   
 
Added sheet numbers shall be as follows: 

Description Sheet No. 
Original Final Plan Sheet 04.31 
DICO 3 04.31-1.C3 

 
Previous Addenda Sheet – Added Sheet 03.24.A1 
DICO 4 03.24-1.C4 

 
Previous DICO – Revised Sheet 02.45.C1 
DICO 2 
 

02.45.C2 

Previous Addenda – Added Sheet 05.14-1A1 
DICO 2 05.14-2.C2 

 
Previous DICO – Added Sheet 02.45-1.C1 
DICO 2 02.45-2.C2 
  

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the previous sheet 
number plus C#, where # equals the Design Initiated Change Order Request number. 

Description Sheet No. 
Original Final Plan Sheet 04.5 
DICO 1 04.6.C4 

 

New subsets shall be submitted by DICO and prepared the same way as an FDP discipline subset except with 
the addition of a C# in the sheet numbers and a note placed, in the bottom left-hand side of the border, on the 
replacement sheets stating “NEW SHEET ADDED BY DESIGN INITATED CHANGE ORDER NO. “Y”.  This note is a 
stamp in the CTDOT Miscellaneous tools in the Bluebeam tool chest that needs to be added and edited.  If you 
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do not have these tools in the tool chest you can find them in Appendix A of this manual.  first sheet of a new 
subset will be a subset cover sheet containing an index of drawings contained in that specific subset. 

 

Contract sheets are never deleted. Sheets submitted within final design plan subsets, addenda subsets, or 
design-initiated change order subsets that are no longer needed shall NOT be deleted, but shall be voided by 
the engineer of record, with a DICO stamp. The voided stamp crosses out the entire sheet with a red X and 
adds the following note: “VOIDED BY DESIGN INITATED CHANGE ORDER NO. “Y” where “Y” equals the Design 
Initiated Change Order number.   

 

Special provisions shall be created in accordance with the Contract Special Provisions. 

 

A DICO Memorandum from the Designer to Construction shall be prepared for all change orders.  This 
memorandum shall not include any digitally signed DICO plans and / or DICO specifications.  The memorandum 
shall include the following: 

• A detailed description and justifications of the changes requested. 

• Identify the funding source, if known. 

• A listing of each new, revised, replaced and / or voided plan sheet(s). 

• A listing of each new, revised replaced and / or voided special provision(s). 

• A list of the changes in the estimated quantities for the project (increase, decrease).  The list should 

also include any item that is new to the project or any item that is deleted because of the revised 

work.  Item numbers of items already in the project should be provided.  Item numbers for items that 

are not currently in the contract should be provided if known. 

• The estimated increase in cost or credit associated with the change order request. 

 

The designer shall prepare a DICO to a CTDOT Standard Drawing subset in accordance with the following. 
 
The DICO for a standard subset shall only include the added sheets, do not include all the standards for the 
project.  Only include the added sheets and check off only those sheets on the index sheets.  
 
When uploading to COMPASS add a “C##” to the end of the label attribute.   
 
Update the 02-Revision Subset to record this change.  

 

Please see Design Initiated Change Orders in COMPASS for a sample workflow for sending Design Initiated 
Change Orders using the COMPASS Submittals/Transmittals (S&T) application. 

9.3. 02-Revisions Subset 
The project manager is responsible for managing this subset.   
     
Each project has a 02-Revisions subset, and this subset only contains the “Index of Revisions Sheet(s)”.  These 
revision sheets are used for tracking all sheet changes due to addenda (ADP) and Design Initiated Change 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Design-Initiated-Change-Orders-in-COMPASS.aspx
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Order (DICO) with respect to the entire project.  The 02-Revisions subset starts out as an un-signed blank place 
holder in the project.  This file can be found here and doesn’t need to be edited until an Addendum or Change 
Order occurs. 02-Revisions  When an addendum or DICO is required an 02-Revisions file shall be created in 
CAD following this process:  The figure below is an example of a blank 02-Revisions subset: 

 
 
ADDENDA: 
When the project requires an Addendum, the Project Manager must record these changes on a NEW 02-
Revisions_A## subset, where A## equals the Addendum ##.  New 02-Revisions subsets shall contain all 
previous Addendum information.  For example, Addendum 4 shall include all changes made from Addendums 
1, 2, 3 and 4.   
 
Note: A New 02-Revisions subset is required for each addendum because there are times when multiple 
addendums are being submitted to contract processing for the same project.  An example of this is if 
Addendum 1 and Addendum 2 are submitted to processing at the same time, two addendum revision sheets 
must be submitted. 

 

When a project requires a Design Initiated Change Order (DICO), the following process shall be followed: 
 
For each DICO, the Project Manager shall create a new 02-Revisions subset.  The 02-Revision subset shall 
always contain all previous Addendum information and the new DICO information.  For example, when DICO 
#1 is prepared, the 02-Revisions subset shall include all Addendum information as well as the changes made 
for DICO #1. 
 
The following figures are an example of the “Index of Revisions Sheet(s)” completed up to Addendum #3:  

https://portal.ct.gov/-/media/DOT/documents/AEC/02-revisions.pdf


Connecticut Department of Transportation – Digital Project Development Manual

111 
 

 
Detail A from figure 1 shows the information typed in for a change to the contract plans.  The project designer 
inputs the Addendum or DICO number, the sheet number, the date, a description of the change, the person 
who made the change, and checks the appropriate box for: new sheet added, revised sheet or deleted sheet.  

 
 
Detail B shows the title block information.   
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Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project Manager as 
follows: 

1. The user will checkout the 02-Revisions subset from COMPASS.   

2. With your digital signature USB key inserted within the USB, right click on the Signature Box, and select 
Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset 
will not have a signature on it:  

 
 

3. Enter the information into form fields as described. 

4. Add note “ADDENDUM NO. Y” in the bottom right-hand corner of the sheet above the title block, 
where Y = the Addendum number.   

5. Add new revision sheet each time previous sheet becomes full.  Add note “NEW SHEET ADDED BY 
ADDENDUM NO. “Y”, where “Y” equals the addenda number.  

6. When finished sign using a certifying signature. 

7. Check the document into COMPASS to save the changes. 

 

The following workflow shall be used by the Project Manager for recording DICOs to the 02-Revisions subset.  
In this workflow the user edits the subset in COMPASS, they do not have to export the document out and 
submit a new subset: 

1. Check out the 02-Revisions subset from COMPASS.  See Checking Out Documents to Bluebeam for 
instructions. 

2. With your digital signature USB key inserted within the USB, right click on the Signature Box, and select 
Clear Signature as shown below, this is the first Addendum this step can be skipped since the subset 
will not have a signature on it:  
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3. Enter the information into form fields. 

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y ” 

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET ADDED BY 
DESIGN INITIATED CHANGE ORDER NO. Y” 

6. Resign the 02-Revision subset. 

 

1. Download a new “Index of Revisions sheet.”  
2. Insert the new sheet into the existing 02-Revisions subset pdf.  Update the title block information and 

update the sheet accordingly.   

 

To fill out a form field simply click on the box and begin typing. The first column is the Addendum or Design 
Initiated Change Order. The second column is the revised or new sheet number. The third column is the date, 
followed by a brief description that is like the description on the actual sheet being revised. Finally click in the 
appropriate check box per row to describe the action taken, new sheet, revised sheet, or sheet deleted.  Note:  
The Engineer is not required to input changes numerically by Sheet No.  If another changed sheet is added to 
an Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of Revisions 
Subset”.    

 

9.4. Placing Stamps on Affected Sheets – Revised, or Deleted Sheets 
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A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that are affected by 
Addenda or Design Initiated Change Order. The stamp shall be placed using Bluebeam’s Stamp tools and can 
be found in the tool chest under the miscellaneous stamps or in Markup>Stamps as shown below:    
 

 
 
If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User Profile as 
shown in Appendix A.  If you do not have the stamp in the Markups>Stamp area, see Appendix A – Bluebeam 
Stamps. 
 
WARNING – When placing the stamps, removing the digital signature is not allowed.  The table below lists the 
notes that shall be used for addenda, construction order requests, and as built notes. These notes should be 
used in conjunction with the cross-out stamp.  
 
The following shows how to apply the stamp to the sheet that needs to be crossed out for an Addendum or 
Change Order.   

1. Select the stamp from the Tool chest or Markup>Stamps and place it:
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2. After the stamp is placed a box will pop up.  Enter the applicable note from the table below in all 
caps as shown below: 

 

 

Addendum Notes Description of Use 

THIS SHEET REPLACED BY ADDENDUM 
NO. Y 

The revised sheet is considered to replace, 
in total, the original sheet. 

VOIDED BY ADDENDUM NO. Y Sheet is voided by Addendum. 

  

Design Initiated Change Order Notes Description of Use  

THIS SHEET REPLACED BY DESIGN 
INITIATED CHANGE ORDER NO. Y – 

mm/dd/yy 

Used for revisions to existing sheets. 
Changes must be noted only on the revised 

sheet.     

VOIDED BY DESIGN INITIATED CHANGE 
ORDER NO. Y – mm/dd/yy 

Use this for voiding of existing sheets. 

 
3. The following shows a completed stamp. 
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10. As-Built Comments - Final Plans 

As stated in the CTDOT’s Construction Manual chapter 1-314 “As-Built Drawings and Final Revisions of Plans 
(As-Builts)”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or State Forces 
(Office of Construction) to perform final as-built revisions of Contract Plans.  As-Built revisions shall be 
recorded in accordance with Chapter 1-314 of the Construction Manual, amended as follows: 

Final as-built revisions will be applied to the digitally signed PDF plans as a digital comment, using 
Adobe or Bluebeam’s commenting tools. Digital comments are placed over the top of the digital 
signature and its security; therefore, the original content of the PDF plans can never be altered. 
Because as-built comments are digital and placed over the top of the plans they are easily 
recognizable, searchable, and may be turned off if necessary. 

As-built comments shall be applied to the latest sheet, whether it’s the original, addenda, or 
construction order plans, located in COMPASS within the project’s 100_Contract Plans folder.  

If additional As-Built information has been created, (information that cannot be placed on the digitally 
signed contract plans), these sheets shall be combined by subset number and uploaded into the 
100_Contract Plans folder in COMPASS.  

CAD drawings may be updated, at the discretion of each design office, to reflect any addenda, change 
orders, and as-built revisions for use in the future; however, the original digitally signed as-built PDF 
plans shall not be replaced and shall be the PDF set for permanent records.  

10.1. As-Built Revisions (Digital Comments) Workflow 
Two methods for applying as-built revisions to the digital PDF plans are provided in the following sections. 
 
The first method, Post Construction, district staff shall record as-built revisions on their record set (paper 
copies) during construction. Once construction is completed these revisions shall then be applied as comments 
to the digital PDF. 
 
The second method, Active As-Built, district staff shall record as-built revisions on their record set (paper 
copies) and shall apply them as comment to the final set of digital PDF plans on an intermittent bases, during 
construction. By using this method as-built information becomes available to all parties that have access to 
COMPASS during the construction process, improving communication and transparency.  

 

As-Built Workflow 
Step Personnel  Task 

1 Chief Inspector Notify the Contracting Engineer or Designated District Staff that As-Builts 
can be applied to the Contract Plans. 

2 Contracting Engineer or 
District Staff 

Apply As-Built revisions to the Contract Plans in accordance with Section 
8.3 

3 Contracting Engineer or 
District Staff 

Notify all applicable personnel list in the Section 8.4.2 that the As-Builts 
have been completed for this project. 

10.2. As-Built Markup of Contract Plans 
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All as-built information will be placed using a few basic Bluebeam commenting tools.  These tools include text 
tools, line and arrow tools, and stamp tools (all other tools will still be available under the main toolbar).  
These tools will be in the right-hand panel under “CTDOT As Built Tools” toolbox when the CTDOT As-Builts 
Profile is selected (see CTDOT Bluebeam Profile): 

 

10.3. Applying As-Built Comments to Contract Plans 

 
All CTDOT users are required to complete the steps in Appendix A prior to applying as-built revisions. By 
completing these steps as-built revisions will be standardized across all CTDOT users.   These steps only 
need to be completed the first-time using Bluebeam or when the user logs into a new computer. 

• Perform the initial login steps for Bluebeam.  Initial Log In to Bluebeam 

• Download the CTDOT Bluebeam profile.  Download CTDOT Bluebeam Profile 

• The user must have access to the COMPASS project.  All DOT users automatically have access.  

Consultants must be invited per project.  See COMPASS Project Site Permissions. 

 

https://portal.ct.gov/-/media/DOT/documents/AEC/CTDOT-Bluebeam-User_profile.zip?sc_lang=en
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The contract plans are in the Contract Documents → 100_Contract_Plans (PDF) folder of the COMPASS project 
site. 

 
 

1. Log-in to the appropriate COMPASS project site using Microsoft Edge. 

2. Browse to Contract Documents → 100_Contract_Plans (PDF).  

3. Click on the document to open.  See Checking Out Documents to Bluebeam for instructions on how to 

check-out and check-in the document. 

 

10.3.3.1 Construction Started & Completed Dates 
The construction started and complete date stamps must be applied to the PDF title sheet, located in the 
01_General subset, as stated below: 
   

1. Select the ”Construction Started and End Dates”: stamp from the “CTDOT As Built Tools” toolbox and 

place it at a conspicuous location on the title sheet: 

 
 

2. Enter Start and end and click OK as shown below: 
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Below is an example of the placed stamp: 

 

10.3.3.2 This Sheet Not Corrected Stamp 
This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail Estimate Sheets must 
never be revised; therefore, they always receive this stamp. 
 

1.  To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select that stamp from 

the CTDOT As Built Tools toolbox and place it in the lower right-hand corner of the sheet, by clicking 

once. 

If most of the sheets do not contain as-built revisions it is easier to apply this note to every sheet included in 
plan set, including the as-built revised sheets, and then go back and remove it from the sheets that were 
corrected.  
 

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that stamp from the 

CTDOT As Built Tools toolbox and place it in the lower right-hand corner of the first sheet in the plan 

set: 
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2. Right click on the stamp that was placed and select “Apply to All Pages”: 

 
This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the pdf set.   
 

NOTE:  You must go back and replace this note on the sheets that contain as-built revisions with the 
appropriate stamp.  

10.3.3.3 This Sheet Corrected 
This stamp must be applied to all PDF sheets that contain as-built revisions.  
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1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that stamp from the 

CTDOT As-Built Tools toolbox and place it in the lower right-hand corner of the sheet, by clicking once. 

If most of the sheets contain as-built revisions it is easier to apply this note to every sheet included in plan 
set, including sheets that do not contain as-built revisions, and then go back and replace it, with the 
appropriate stamp, on the sheets that were not corrected.  
 

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp from the CTDOT 

As Built Tools toolbox and place it in the lower right-hand corner of the first sheet in the plan set: 

2. NOTE:  You must go back and replace this note on the sheets that do not contain as-built revisions 
with the “THIS SHEET NOT CORRECTED” stamp.  

 

To place an as-built revision, simply select any of the provided tools located within the as-built toolbox shown 
below and apply it to the document that is being as-built.   
 

 
 
In the following example, the Line tool was used to cross out the existing text and the Text Box tool was used 
to add text:  
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Do not add a note to a comment by double clicking on the comment.  For example, if a line was placed the 
user could double click on the line and add notes to it: 

 

If notes are added this way they do not print.  

10.3.4.1 Digital As-Built Stamps and Notes Using ADOBE 
The following stamp files need to be downloaded to the user’s computer and placed in this folder:  
C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\.  This could be either C:\ or 
D:\ Drive depending on your computer. With the “User” folder being the current user’s login Username.  If 
Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous sentence if version 10 is used replace with 
10.   
Stamp Files 
As-Built stamps.pdf  
 
As-Built notes shall be placed on the plans using the Adobe commenting tools in the following format: 

1. Text Font shall be Cambria 16, and the color Red. 

2. All line work shall be line width 2 and the color Red. 

 

Additional As-Built Information that cannot be applied to the contract plans can be uploaded to COMPASS for 
future use.  This information shall be uploaded to COMPASS in accordance with the following: 

1. Combine the additional As-Built information into (1) PDF for each discipline subset.  For example, if 
the 03-Highway and the 04-Structures set had additional As-Built information, 2 separate PDFs 
would need to be uploaded to COMPASS.   

2. After the additional As-Built information is combined into their respective files they will need to be 
uploaded to the Contract Documents → 100_Contract_Plans (PDF) folder in COMPASS. 

 

If the project limits were changed in construction, the project polygon KML file shall be updated.  The following 
shows how to do this. 

https://portal.ct.gov/-/media/DOT/documents/AEC/as-builtstamps.pdf
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1. Browse to the Internal Documents → 170_Row Files folder in COMPASS and double click on the 
FDP Boundary. 

 
 

2. Open the file with Google Earth.  It may say KML like below. 
 

3. After the polygon opens, right click on Style 1, and select properties.  This will allow you to edit the 
polygon. 

 
 

4. Then adjust the polygon as necessary by dragging the red points. 
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5. Then click OK on the properties box. 

 
 

6. Then right click on Style 1 and select Save Place As 



Connecticut Department of Transportation – Digital Project Development Manual

126 
 

 
 

7.  Name the file construction polygon and save it as a KML file:  

 
 

8. Then upload this file into the Internal Documents → 170_ROW Files folder in COMPASS and name 
the file Construction. 
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10.4. Notifications 

 

When the As-Built information is completed and ready for permanent storage, create a ticket in the COMPASS 
Support Desk providing the following information: 

• Project Number 

• Note that As-Built information is complete and ready for permanent storage. 
 
After the ticket to the COMPASS Support Desk is verified complete, the person responsible for the as-built 
revisions shall notify the appropriate Department personnel via a memorandum.  Prepare a memo and route it 
via the S&T application, assigning all necessary parties as reviewers.  Reviewers shall click complete in the 
submittal reviewers section to confirm receipt. 

• Lead Designer 

• Chief Inspector 

• Central Surveys 

• ROW 

• Central Construction 

• Bridge Maintenance (if a structure is on the project)  

 

  

https://ctdotcompass.atlassian.net/servicedesk/customer/portals
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
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11. Contractor Submittals 

11.1. COMPASS Submittal/Transmittal Application 
This section establishes the requirements for the submittal and processing of Contractor Submissions using 
COMPASS’s Submittal/Transmittal Application (S&T).  The business processes for Shop Drawings, Working 
Drawings, and Product Data (Catalog Cuts) are defined within this manual.  For all other submittal types, please 
follow relevant manuals.  It is the responsibility of the Engineering Project Manager to ensure that a Contractor 
Submittal List is populated by all support units (see also ECD-2020-1_Contractor_Submittals.pdf).  This list is to 
be stored in the 110_Contract_Documents folder in COMPASS to ensure access for all members of the project 
team, including the Contractor.  The list shall include the expected contractor submittals, such as but not 
limited to Shop Drawings, Working Drawings and Product Data. This list will eliminate confusion and improve 
contractor submittal turnaround times.  This list will be maintained and amended as needed by the 
construction team throughout the duration of construction. 

 
The S&T Application is a custom-built application that enables Contractors to digitally deliver documents to the 
Department for processing. 
 
High level S&T Application Functionality: 
 

• Provides free, cloud-based access for the Contractor 

• Cloud-based storage and access for the Department 

• Automatically delivers submittal documents to the appropriate CTDOT staff 

• Ball-In-Court (BIC) submittal review tracking and notification controls  

• Automatic document version control for modified or replaced documents 

• Automatic document storage in correct folders  

• Integrated with Bluebeam  
 
The S&T Application automatically tracks what processing phase the contactor submittal is in and who is 
currently responsible for reviewing the submittal. Staff are tracked using a BIC workflow. The processing phase 
is tracked using the Submittal Review Status. These tracking functions will be described in detail below.  
 
Once documents are delivered to the Department, the S&T Application allows Department Staff to establish 
custom BIC review processes that include one or more reviewers. Reviews that require multiple staff may be 
conducted in series or in parallel. Notifications and reminders are automatically sent to the appropriate staff 
using email. Notifications include both instructions and links to the submittal documents.  
 
The S&T also automatically creates versions of replaced or modified documents, providing a high level of 
quality control and making finding the latest document easy.   
 
The following fundamental set up is required for each project prior to using the S&T Application: 
 

Action Responsibility 

1. Set-up project site, including item number list Automated / AEC Applications 

2. Complete the Approval Matrix Engineering and Construction PMs 

3. Set-up COMPASS Project Site Permissions Engineering and Construction PMs 

 

From the Project Landing page, navigate to the Submittals/Transmittals page. 

https://portal.ct.gov/-/media/DOT/documents/AEC/Contractor-Submittal-List.xlsx
https://portal.ct.gov/-/media/DOT/documents/AEC/Contractor-Submittal-List.xlsx
https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2020-1_Contractor_Submittals.pdf
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All project submittals display in the S&T table.  The table can be sorted and filtered as needed. 
 

• Search by key words from submittal name. 

• Filter by Submittal Type, Status, Ball in Court, or Due Date. 

• Sort columns in ascending or descending order. 
 

 
 

 

 

The review statuses identify where a given submittal is in the workflow for Contractor submittals.  Review 
statuses display the workflow status within the S&T application; this is distinct from the Department’s 
disposition. 

Review Status Contractor Submittals 

Process Assignment Submittal received by DOT; submittal owner needs to establish review workflow 

In Review DOT reviewing submittal; Contractor cannot view submittal documents 

Revise and Resubmit Contractor to amend documents 

Send Back Assigned reviewer requesting a change from the submittal owner 

Draft Saved work; person who created draft needs to act  

Complete Submittal fully processed 
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The Engineering Project Manager and Construction Project Manager are jointly responsible populating 
Approval Matrix.   
 
The To column identifies the submittal owner for a given submittal type.  This individual is responsible for 
review and tracking of all contractor submittals of the given submittal type.    
 
The CC column is optional.  Staff added to the CC list have no required action and are not given any special 
privileges or access rights.  Individuals in the CC list receive an email notification each time the following 
actions occur for the given submittal type: 
 

• New submittal created (Process Assignment) 

• Submittal marked as Revise and Resubmit 

• File(s) replaced in response to a Revise and Resubmit (Process Assignment) 

• Submittal marked Complete 
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The submittal owner is the CTDOT/Consultant employee responsible for assigning any reviewers (optional), 
initiating a Bluebeam Studio Session (optional), setting due dates in conformance with any contractual 
obligations, and responding to the Contractor with the Department’s disposition. 
  
Submittal owners are assigned to a specific submittal type in the Approval Matrix.  
 
Because submittal owners are responsible for establishing the BIC custom review workflow, they must possess 
a strong understanding of the business processes associated with their submittal type.  They must thoroughly 
understand who performs each step and how much time shall be allotted.  They must actively check on 
progress and ensure the submittal review is completed and returned within the contractual timeframe.  

11.2. Setting up the S&T Application 
This section provides directions on how to provide access to project staff, how to complete the Approval 
Matrix, and how to invite the Contractor.  

 

All individuals who need to access a project site – including CTDOT staff, consultants, and contractors – must 
first be granted project-specific access using COMPASS Project Site Permissions.  The Engineering and 
Construction PMs, or those they delegate, are jointly responsible for setting up the site permissions at the 
beginning of a project and maintaining them throughout the duration of the project. 

 

After establishing site permissions, the Engineering and Construction PMs are jointly responsible for setting up 
the Approval Matrix.  Always populate the Approval Matrix before inviting construction contractors to the 
project site.   
 



Connecticut Department of Transportation – Digital Project Development Manual

132 
 

Project site owners have the ability to edit the Approval Matrix.  Project site members have the ability to view 
the Approval Matrix as read-only. 
 
To access the Approval Matrix: 
 

1. Navigate to the Submittals/Transmittals page. 

 
 

2. Open the Approval Matrix by selecting the Approval Matrix button, located next to the New Submittal 

button. 

 
 

3. Click in one of the field boxes for a Submittal Type. 

4. Start typing the person’s name in the box under the “To” column and select the correct name when it 

appears.  For consultants who have a ct.gov email address, select the user’s company email address, 

not their ct.gov account.  

5. Repeat for other submittal types. 

6. Click Save before closing the dialog box.  

7. Activate/Inactivate submittal types as needed.  Any submittal types inactivated will not display as 

options for the Contractor. 
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In addition to assigning the required submittal owners, PMs may also add staff to the optional CC list for each 
submittal type.  IMPORTANT - In order for staff to receive submittal notifications through the use of the CC list 
the PM must not only add them to the Approval Matrix but must first grant them access to the project in 
COMPASS via the site owners or site members permissions group, as described in COMPASS Project Site 
Permissions. 
 
To add a user to the CC list:  
 

1. First use the same instructions listed directly above to navigate to the Approval Matrix.  
2. Click on the box under the CC column and start typing a name.  Select the name.  Click the Save button 

at the bottom or top of the dialog box.  

 

 

The CTDOT Construction Project Manager (Project Engineer or Chief Inspector) is responsible for inviting the 
Contractor to the project. Contractors need to be sent a separate invitation for each project.  Ensure that the 
Approval Matrix is populated before inviting the Contractor. 
 
To invite a Contractor to a specific project in COMPASS, follow the steps described in Setting up Site 
Permissions Groups.  Invite the Contractor to the xxxx-xxxx Contractors permissions group.  The Contractor 
should accept the invitation following the instructions provided in Accepting an Invitation (External Users). 

11.3. How to Process a Contractor Submittal 
Once the Contractor delivers a submittal, the submittal owner is responsible for establishing and starting the 
Department’s BIC internal review workflow.  Submittal owners establish who needs to review the Submittal, 
initiate a Bluebeam Studio Session (optional), set due dates in conformance with any contractual obligations, 
and respond to the Contractor with the Department’s disposition.  

 

The three types of Contractor submittals identified below are covered in this manual. Although they are 
covered in this manual, they are each being precisely defined in your project Contract specifications. The 
following ‘shorthand’ descriptions are provided for instructional purposes but are not the controlling 
definitions.  
 
Shop Drawings supplement the information in the contract documents (e.g., plans and specifications) and 
include details, diagrams, etc.  
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Working Drawings portray the design of an engineered feature required by the Contract that was not designed 
by the Department’s Designer. Working Drawings and supporting information are prepared and stamped by a 
Professional Engineer serving as the Contractor’s designer.  
 
Product Data (Catalog Cut) is product information developed and made available by manufacturers, such as 
product specifications, diagrams, installation instructions, etc. 
 
IMPORTANT - Although, contractors submit other types of submittals to the Department for review, only the 
workflows for the three submittal types are covered by this manual. Please see other office manuals and 
directives as necessary.  

 

This section summarizes key points related to processing Shop & Working Drawings and Product Data 
Contractor submissions, with a focus on Department responsibilities and coordination. 
 
This summary is an overview of the Contractor submittal and internal review processes and is intended to be 
an instructional overview. It is important to understand that the contract documents (i.e., including special 
provisions), not this summary, control the actual requirements between the Contractor and the Department, 
and should be referenced for all project decisions.  
 
Timely, coordinated, and effective communication is essential to the successful and equitable completion of 
the Contract. Generally, the Department is required to respond to a contractor submittal within 30 calendar 
days of its receipt, with 20 additional days allowed to process any necessary resubmissions. Special provisions 
may alter this typical timeline.  
 
Shop Drawings/Product Data along with supporting information shall be submitted by the Contractor to the 
Department and shall be processed by the Department’s submittal owner using COMPASS.  
 
Once received it is the owner’s responsibility to ensure that the shop drawing is reviewed, that appropriate 
comments have been made and the Department’s disposition is clearly defined by stamping each shop 
drawing sheet and, at a minimum, the cover sheet of any multi-page support documents with the appropriate 
Department (digital) Action stamp.  

 
Working Drawings along with any supporting information, transmittal, calculations, and certificates of 
insurance, shall be submitted by the Contractor to the Department and shall be processed by the 
Department’s submittal owner using COMPASS. 

 
Once received, it is the Construction District’s responsibility to ensure that the working drawing is reviewed, 
that appropriate comments have been made and the Department’s disposition is clearly defined by stamping 
each working drawing sheet and, at a minimum, the cover sheet of any multi-page support documents with 
the appropriate Departments’ (digital) Action stamp.  

 
It the discretion of the District to decide if they need assistance from the Office of Engineering during the 
review process. Typically, the District will ask the Design Engineer(s) to perform a review on Working Drawing 
submissions involving structures and complex engineering. All requests for additional reviews shall be 
completed in COMPASS. See the Construction Manual for guidance for additional reviewers.   

 
When requested by the Construction District, the Department’s Designer(s) from the appropriate discipline(s) 
(e.g., Bridge, Highway Design, and Traffic Engineering) shall review the Working Drawing documents, and 
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stamp (with a Review stamp) each Working Drawing sheet and, at a minimum, the cover sheet of any multi-
page supporting documents.  

 
Each time a reviewer applies a “Reviewed with Comments” stamp they must also provide a comment note that 
clearly describes the reviewer’s recommended disposition, i.e., exceptions as noted, revise and resubmit, or 
reject.  

  
The Construction District should evaluate the Designer’s comments and recommendations and meet with the 
Designer and/or Contractor to resolve any conflicts. 

 
After considering the Department’s Designer’s review comments and other pertinent information, the 
Construction District will make appropriate adjustments to the comments and clearly define the Department’s 
disposition by stamping each Working Drawing sheet and the cover of associated support documents with the 
appropriate action stamp. 

 
All communications between the Contractor and Construction District and between the Construction District 
and Department Designer shall take place in COMPASS. 
 
The submittal type the Contractor selects determines which submittal Owner will receive the submittal and 
what internal business process review will be implemented.  Some submittals will be processed by 
Construction, some by Engineering, and some by both. COMPASS’s flexibility allows submittal Owners to 
establish a variety of review workflows. Review workflows for all submittal types must adhere to all standard 
business processes as defined in the Contract, issued as directives, and defined in office manuals.   
 
IMPORTANT - For employees to participate in a review they must first be given access to the project in 
accordance with section COMPASS Project Site Permissions. 

 

Overview 
To improve the accuracy and turnaround time of landscape related Contractor submittals, Landscape 
Submittal Templates, and the COMPASS submittal type ‘Landscape Submittals’ have been created. Fillable 
Landscape Submittal Template forms can be found in the Appendix of the COMPASS Contractor's User Manual.   
 
Note: Only items listed under ‘Landscape Items’ on the Contracts Detailed Estimate Sheet shall utilize the 
Landscape Submittal Templates and be submitted as a ‘Landscape Submittals’ submittal type. 
 
The following Landscape Submittal Templates are available for Contractor use: 

1. Plant Material Submittal Template 

2. Request for Substitution of Plant Material Submittal Template 

3. Supplemental Landscape Item Submittal Template 

4. Landscape Seeding Submittal Template 

All Landscape Submittals shall be uploaded to COMPASS using the submittal type ‘Landscape Submittals’ 
except for any requests for change (request for substitution of plant material) which shall be uploaded as an 
RFC submittal type. 

https://portal.ct.gov/-/media/DOT/documents/AEC/COMPASS-Contractors-User-Manual.pdf?la=en
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Filling Out the Landscape Submittal Templates 

 
All Landscape Submittals 
 
Each Landscape Submittal will begin with general information about the project and the contractor(s) and 
should be filled out as shown in the example below: 
 

1. Plant Material Submittal Template 

All plant material items may be included in a single submittal for the project, or in a single submittal for each 
planting season. Information in the Plant Material Submittal template includes the Plant Material Source of 
Supply, as well as all other materials required by the pay item as specified by the contract specifications. 
 
If the Contractor is unable to source any of the plant items, an RFC Plant Material Submittal Template shall be 
submitted and approved prior to this submittal. 
 
The Plant Material Submittal Template includes the following sections: 

A. Plant Material Cover Sheet 

B. Plant Material Source of Supply 

C. Planting Soil 

D. Fertilizer 

E. Mulch 

F. Tree Stakes 

 
A. Cover Sheet 

The cover sheet contains general information about the project and Contractor(s), and an affidavit 
which should be completed by the Contractor. The rest of the form will be used by the department to 
track the status of the multi-page submittal.  
 

B. Plant Material Source of Supply 
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The Contractor shall complete one sheet for each plant material supplier being used, and on each 
sheet shall specify: 

• Supplier information: name, address, a contact representative for the supplier and their phone 

number 

• Attached copies of the suppliers Certificate of Inspection issued by federal or state authorities 

which attest to the plant materials freedom from diseases and insect infestations. 

• Item number, item description, and item quantity of the items being sourced from that supplier. 

 
C. Planting Soil 

Provide the manufacturer, supplier, and quantity of, and attach a certified test report for both 
compost and peat moss which is to be used for the creation of the planting soil being provided for the 
installation of plant material within the submittal. 
 

D. Fertilizer 

Provide the grade of fertilizer to be used, and provide the Guaranteed Analysis of the product, or 
attach a copy of the product label clearly showing such information. Also provide the fertilizer 
manufacturer, supplier, and the quantity to be used in association with the plant material within the 
submittal packet. 
 

E. Mulch 

Provide the mulch product type and name, particle size and color, as well as the manufacturer, 
supplier, and quantity to be used in association with the plant material within the submittal template. 
 

F. Tree Stakes  

Provide a written description of the materials to be used for tree staking and the intended installation 
method. A copy of the manufacturer’s installation instructions may supplement a written description 
of the installation method. The products manufacturer, supplier, and number of trees to be staked 
shall also be provided. Trees under 2” caliper require a minimum of two stakes each, and trees larger 
than 2” in caliper require a minimum of three stakes each, unless otherwise specified in the contract.  
 

2. Plant Material Request for Substitution Submittal Template 

Use this template for any plant materials in which the plant species in the contract is unable to be sourced or 
the contractor is requesting a substitution for any other reason. One submittal template must be filled out 
each item being requested for substitution. 
All Plant Material Request for Substitution Submittals shall be uploaded to COMPASS under the submittal type 
“RFC”. 
The information provided on each Plant Material Request for Substitution Submittal Template shall include: 

• Original Contract item information: Provide the item number, description, plant size, and quantity of 

the original contract item that is being requested for substitution. 

• Reason for the request for substitution: If the item was found to be unavailable in the region, check 

the corresponding box. If requesting the substitution for any other reason, check the second box and 

provide an explanation for the request. 

• Attempted sources: Identify A minimum of 3 sources/vendors which were unable to supply the original 

contract item. 

• Proposed Substitution: Identify any proposed plant species for the substitution (optional) 

• Identify any changes in cost for the substituted item. 
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3. Supplemental Landscape Item Submittal Template 

Provide the general information about the project and contractor(s) and complete the affidavit attesting to the 
items’ conformance to the contract specifications. Also provide the item number and name, and the quantity if 
applicable. Provide any other information required by the specification in the space provided or attach 
additional sheets. 
 

4. Landscape Seeding Submittal Template 

Provide the general information about the project and contractor(s) and complete the affidavit attesting to the 
items’ conformance to the contract specifications. Provide the item number, name, and the quantity of the 
seed mixture to be used. Also provide an attachment from the supplier stating the seed mixture components 
and their purity rate by percent of mass, germination rate, and origin of each species in the mix. Also provide 
any other information required by the specification as attachments. 

 

1. For Section 1.20 Facilities projects, please see Appendix F for the Submittal Transmittal Form.  The 

Contractor shall attach the Submittal Transmittal Form to the beginning of each PDF submittal.  The 

form will be used for the Contractor to digitally certify that “Having reviewed this submittal, I certify 

that it is complete, accurate, coordinated in all aspects of the item being submitted and conforms to 

the requirements of the Contract in all respects, including all Federal requirements such as the ‘Buy 

America Act (BAA)’ and the ‘Build America, Buy America (BABA) Act,’ except as otherwise noted.”  

 

2. The Contractor shall follow recommended Naming Conventions and the following additional 

recommendations for Section 1.20 Facilities Submittals: 

 
a. File Name:  

Project Number [####-####] Submittal Number [###] Facilities Submittal Type (one 
only) [##] [Description]  

Example:  

0034-0350 001 SD Concrete Pads   

i. Project Number: 8-digit project number.  
ii. Submittal Number: chronological submittal number created by the Contractor 

starting at 001.  
iii. Section 1.20 Facilities Submittal Types:  

1. Shop Drawing - Facilities (SD)  
2. Product Data Sheet – Facilities (PD)  
3. Product Sample (PS)  
4. Coordination Drawing (CD)  
5. Working Drawing (WD)  
6. Facilities Submittal – DO NOT USE  
7. Quality Assurance Submittals (QA)  
8. Operation and Maintenance Manuals (OM)  
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9. Spare Parts Transmittal (SP)  
10. Warranties (WA)  

iv. Description: Brief description of submittal content.  
  

b. Submittal Name:  

Same as File Name except remove Project Number.  

Example:  

001 SD Concrete Pads   

3. Subsequent Resubmittals:   
a. File Name remains the same.   
b. Submittal Name shall remain the same and shall include revision number (e.g., R1, 

R2, etc.) to name the resubmittal chronologically, after the Submittal Number.  

Example:  

001R1 SD Concrete Pads  

 

When the Contractor creates a new submittal in COMPASS, the initial review status is Process Assignment.  
 
In this phase the submittal owner first reviews the submittal for completeness.  If complete, submittal owners 
establish the BIC review workflow by adding the correct staff; setting due dates; setting the review order; and, 
launching a Bluebeam Studio Session, if needed.  Once the submittal owner presses the Start button the 
review status changes from Process Assignment to In Review. 
 
Submittals may be reviewed by a single reviewer (the Submittal owner only) or by multiple staff, including the 
submittal owner.  Either option always requires the owner to be the last reviewer. Being the last reviewer 
allows the owner to complete the workflow. 
 
During Process Assignment, Contractors can view the documents via the S&T envelope and the 
120_Contractor_Submittals (PDF) folder.  To ensure confidentiality, ensure the review status is In Review 
before applying any comments to the Contractor submittal documents. 

 

The submittal owner will perform an initial cursory assessment of the submittal before beginning the review 
cycle.  The initial assessment shall validate if the correct documents are attached, the documents are 
complete, are signed, are in the correct file format, etc.   

 

If the submittal owner deems the assessment satisfactory, the submittal owner will establish the review 
process to be used for the specific submittal documents from the following list provided below.  If the 
assessment is deemed unsatisfactory, see Incomplete Submittals.  
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1. Submittal owner opens the submittal by clicking the submittal name or review status in the S&T table. 
  
2. Start a Bluebeam Studio Session, if needed. 

 
3. Enter the appropriate due date by clicking on the calendar. 

 
4. Press the Start button at the bottom of the Submittal Process Assignment window.   

 

 
 

5. Once the Start button is clicked, the submittal owner will receive an email notification and the 
submittal review status will advance to “In Review” in the S&T table. 

 

An expedited approval option is available to an individual reviewer if the following conditions are met: 

• No other reviewers are needed. 

• No Bluebeam Studio Session or document mark-ups are needed. 

• The submittal can be accepted and completed as-is with no need for a Revise and Resubmit process. 

If such conditions are met, from the Submittal Process Assignment page, the submittal owner may push the 
Bypass Approval & Complete button. 

 
 

When the Bypass Approval & Complete button is selected, the Review Status automatically updates to 
Complete, and the appropriate notification is sent to the Contractor. 
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For workflows involving multiple reviewers, it is recommended that a Bluebeam Studio Session be used to 
facilitate a collaborative review.  See Starting a Bluebeam Studio Session for details. 
 
To establish a review workflow which includes multiple reviewers, the submittal owner opens the submittal 
and sets the appropriate due date, order of review, and task for each assignee.  Users may save frequently 
used reviewer lists to be applied in the future.  Once all staff is added according to business needs, press the 
Start button to initiate the automated Ball-In-Court workflow. 

1. Name:  Select the appropriate DOT or consultant staff.  Users must have permissions to the project 
site to be assigned as a reviewer. 

2. Due Date:  Set the due date for each person. 
3. Order of Review:  Set the order of review in series, parallel, or any combination thereof, in accordance 

with the business need.  Multiple review steps can be set for the same due date, if needed. 
4. Task:  Select the appropriate comment from the drop-down menu.  This comment will display in the 

S&T envelope and populate in the recipient’s email notification. 
a. Review:  Default comment.  Assignee is expected to add comments or review stamps to 

documents. 
b. Contribute:  Assignee is expected to upload one or more files to the submittal envelope. 
c. Sign:  Assignee is expected to apply a digital signature. 
d. Concur:  Assignee is expected to verify viewing the submittal but may not need to take any 

action on the document itself. 
e. Distribute:  Assignee is expected to distribute links to the envelope. 
f. Custom:  Option to provide customized task guidance. 

 

 
 

During In Review, Contractors are restricted from viewing or modifying the submittal documents. 

11.3.10.1 Saved Reviewer Groups 
Any submittal owner can create saved reviewer groups to apply to future workflows.  These reviewer groups 
are saved per user account and can be applied across projects by the individual submittal owner. 
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1. After establishing a review order, press the Create Reviewer Group button to save the review 
workflow. 

 

 
 

2. Name the reviewer group and press Submit. 
 

 
 

3. The saved Reviewer Group will be available to apply to any future review workflows. 

 

If the submittal owner deems a submittal incomplete or unacceptable because not all the required documents 
were attached, documents are incomplete, or are in the incorrect format the owner should return the 
submittal to the Contractor as Revise and Resubmit.   
 
Reasons for returning an incomplete submittal before beginning a review session may include, but are not 
limited to:   

• Required digital signatures / contractual obligations are missing. 

• Document Submittal form incorrectly filled out (e.g., incorrect Submittal Type or Item Number is 

selected) 

• Document Submittal Type incorrectly selected, causing the submittal to route to the incorrect 

approving party.  Note:  An individual who incorrectly receives a submittal should respond to the 

Submitter / Contractor promptly with instructions to select the correct Submittal Type when 

resubmitting.  
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It is the submittal owner’s responsibility to explicitly define to the Contractor why the submittal was deemed 
incomplete. The Revise and Resubmit button displays the comment box below.  

 
 
Below is a sample email notification back to the Submitter / Contractor.  Comments typed in the Resubmit 
Comments window will populate in the email notification.  

 

 

Each reviewer is responsible for applying the appropriate stamps and comments in accordance with 
Department Directives and manuals.  It is the submittal owner’s responsibility to resolve all internal 
comments/disputes and prepare the final documents for the Contractor with the appropriate mark-ups and 
stamps.  Any documents added directly into the Bluebeam Studio Session will not save back to COMPASS.  
Pages can be inserted into existing documents, if needed.   
 
Contractors are blocked from accessing submittal documents while they are In Review.   
 

1. Navigate to the submittal through the COMPASS S&T table. 
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2. The Submittal Status Review window will open.  The current reviewer’s name will be highlighted in 

blue in the Submittal Reviewer(s) table.  The eye icon identifies ball-in court. 

 
 

3. Each assigned reviewer performs the review per the business need and presses Complete when done 

to advance the Ball in Court.  To transfer or add a member of the project team to one’s review step, 

follow Reassign or Add to a Review.   

11.4. Bluebeam 

 

All COMPASS S&T envelopes include a Bluebeam Revu plug-in option for PDF files.  Users can press this button 
to trigger a Bluebeam / SharePoint integration.  The user must have Bluebeam Revu on one’s device to use this 
feature.  The feature is available on any supported browser (e.g., Edge, Chrome, etc.)  This integration can be 
used in COMPASS for a single reviewer who prefers not to start a new Bluebeam Studio Session, or for whom a 
Bluebeam Studio Session will not meet the business need. 

• The submittal owner is the sole reviewer and prefers not to start a Bluebeam Studio Session. 

• The submittal owner needs to scrub / modify review comments applied during a Bluebeam Studio 

Session. 

• A digital signature is required (not feasible in Bluebeam Studio Sessions per Bluebeam). 

The checking out process should not be attempted while a Bluebeam Studio Session is open. 
 
To initiate the Bluebeam / SharePoint integration from a COMPASS S&T envelope: 

1. Press the Bluebeam Revu icon associated with the PDF document to check out. 

 
 

2. Press Open if a SharePoint / Bluebeam request window appears. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/How-to-Transfer-or-Add-to-a-Review.aspx
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3. Once the file is open in Revu, click the lock symbol to checkout and edit the document. 
 

 
 
 
For more details on the Bluebeam / SharePoint integration, and instructions on how to use the integration 
outside of COMPASS S&T envelopes, please see Signing and Editing PDFs in Office 365 (sharepoint.com). 
 
After checking a document back into COMPASS, previous versions of the document are automatically 
preserved by COMPASS’s Version History feature. 
 
Once the review is complete, the submittal owner needs to take final action to communicate with the 

Contractor.  If no further is action required by the Contractor, the submittal owner should press Complete in 

COMPASS to end the submittal workflow and a notification email will be sent automatically.  If further action is 

required, the submittal Owner should press Revise and Resubmit. 

 

Bluebeam Studio Sessions allow multiple individuals to participate in a collaborative review of submittal 
documents. 
 
To start or finalize a Bluebeam Studio Session in COMPASS, a Bluebeam Prime license is required.  A Bluebeam 
Prime license is not required to participate in the review; only to start or finalize the Bluebeam Studio Session.  
To acquire an account for new DOT staff or consultant staff, create a ticket with the COMPASS Support Desk.   
 
It is the submittal owner’s responsibility to start and finalize the Bluebeam Studio Session and establish the 
review.   
 
When the Start Bluebeam Session button is clicked, all PDF documents in the submittal envelope will 
automatically be put into a single Bluebeam Studio Session.  There is no need to check boxes to choose 
individual documents.  The document links will convert to route directly to the Bluebeam Studio Session.   
 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Signing-in-Office-365.aspx
https://ctdotcompass.atlassian.net/servicedesk/customer/portals
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Note:  If a PDF document is a PDF/A, or has other restricted security settings restricting editing, it will not be 
included in the Bluebeam Studio Session.  In the Bluebeam status column of the document grid, it will display 
as “Not Eligible (Locked).”  If the Start Bluebeam Session button is pressed, a message will display noting the 
security restriction. 

 
 
For information only:  When a Bluebeam Studio Session is started in COMPASS, the PDF documents are 
automatically checked out of the document library in the name of the user who started the Bluebeam Studio 
Session.  These checkouts are automatically discarded when the Bluebeam Studio Session is finalized.  Users 
should not take any action on this automated check-in/check-out process.   

 

The submittal owner is responsible for finalizing the Bluebeam Studio Session at the appropriate time in the 
review workflow.  When a Bluebeam Studio Session is finalized, the new document version is automatically 
saved in COMPASS, with the author displaying as app@sharepoint.  Previous versions are preserved through 
the COMPASS Version History feature.   
 
If extra documents are added directly to the Bluebeam Studio Session, but were not in the original submittal 
envelope, those documents will not save back to COMPASS.    
 
When the submittal owner determines that a Bluebeam Studio Session is complete, the owner should push the 
Finalize Bluebeam Session button in COMPASS.  IMPORTANT:  Users should not finalize the Bluebeam Studio 
Session directly within Bluebeam.   
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During a Bluebeam Studio Session, comments may be added to the submittal documents that are confidential 
to CTDOT personnel or consultants and not appropriate to send to the Contractor.  There are two means by 
which the submittal owner can reconcile Bluebeam Studio Session comments. 
 

• Option A:  Use the Checking Out Documents to Bluebeam technique to reconcile comments and scrub 
the document as needed before it is returned to the Contractor.   
 

• Option B:  Modify other users’ comments within the Bluebeam Studio Session, using Bluebeam’s 
guidance:  How to deny a Session participant and reassign markup ownership. 
 

For Option B, if the email address of the attendee(s) whose comments that need to be modified is not showing 
on the Attendees tab (see Bluebeam instructions, step 1), press the green plus sign to add those email 
address(es) to the list (example below), then proceed with the instructions provided in the above link from 
Bluebeam. 
 

 
 
Once all the review for a submittal is complete, the submittal owner needs to take final action to communicate 
with the Contractor.  If no further action is required by the Contractor, the submittal owner should press 
Complete in COMPASS to end the submittal workflow; a notification email will be sent to the Contractor 
automatically.   
 
If further action is required on the submittal documents, the submittal owner should press Revise and 
Resubmit and provide comments to the Contractor.   
 
These two processes cannot proceed if any Bluebeam Studio Sessions are still open.  In such a case, COMPASS 
will block the process and provide a notification message: “There are x documents in a Bluebeam Studio 
Session still open.  Please finalize and close the open Bluebeam Studio Session before proceeding with this 
action.”     

11.4.4.1 Commenting 
IMPORTANT - All comments and stamps must be digital and must be applied directly onto the submittal 
documents. Prior to commenting you must import the CTDOT Bluebeam Profile, see Appendix A. Once 
completed you are ready to comment. The user shall also ensure that standard Department settings are made. 
Consultant stamps can be found in Appendix D. 
 

https://support.bluebeam.com/articles/revu-deny-and-transfer-markup-ownership/#:~:text=Denying%20a%20user%20and%20transferring%20their%20markups%201,select%20Deny%201%20User%20.%20...%20More%20items
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Reviewers may print the digital review documents to paper and mark them up, however, when done, all paper 
markups must be transferred from paper to the digital documents.  See Reviewing.  If a unit cannot print their 
own paper copies, they should contact MaryAnn Cass by emailing Jackie.Rivera@ct.gov. In the email include 
the project number and attached documents that need to be printed and include the address of where they 
are to be mailed.  
 
All comments associated with a review must be applied to the digital documents, such as telephone or email 
comments. 
 
The goal is to provide clarity and to eliminate confusion.  Be sure to use engineering judgment to determine 
the most appropriate location for placing comments in a document.  
 
General comments may be placed on the first sheet of the document using the note markup tool in Bluebeam. 
This process is detailed in Reviewing. 
 
If a reviewer refuses to participate in the digital review, please contact AEC Applications.  

11.4.4.2 Best Practice – Applying Comments 
There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, cloud, 
rectangle, etc.).  
 
Text/notes can be attached to each type. Text tools already have a note attached; all you need to do is start 
typing. 
 
Non-text tools also have a note attached to them, but you need to double click on it to launch the attached 
note box. The text note box must be closed after the comment is made by clicking on the X in the top right 
corner of the note. The example below shows a note being attached to the cloud tool the correct way:  

 

11.4.4.3 Review Stamps 
Review stamps are used for intra-Department (including Department consultant Designers) coordination. They 
are applied by the reviewer to communicate information to the submittal Owner and the Department. 
 
An example of use is that each Department Designer(s) must apply a review stamp when requested by a 
Construction District to review Working Drawings.   
 
Review stamps have the following meanings: 
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• Reviewed, No Comments means the Department’s Designer has reviewed the submittal and takes no 
exception.   

• Reviewed with Comments means the Department’s Designer has reviewed the submittal and has 
provided comments. When used on Working Drawings the reviewer shall provide a Bluebeam note 
that identifies the reviewer’s recommended disposition, i.e., Exceptions as Noted, Revise and Resubmit 
or Reject.  

11.4.4.4 Action Stamps 
The Department uses action stamps (and if appropriate, comments) to notify the Contractor of the 
Department’s disposition. 
 
Action stamps must be placed on each sheet of all working drawing, shop drawing and Product Data 
submittals. They shall also be placed on the cover of any other supporting, multi-page PDF documents such as 
computations.    
 
The precise meanings of action stamps are defined by the contact control of work specifications.  The following 
are paraphrased definitions: 

 
 

• No Exceptions Noted means the Department’s reviewer has not observed anything in the submittal 
different from what is called for by the Contract requirements and the Contractor may proceed, 
provided that any manufacturer’s warranty called for by the Contract can be fulfilled. 
 

• Exceptions as Noted means the considerations or changes noted by the Department’s reviewer are 
required and, after reviewing required changes, the Contractor notifies the Department’s reviewer if 
the changes violate a Contract provision or lessen any warranties. The Contractor may proceed with 
the work covered in in the submittal. 
 

• Revise and Resubmit means the Department’s reviewer has identified and noted statements or 
features that appear different from what the Contract requires. The Contractor is required to revise 
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the submittal(s), based on the reviewer’s comments, and resubmit for another review. The 
Department may take such additional time (typically 20 days) to review resubmissions. 

 

• Rejected means the Department’s reviewer has identified and noted one or more statements or 
features that are different from what the Contract requires. The Contractor is required to revise the 
submittal, based on the reviewer’s comments, and resubmit for another review. The Department may 
take such additional time (typically 20 days) to review resubmissions. 

11.4.4.5 Applying Review Stamps 

Submittal Review Stamp 
1. For CTDOT employees the submittal review stamp is in the tool chest in Bluebeam and should be 

placed on an open area of the drawing.  For Consultants Appendix D must be followed before their 

stamp is in the tool chest.   

2. To place the stamp, left click on the stamp in the tool chest and then place it.  All shop drawing sheets 

must be stamped with the action stamp.  Product data sheets only need to have the first sheet 

stamped. 

 

3. Next select the appropriate option from the java script window and click OK.   



Connecticut Department of Transportation – Digital Project Development Manual

151 
 

 
 

4. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as 

shown below: 

 
The stamp is now resized as shown below: 
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5. After the review is completed, close the file, and click yes to save. 

 
 

6. Repeat the review process for each drawing/document in the submittal. 
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7. Close Bluebeam when complete.  If the document is in a Bluebeam Studio Session, the stamps will save 

automatically.  If the document is being modified by using the check-out to SharePoint feature, ensure 

the document is properly checked back into COMPASS. 

Designer’s Review Stamp 
The designer shall place a Designer’s Review stamp on the working drawing submittal.  The action stamp will 

be placed by District Construction.   

1. To place the Reviewed stamp, left click on the stamp in the tool chest and then place it.  All working 

drawing plan sheets shall be stamped with the reviewed stamp.  Calculations and supporting 

documents only need to have the first sheet stamped with the reviewed stamp. 

 

 
2. Then select the appropriate option. 
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3. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as 

shown below: 

The stamp is now resized as shown below: 

 
 

4. Close Bluebeam when complete.  If the document is in a Bluebeam Studio Session, the stamps will save 

automatically.  If the document is being modified by using the check-out to SharePoint feature, ensure 

the document is properly checked back into COMPASS. 

District Construction Review  
After the designer has reviewed the working drawing submittal, District Construction should do the following: 

1. Review the designer’s comments and update the comments on the drawings/documents as necessary.  
District has the final say on what comments the Contractor should be able to see.  

2. Stamp each working drawing sheet with the action stamp; stamp the first page of any calculations or 
supporting documents with the action stamp. 

3. Prepare the documents to provide CTDOT’s response back to the Contractor.     
4. Open the file from COMPASS. 
5. To place the action stamp, left click on the stamp in the tool chest and then place it.  Each plan sheet in 

a working drawing submittal shall be stamped.  For calculations and supporting documents in a 

working drawing submittal, only the first sheet of those files needs to be stamped.  
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6. Next select the appropriate option from the java script window and click OK.   

 

7. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging a corner as 

shown below: 
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The stamp is now resized as shown below: 

 
 

8. Close Bluebeam when complete.  If the document is in a Bluebeam Studio Session, the stamps will save 

automatically.  If the document is being modified by using the check-out to SharePoint feature, ensure 

the document is properly checked back into COMPASS. 

9. Repeat the review process for each document in the submittal. 
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11.4.4.6 Completing the Review – Advancing the Submittal 
Once the review is complete there are two options available to move forward.  
 

• Further action is required by the Contractor – Revise and Resubmit 
o One or more pages of the submittal documents have received a Revise and Resubmit Action 

Stamp or Rejected Action Stamp.  
o During this process, the submittal owner may provide supplemental comments in the 

comment pop-up window, but the comprehensive comments should always be on the 
submittal documents.   

o Once the reviewers have all completed the review and it has been identified that further 
action is required by the Contractor, the submittal owner must click the Revise and Resubmit 
button. This will change the review status displayed in the S&T table from In Review to Revise 
and Resubmit. 

 

• No further action is required by the Contractor – Complete  
o All Action Stamps are either No Exceptions, or Exceptions as Noted 
o Once the reviewers have all completed the review and it has been identified that no further 

action is required by the Contractor, the submittal owner shall click the Complete button. This 
will change the review status from, In Review to Complete. 

11.5. Revise and Resubmit 
If a submittal enters the “Revise and Resubmit” review status, the Contractor will be notified via email and the 
BIC displayed in the S&T table will update accordingly. This is the phase where the Contractor makes all the 
necessary adjustments, replaces the file(s), and resubmits to the Department. 
 
Guidance for the Contractors is available in the COMPASS-Contractors-User-Manual.pdf. 
 
The Contractor is responsible for reviewing all comments and addressing as needed. For documents that 
require changes, the Contractor shall resubmit the document(s) in COMPASS by replacing the existing 
document with a new conformed document. COMPASS has automated Version History, so when the 
Contractor replaces the document COMPASS automatically creates a new version.  
 
Conformed files shall include all unchanged sheets that received No Exceptions as Noted or Exceptions as 
Noted Action Stamps, and any revised sheets that need to be reviewed. 
 
See Revising and Replacing a File for details. 

11.6. Complete 
A submittal enters the Complete phase when the submittal owner clicks the Complete button.  The Complete 
review status indicates that all documents have been processed and that no further action is necessary.  A 
submittal should not be completed if the Action Stamps Revise and Resubmit or Rejected are used.  
 
The Department’s disposition shall be clearly marked by Action Stamps placed on each sheet of all working 
drawing, shop drawing and product data submittals. It shall also be placed on the cover of any other 
supporting multipage PDF documents, such as computations.   
  
The Contractor is responsible for opening and reviewing the final submittal documents to determine the 
Department’s disposition.  The Department’s disposition is not shown as a status in the Submittal / Transmittal 

https://portal.ct.gov/-/media/DOT/documents/AEC/COMPASS-Contractors-User-Manual.pdf?la=en
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tool; it shall be communicated using action stamps in accordance with this manual and current business 
processes.   
 
Contractor submittal documents – except for Payrolls – automatically relocate from the Internal Documents 
→ 120_Contractor_Submittals (PDF) folder to the Contract Documents → 125_Completed Submittals folder. 
 

 

11.7. Draft 
The submittal owner, reviewers and Contractor have the option to save their work as a draft without 
advancing the workflow.  In the Process Assignment and Document Submittal windows, if the Save button is 
selected the user’s work will be saved as a draft.  In the Submittals/Transmittals table, the Review Status will 
show as Draft.  The Ball-In-Court will remain with the user who selected save.  
 

 

11.8. Send Back to Owner 
An assigned reviewer may opt to press the Send Back to Owner button in the following circumstances: 
 

• Individual believes they are incorrectly assigned to the review. 

• Individual is requesting changes to the review, such as adding additional reviewers, changing due 
dates, starting a Bluebeam Studio Session, etc. 

 
Subject to business needs, in lieu of using the Send Back to Owner function, an assigned reviewer may choose 
to transfer or add a member of the project team to one’s review step by following Reassign or Add to a 
Review.   
 
A comment should be included explaining the reason for sending back the submittal.  Any individual who 
believes a submittal to have been incorrectly assigned is responsible for sending back the document 
immediately to avoid any delays to the processing period. 
 
If an assigned reviewer presses the Send Back to Owner button, the submittal owner will become Ball in Court 
and receive an email notification containing the comments.  The submittal owner is responsible for revising the 
review workflow, then pressing Start to resume the review process. 

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/How-to-Transfer-or-Add-to-a-Review.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/How-to-Transfer-or-Add-to-a-Review.aspx
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11.9. Adding Attachments to a Submittal  
When using COMPASS, submittal Owners and Reviewers may choose to respond to the Submitter / Contractor 
with a letter or memo.  Such a response can be transmitted via COMPASS using Bluebeam Revu’s Attachment 
Tool. 
 
To attach a file inside of a COMPASS document: 

1. Open the submittal document from COMPASS using a Bluebeam Studio Session or by Checking Out 

Documents to Bluebeam. 

2. Once the document is opened in Bluebeam Revu, go to Tools → File Attachment. 

3. An Open Dialog box appears. 

 
4. Browse to and select the desired file to send to the Contractor.  Then click Open.  Note:  Attachments 

are made individually, so only one file can be selected at a time.  If multiple files need to be attached to 

a submittal document, then a separate attachment can be created for each file. 

5. Click on the submittal PDF to place the Attachment icon, a paper clip.  Attachment icons can be moved 

after they have been placed.  Click and drag the icon to move it.  The name of the attachment file is 

revealed when hovered over with a mouse. 

 
6. When finished inserting attachment(s), finalize the Bluebeam Studio Session or check-in the PDF per 

the applicable instructions for Using Bluebeam to Review Submittals. 

7. If no further action is required by the Contractor, press Complete.  If the Contractor has further action 

or correspondence, press Revise and Resubmit.  The Contractor will be able to view and download the 
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original submittal with the response attachment.  This response attachment will also automatically 

save in the Internal Documents version-controlled folder in COMPASS.  Note:  If using the Attachment 

Tool, the submittal Owner should include a note to the Contractor in the Comments box, notifying 

the recipient that an attachment containing additional information is embedded in the document. 

If the review has identified a document(s) that the Contractor must revise and resubmit, the Submittal Owner 
shall respond to the Contractor in COMPASS by clicking the Revise and Resubmit button located on the 
Submittal status review dialog box. COMPASS will automatically notify the Contactor that reviewed documents 
are ready for consumption and that some portion of the original submittal needs to be amended and replaced.  
 
If no portion of the Submittal needs to be revised and resubmitted then the Submittal Owner may click the 
Complete Button, this will automatically notify the Contractor.   

11.10. Reopen Complete Submittal / Transmittal Envelope 
See Reopen Complete Submittal / Transmittal Envelope. 

11.11. Delete a Submittal 
Members of the project site owners permission group can delete a submittal.  When this function is exercised, 
all elements of the submittal are deleted, including: 

• Line item in the S&T table 

• Back-up document(s) in the Internal Documents folder 

• Comments and comment log 

Submittals can be deleted when they are in the following workflow stages: 

• Process Assignment 

• In Review 

• Send Back 

Submittals cannot be deleted if they are the Revise and Resubmit or Complete workflow status.   
To delete a submittal: 

1. Select the submittal from the S&T table. 

2. If the submittal is in Process Assignment or Send Back status, select the Delete Submittal button 

located in the lower left-hand corner of the page.  If the submittal is In Review, select Edit to see the 

Delete Submittal option.  

 
 

3. A Delete Submittal confirmation window will appear.  Select Delete to confirm the deletion.  Select 

Cancel to abort the process.  Once the Delete button is selected all documents and data for the 

submittal will be permanently deleted.  This process cannot be undone once the Delete button is 

selected. 
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11.12. Revising and Replacing a File 
When a submittal is returned to the Contractor as Revise and Resubmit, the Contractor is responsible for 
opening the document, reviewing all email comments and mark-ups, and responding according to COMPASS-
Contractors-User-Manual.pdf. 

 

To open a file, navigate to the appropriate submittal from the Submittals / Transmittals table. Select the 
hyperlink in either the Submittal or Review Status column.  The Review Status will be listed as Revise and 
Resubmit; the Ball-In-Court will list the Contractor’s name. 
 

 
 
When the hyperlink is selected, the Document Submittal window will appear.  This window will appear like the 
original window used to create a New Submittal.  The two key differences are that the submittal document(s) 
will appear and there will be a red Replace File button to the right of each document listed.  To view the 
submittal document(s), select the file name.   

 

https://portal.ct.gov/-/media/DOT/documents/AEC/COMPASS-Contractors-User-Manual.pdf?la=en
https://portal.ct.gov/-/media/DOT/documents/AEC/COMPASS-Contractors-User-Manual.pdf?la=en
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Once the comments provided via email and/or in the document mark-ups are reviewed, the Contractor is 
responsible for revising the submittal document(s).  The Contractor should not revise any portion of any 
documents that have been accepted by the Department. 

 

If the submittal owner returns a shop or working drawing submittal with different dispositions stamped on 
each sheet, the Contractor shall revise individual sheets as needed.  Consistent with current business 
processes, the Contractor shall only make modifications to sheets stamped Revise and Resubmit or Rejected; 
the Contractor shall not make any modifications to sheets that have been accepted by the Department.  When 
the replacement document is ready to submit, the Contractor shall combine the approved sheets and 
replacement sheets in the appropriate order in one file.   

 

When the replacement document is prepared, the Contractor who created the initial submittal should 
complete the following steps.   
 

1. Navigate to the appropriate submittal page and click the Replace file button.  This is the red button 

located to the right of the file name.  Note:  The Contractor should not respond to a Revise and 

Resubmit by attaching a new document in the Attach File(s) window:   
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2. A Replace Document window will appear.  Select the correct document to upload, then press the 

Submit button.  The replacement document does not have to match the original file name; it can have 

any name necessary based on the Contractor’s naming conventions (e.g., Rev. 1, etc.).  The file name 

in COMPASS remains the same, regardless of the name of the replacement file. 

 
 

3. If more than one file in the submittal is to be replaced, press Replace File under each document and 

repeat the process described above.  Ensure that the correct replacement file is uploaded to replace 

the corresponding original document in COMPASS.  

 
4. Press Submit to complete the R&R process.  COMPASS automatically saves the replacement file in the 

original document’s Version History.  The Ball in Court will return to the submittal Owner.   

 

11.13. Comments 
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The COMPASS Document Submittal / Transmittal Application contains two mechanisms for providing 
comments.   

 

The Comments/Log is accessible to project site owners and project site members per project.  The 
Comments/Log is a combination of system auto-generated submittal data and user entered information.   
 

 
 

 

11.13.1.1 Mention A User in the Comments/Log 
To mention (tag) a member of the project team in the Comments/Log, type @ and begin to key in the letters of 
the user’s name.  Multiple users can be mentioned in one entry.  Once the message is complete, press the Post 
button.  The recipient(s) will receive a COMPASS-generated email notification, instructing them to view the 
Comments/Log for the given submittal.   
 
Only use this feature for users who can view the Comments/Log – project site owner and project site 
members.  This feature is not accessible for site contractors, site stakeholders, or users without permissions to 
the project site. 
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Optional comment windows pop-up when the Ball-In-Court is returning to the Submitter / Contractor or when 
the Send Back button is pushed.  The Owner or Reviewer completing a given process can use the comment 
field to communicate with the recipient.  Once the comment is typed in the pop-up, press Submit to log it.  
These comments will populate in the email notification sent to the recipient and be saved in the Comment Log 
to maintain a record of project communication.  Users can also be mentioned in the comment pop-up boxes, 
which will create the same entry and email notification as described in Mention A User in the Comments/Log. 
 

 

11.14. Document Storage 
There are four SharePoint libraries attached to each project in COMPASS:  Design, Contract Documents, 
Internal Documents and Confidential Documents.  See Project Folder Structure and Required Documents for 
Capital Projects for more details.  To access a document library, navigate to the Project Dashboard, Details or 
Submittals/Transmittals page of the selected project.   
 

 
 

By default, all Contractor submittals are saved to the Internal Documents library, in the folder named 
120_Contractor_Submittals (PDF).  Once a contractor submittal is marked complete, it automatically relocates 
to the Contract Documents → 125_Completed_Submittals folder (except for Payrolls). 
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See COMPASS Permissions Model (sharepoint.com) for design library and folder permissions. 
 
Additional resources:   

• Share SharePoint files or folders (microsoft.com)   

• See who a file is shared with in OneDrive or SharePoint (microsoft.com) 

 

COMPASS includes automated Version History.  Every version of each individual document is automatically 
saved in COMPASS.  This includes the original document as submitted, versions saved from Bluebeam Studio 
Sessions, versions saved from checking out to SharePoint and replacement files submitted in response to a 
Revise and Resubmit. 
 
Version history can be accessed in two ways. 
 

1. In the submittal envelope, select the green version history icon: 
 

 
 

2. Navigate to the appropriate folder.  Before a submittal is marked complete, the documents are stored 
in the Internal Documents → 120_Contractor_Submittals (PDF) folder.  Once marked complete, 
contractor submittals – except for Payrolls – can be found in the Contract Documents → 
125_Completed_Submittals folder. 

a. Navigate to the document. 
b. Click the ellipses (three dots) to show the drop-down menu associated with the preferred 

document, then click Version history.   

https://ctgovexec.sharepoint.com/teams/AEC/SitePages/COMPASS-Permissions-Model.aspx?OR=Teams-HL&CT=1637931272661
https://support.microsoft.com/en-us/office/share-sharepoint-files-or-folders-1fe37332-0f9a-4719-970e-d2578da4941c
https://support.microsoft.com/en-us/office/see-who-a-file-is-shared-with-in-onedrive-or-sharepoint-51bb79a9-b696-410d-a7a7-c320e541272d


Connecticut Department of Transportation – Digital Project Development Manual

167 
 

 
 

c. The document version history shows in a new window.  All versions of the document are listed 

with their associated version number, date, and author.  Click on any version’s hyperlink to 

view the version.  When a file has been saved back from a finalized Bluebeam Studio Session, it 

presents as Modified By app@sharepoint.com. 

11.15. S&T File and Document Grid Management 
Please see S&T File Management - Rename and Move Files and S&T Document Grid Management for details. 

 

  

mailto:app@sharepoint.com
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/S%26T-File-Management---Rename-and-Move-Files.aspx
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/S%26T-Document-Grid-Management.aspx
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12. Digital Review and Commenting  

12.1. Introduction 
A digital review is when a document is reviewed in its native digital format or as a digital copy of the original 
paper document.  Any required markups are placed directly on the document using a computer with software 
designed for managing digital reviews.  The documents can also be printed from the review session and the 
paper copy marked up; however, those markups must get transferred back to the digital copy.  See Submitting 
Documents to CTDOT for details on how to perform a digital review in COMPASS. 
 
Advantages of a Digital Review Compared to Conventional Paper Review 

1. Higher Transparency – Increased Collaboration. 
2. Digital markups are searchable and sortable, by comment, author, etc. 
3. Real time collaboration review process improves turnaround time and quality of the review. 
4. Real time feedback allows easier handling of large amounts of data. 
5. Reduces the time required to compile and resolve comments.  
6. Eliminates document mailing time.  
7. Reduces document printing. 
8. Eliminates shipping cost. 
9. Easily store a permanent digital record on the cloud. 
10. Overall reduction in review time. 

 
Types of Reviews: 
This manual may be used as a guide to perform a digital document review on any digital document. Below is a 
list of examples of the types of documents that may be reviewed: 

• Preliminary Design Plans 

• Structure Type Studies 

• Semi-Final Plans 

• Final Plans for Review 

• Special provisions 

• Engineering Reports 
 

Review Process: 
To help participants of a digital review more easily track the digital review process it has been split up into six 
Phases as listed below: 

• Phase 1 – Preparation of the Digital Documents  

• Phase 2 – Set Up Digital Review 

• Phase 3 – Invite Attendees to Review 

• Phase 4 – Digital Review 

• Phase 5 – Ending the Digital Review 

• Phase 6 – Resolve Comments 
Each phase and its required steps will be discussed later in detail. 
 
Digital Comments: 
In this review process, all comments must be applied to the documents in the review session.   
 
All comments associated with a design submission should be applied to the digital documents.  Telephone of 
email comments must be applied to the correct digital document by the staff member who received them.  Be 
sure to use engineering judgment to determine the most appropriate location for the comments in the 
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document.  General project comments can be placed on the first sheet of the document using the note markup 
tool in Bluebeam. If any outside entities (railroads or utilities) will not participate in the digital review, their 
comments with your responses should be attached to the final record copy. It is not necessary to transpose 
these comments individually as all comments can be attached at one time.    

12.2. Prerequisites 

All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to 
organizing or joining a review session.  Completing these steps will standardize the Bluebeam format across all 
CTDOT digital reviews.     

12.3. Phase 1 – Digital Document Preparation 

 

Below are the guidelines by which the review documents should be organized: 

Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Plans - Must be in discipline subsets.  The review Organizer is responsible for assigning each Author a 
subset number. 

2. Special provisions – Each discipline shall combine all their special provisions into one (1) PDF 
document.  Each discipline’s special provisions will remain separate throughout the review session; 
they will not be combined with the other discipline’s special provisions.      

3. Other Documents – Shall be individual PDF documents. 
 

Other Reviews 

1. The only requirement for the organization of other types of reviews is that the documents must be in 
PDF format.   

 

Authors shall prepare their digital documents in accordance with the following guidelines: 
Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Plans: 
a. Must be in PDF format. 
b. Plans must be in discipline subsets. 
c. Plans must be sized 34” x 22” 
d. Do not need watermarks, sheet numbers or to be digitally signed. 

2. Special provisions: 
a. Each discipline shall combine all their special provisions for review into one (1) PDF document. 
b. Sized 8.5” x 11” 

3. Other Documents: 
a. Must be in PDF Format 

Other Reviews 

1. Documents: 
a. Must be in PDF Format 

12.4. Phase 2 – Set Up Digital Review 
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Please see PS&E Milestone Reviews in COMPASS for information on how to set up a digital review in 
COMPASS.   

12.5. Phase 3 – Invite Attendees to Review 
Please see PS&E Milestone Reviews in COMPASS for information on how to invite attendees to the digital 
review in COMPASS.   

12.6. Phase 4 – Digital Review 

 

Below is the typical layout in the review session.  On the right tab, there are the tool chest for commenting, the 
attendees of the session, and the documents in the session.  On the bottom, there are the list of comments.   

 
 
All comments that are made get saved instantly to the Bluebeam review session; these do not need to be 
manually saved.  Each user can only delete their own comments and can leave and rejoin as many times as 
they want if the review session has not been closed.  The review session will be closed by the Organizer in 
accordance with the date on the review memo.  

 

All CTDOT digital review participants are required to complete the steps provided in Appendix A prior to 
organizing or joining a review session. 
 
This section shows the procedures for reviewing and commenting on documents in a digital review. 
 
In the case of preliminary contract plan reviews, the original digital documents, with comments, will become 
the final record.   
 
All comments associated with a design submission should be applied to the digital documents, including any 
email or phone call comments.  These types of comments must be applied, by the staff member who received 
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the email or phone call, to the correct digital document, use engineering judgment to determine the most 
appropriate location.   
 
General Project wide comments can be placed on the first sheet of the document using the note markup tool 
in Bluebeam as shown below:  Using the note tool you can copy and paste text from any source such as an 
email or a Word document.  This allows larger project wide comments to be applied to the plans.    

 
 
Note about Commenting in a Review Session and Supervisor Approvals  
In most cases, the unit that reviews a document has an internal approval process whereby the supervisor 
finalizes the comments from staff members.  The workflow described in this Chapter does not specify or 
dictate an approval process within each unit; rather, it outlines the review procedures once the review 
comments have been compiled from each unit.    Therefore, it is important that only the reviewing unit’s final 
comments be added to the review session.  Once the session ends, the comments made in a review session 
will be considered final.    
 
The following shows a few options for a supervisor approval procedure, but the digital review process is 
flexible for any procedure a reviewing unit develops.  The only restriction is the final comments must be placed 
on the digital documents located in the review session before the review session ends:   
 

1. A lower-level employee can join the session and comment on the documents in the review session.  
Then the supervisor can join the session and filter out their subordinates’ comments for their review.  
If there is an issue with a comment the supervisor will have to direct the lower-level employee to fix 
that comment. If there are not any issues with the lower-level employee’s comments, then nothing 
must be fixed.  After the supervisor review, a lower-level employee will join the session and fix the 
applicable comments.   
 

2. A lower-level employee can join the review session and save a copy of the review documents to their 
computer.  Then they can markup the documents offline and have their supervisor approve those 
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comments.  After the supervisor approves the comments, those comments can then be imported into 
the documents in the review session.  
 

3. A lower-level employee can join the session and print the documents in that review session.  Then they 
can markup the prints and have their supervisor approve the comments.  After the approval, a lower-
level employee can transfer the comments to the digital documents in the review session.  In section 
10.1 of this manual there is a list of advantages to this digital review process.  With this option, 
advantages 3 and 4 are eliminated due to the comments made offline.     

 
Notes about Outside Entities that will not Participate in a Digital Review 
If an outside entity such as a railroad or utility company will not participate in a digital review it is still 
important to add their comments to the final record document in COMPASS.  It is encouraged to have these 
entities participate in the digital review and AEC Applications is available to provide support and technical 
assistance in these efforts.   
 
The following details how the comments from a non-participating entity and your responses to those 
comments shall be attached to the final record document in COMPASS: 

1. Create a PDF document that includes the non-participating outside entity’s comments and your 
responses to those comments.   

2. Then add the pages from that document to the end of the final record document in COMPASS. 
 
MUST READ BEFORE PLACING COMMENTS 
The following shows best practice for applying text notes in a review session.       
 
There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, cloud, 
rectangle, etc.).  Each type can have a note attached to them.  The text tools already have a note when you 
type text, but the non-text tools can also have a note attached to them.  To attach a text note to a non-text 
tool, place the comment and then double click on that markup.  Then you can type in your note.  The text note 
box must be closed after the comment is made by clicking on the X in the top right corner of the note.  The 
example below shows a note being attached to the cloud tool the correct way:   

 
General Project wide comments can be placed on the first sheet of the document using the note markup tool 
located in the tool chest. Text can be copied and pasted into the note tool as necessary.  

1. Create a review comment report of your comments.  First filter out the comments so only your 
comments are displayed as shown below: 
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2. Now that the comments are filtered by your name create a comment report as shown below: 

 
Next type in a title for the comment report that includes Project No, what review it is plus the word 
“Comments”, and what document this comment report is for.  See below for an example: 
 

Project ####-#### Semi Final Review Comments 03-Highways 
 

Make sure all the settings are set as shown below and click OK: 
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3. The comment report will now be created and opened in Bluebeam, leave the comment report open in 
Bluebeam.  We will be copying this report into the comment report memo. 

4. Next save the following review comment memo to your computer: Review Comment Memo. 
5. Open the memo and fill in the correct information. 
6. Then copy all the pages from the comment report as shown below: 

https://portal.ct.gov/-/media/DOT/documents/AEC/review_comment_memo.pdf
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7. Then paste the pages into the memo as shown below: 

 

8. Save the memo and process this memo as your unit requires. 

12.7. Phase 5 – Ending the Digital Review 
Please see PS&E Milestone Reviews in COMPASS for information on how to end the digital review in COMPASS.  

12.8. Phase 6 – Resolve Comments 
All comments on the review documents shall be resolved by the Document Author directly on the digital PDF 
review documents using Bluebeam.  The following shows the steps for resolving comments. 
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1. Open your document(s) from COMPASS.   
2. Next select a comment in the comment list and right click.  The select Reply.   

 

3. In the box that pops up, type in a final resolution in the following format: 

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.   

Resolution – Type in resolution...No Change to Plans 
 
The resolutions applied to the plans shall be the final resolution decided by the Document Author’s unit.  There 
shall only be one resolution for each comment.   
 
Below is an example of a resolution: 
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Below is an example of how the resolutions will look in the comment list. 

 

 
4. Next attach a PDF document that includes any non-participating entities comments with your 

responses to the review document.  This should be done by adding that PDF document to the end of 
the review document as shown below: 
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5. Browse out to the PDF document you want to add and then select to insert after the last page:

 
 

6. When all the resolutions have been applied, make sure to save the documents and check them back 
into COMPASS.  

7. Notify the Review Organizer that you have completed your resolutions by clicking the gray complete 
button next to your name in COMPASS. 

8. Send out Completion of Review Memo to all the personnel associated with the review session 
indicating that the review session is over, and all comments have been resolved on the documents in 
COMPASS.  Link to: Completion of Design Review Memo 

  

https://portal.ct.gov/-/media/DOT/documents/AEC/completion_of_design_review_memo.pdf


Connecticut Department of Transportation – Digital Project Development Manual

179 
 

13. COMPASS Project Schedule  

An Engineering working group evaluated several scheduling software options to support the mission 
statement. Microsoft Project was selected because it offers the following features and advantages: 

• Accommodates any number of milestones and tasks (i.e., easily scalable), 

• Graphically displays series and parallel tasks, 

• Provides baseline and tracking Gantt charts, 

• Displays the critical path, 

• Ability to link notes and documents, and 

• Interfaces with Outlook, Excel, SharePoint, and other Microsoft products. 
 

Microsoft Project shall be used to develop design phase schedules meeting the following minimum 
requirements: 

1. Includes all the activities identified by the Minimum Requirement Schedule Template; more 
detailed templates and project-specific schedules are encouraged,   

2. Baseline schedule,   
3. Task Indicator columns are used to link applicable instructional and reference documents, 
4. Explanations for changes in task durations are added as task notes,  
5. Tracking View/Gantt chart functions are used, 
6. Task-level progress is tracked regularly,  
7. Files are stored in COMPASS as indicated by the Digital Project Development Manual, and 

8. Microsoft Project files are maintained and current, with projected schedules in accord with the 

obligation plan. 

Base templates were developed by a committee that included Engineering Management and Subject Matter 
Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs are as follows: 

• Bridge Design – Kevin Blasi and David Gruttadauria 

• Consultant Bridge Design – Derick Lessard and Marc Byrnes 

• Highway Design – Scott Bushee, Jordan Pike, and Vitalij Staroverov 

• Consultant Design State Roads – Nilesh Patel and Meredith Andrews 

• Traffic Projects Design – Barry Schilling and Michael Chachakis  

• Traffic Studies & Safety – Erika Lindeberg, Daniel Veronesi and Colin Baummer 

• Facilities Design – Eric Feldblum and Jesse Benson 
 
The SMEs are responsible for developing and maintaining division specific project templates and 
corresponding task libraries in Office 365. They shall be the first point of contact regarding discipline specific 
template and guidance document inquiries and maintenance.  
 
For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling Directive, please 
contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov ) or John Dudzinski (John.Dudzinski@ct.gov) 
 
The table below details the minimum tasks included in the template: 

Task Name  

Project XXXX-XXXX  

Project Initiation  

• Prepare and Submit PPI  

• Prepare and Approve RPM   

• Secure Funding/Authorization   

mailto:Bruce.Bourgoin@ct.gov
mailto:John.Dudzinski@ct.gov
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Preliminary Design  

• Survey   

• NEPA/CEPA  

• Develop PD through Design Approval  

• Design Approval  

Final Design  

• Prepare Semi-Final Design Submission  

• Prepare Final Design Submission  

ROW Coordination  

• Prepare and Submit Final Accepted Property Maps  

• Acquire Properties  

Permit Acquisition Process  

• Permit A  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

• Permit B  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

• Permit C  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

FDP  

DCD  

ADV 

13.1. Getting Started 
All Microsoft Project schedules are now stored in Project Online, or Project Web App (PWA), which is referred 
to as COMPASS (DOT PWA).  

 

COMPASS users may access the Microsoft Project Summary Report for insight into any MS Project schedule, 
Gantt charts and critical path. No license is required to view this report. 
 
Project Managers and any individuals who will be actively maintaining an MS Project schedule must have a 
Microsoft Project license. 
 
To check if you have a license, check My Account Subscriptions for Project Plan 3 for GCC. 
 
To request a Project Plan 3 for GCC license: 

Contact the CTDOT HelpDesk at DOT.Helpdesk@ct.gov. 
 
To request access to COMPASS (DOT PWA): 

Create a ticket with COMPASS Support | Microsoft Project. 

 

The following steps show how to set-up a Microsoft Project file: 
1. Navigate to the Project Schedule Resources folder on the Engineering Administrator SharePoint site. 

https://ctgovexec.sharepoint.com/sites/DOTPWA
https://ctgovexec.sharepoint.com/teams/AEC/SitePages/Microsoft-Project-Summary-Report.aspx
https://portal.office.com/account/?ref=MeControl#subscriptions
mailto:DOT.Helpdesk@ct.gov
https://ctgovexec.sharepoint.com/sites/DOTPWA
https://ctdotcompass.atlassian.net/servicedesk/customer/portal/1/group/21/create/73
https://ctgovexec.sharepoint.com/:f:/r/sites/DOTEngineeringAdministrator/Shared%20Documents/Project%20Schedule%20Resources?csf=1&web=1&e=3gzZTf
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2. Select the applicable Scheduling Documents folder.  The minimum requirement schedule template is 

stored in the AEC Scheduling Documents (Minimum Req) folder. 

 
3. Locate the desired schedule, save the file locally and prepare MS Project schedule. 

4. Next open the project file. 
5. Set the project start date by selecting the File menu > select Info, then select the date as shown below: 

 

 
 

 

 

To interact directly with schedules stored in COMPASS (DOT PWA) via the MS Project Professional Desktop 
Application, set-up the configuration as follows: 

https://ctgovexec.sharepoint.com/:f:/r/sites/DOTEngineeringAdministrator/Shared%20Documents/Project%20Schedule%20Resources/AEC%20Scheduling%20Documents%20(Minimum%20Req)?csf=1&web=1&e=lmmt3o
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1. Open the Microsoft Project Professional desktop application. 

2. Click the File menu at the top of the screen (open your project if you don’t see File menu). 

3. Press Info > Manage Accounts > Configure Accounts 

 
 

4. Click Add. 

5. In the Account Properties window, enter the information provided below, then click OK. 

Account Name: COMPASS 

Project Server URL: https://ctgovexec.sharepoint.com/sites/DOTPWA 

Check the box: Set as default account. 

https://ctgovexec.sharepoint.com/sites/DOTPWA
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When a new MS Project schedule is ready to be added to COMPASS (DOT PWA) follow the following 
steps: 

1. File > Save As > COMPASS. (If missing refer to Section 13.1.3: Connect to COMPASS on page 181.) 
2. Save > Name the project schedule as the full 8-digit project number with hyphen exactly. The name 

is how COMPASS and other systems reference the data from the schedule. 
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3. If applicable map the existing red custom calendars to their corresponding enterprise custom 
calendars in the cloud.  

 

 

1. Once Saved, publish the schedule by File > Info > Publish. 
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Once the schedule is published with the correct name it will be automatically linked to the project’s COMPASS 
pages. 

13.2. How to Access 
This section will describe how to open and edit your COMPASS (DOT PWA) Project Schedules. 

 

Schedules can be opened to view or edit via the MS Project Professional desktop application: 
1. Open the Microsoft Project Professional desktop application. 

2. Select the COMPASS profile; click OK.  

 
 

3. Select Open Other Projects. 

4. Under Project Web App, select COMPASS. 
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5. Click Browse and select the desired project schedule from the list. (Note: If the Project schedule is not 

listed, click “Show me the list of all projects.”) 

 
 

6. Then click Open. 

7. After the edits are completed, Save the file. 

8. Then publish the MS Project file back to COMPASS by clicking on File > Info > Publish. 

 

 

Schedules can be opened via COMPASS. 
1. Navigate to the project’s COMPASS site. 
2. Click on the MS Project Schedule button on the landing page or on the Project details page. 
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This will bring you to the COMPASS (DOT PWA) site. 

3. Navigate to the TASK tab, click the down arrow on the Edit button where you’ll have the option to edit 
In Browser or In Microsoft Project 

13.2.2.1 Desktop Editing 
1. If you select In Microsoft Project. The schedule will then open in the Microsoft Project Professional 

desktop application. 
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13.2.2.2 Browser Editing 
1. If you select In Browser or Edit on the Project Tab. The schedule will be checked out to you for 

incorporating edits as needed. 

 
 

2. Once edits are complete, click the Close button on the Project tab.   

 
 

3. Then click Check it in and press OK. 
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4. Press Close on the Project tab. 

5. On the Task Tab click Publish. This saves and publishes the changes. 

 

 

Users can also manage MS Project schedules directly through the Project Web App (PWA), rather than 
navigating through specific project site. This can be particularly useful for users who are maintaining schedules 
for multiple projects. 
To open an MS Project file directly via the COMPASS (DOT PWA) site: 

1. Navigate to https://ctgovexec.sharepoint.com/sites/DOTPWA. 

2. Locate and select the relevant schedule by project number in the Project Name column.   

https://ctgovexec.sharepoint.com/sites/DOTPWA
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3. To view and edit the MS Project schedule, ensure that the “Schedule” tab is selected. 

 

13.3. Basic MS Project Function 
This section presents the following schedule basic terminology and functions:  

• Adding Notes and Hyperlinks 

• Combining Multiple Projects 

 

To edit an MS Project Schedule baseline (0-5), the user must be assigned as the “Owner” of the schedule. AEC 
assigns the correct Project Manager when a schedule is added to COMPASS. The current owner can reassign 
ownership if needed.  If the current schedule owner is unable to perform this task, please create a ticket with 
COMPASS Support | Microsoft Project. 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/1/group/21/create/73
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To reassign ownership of an MS Project schedule in COMPASS, the current owner can: 
1. Open the relevant MS Project schedule as described in Section 13.2: How to Access on page 185. 

2. Enter the Edit Project Details page. 

 
 

3. Next to the Owner field, click Browse.  Select the new schedule owner, then press OK. 

 
 

4. Click close and check-in the MS Project schedule. 
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As stated in the Directive: “Explanations for changes in task durations are added as task notes.” Notes are 
reserved to clearly indicate when a specific Project Task duration is adjusted from the baseline. The note 
should be placed in the respective task’s indicator column. The note should state: 

• The date of the entry, 

• The person writing the note, 

• Justification for the task duration adjustment and 

• Recommended: Recipient Notification. 

The Recipient Notification list is left up to the Project Managers discretion. The purpose is to outline a step 
where project team members who may be interested or are directly impacted by a duration change, are 
notified. Once a note is drafted and the duration is adjusted, it is recommended that a notification email be 
sent to the relevant recipients and that the correspondence is saved to the subject project’s 140_Project 
Administration folder in COMPASS. The recipients may typically include:  

• AEC’s Project Management Unit –Bruce.Bourgoin@ct.gov  or John.Dudzinski@ct.gov  

• Finance, such as the Office of Capital Planning. 

• Design Engineers within the Project Manager’s division.  

• The group involved with the duration change or the group affected by the change, if applicable. For 
example, if the 6-month estimated duration for a project survey needs to be pushed back, the 
respective survey supervisor who is involved with the task should be included as a recipient in the 
notification email.  

The purpose of the recipient list is to improve communication between units and to harvest project data.  
 

mailto:–Bruce.Bourgoin@ct.gov
mailto:John.Dudzinski@ct.gov
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To add a note right click on a task and select Notes… as shown below: 

 
Then type/insert your notes in the popup window.  

The other option to access the notes window is to double click on the task and in the Task Information window 

and click on the Notes tab. 

 

It is critical that project managers can combine project schedules to better manage several schedules from the 
same file. MS Project provides this ability through the Subproject combine function.  
 
The following steps show how to combine Microsoft Project files: 

1. Open a Master schedule from PWA into Project desktop application or create a new blank 
schedule and save and publish to PWA with a name of “Master Schedule_” either an organizational 
unit, responsible party, or relevant specific program, whatever the user feels is most descriptive. 

2. On the Project tab, click Subproject under the Insert group. 
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3. Open the list of all projects and select the one you want.  Configure the other options as you would 

like and click Insert. 
 

 
4. Save and Publish the Master schedule. 

13.4. Tracking the Project 

 

Each project file must have a baseline set at the start of Preliminary Design.  The baseline is essentially a stamp 
of the schedule at the start of the Preliminary Design phase. The purpose of the baseline is to gage how much 
a schedule varies from the initial baseline. Projects shall not be re-baselined unless there is a major scope 
change.  Re-baselining requires Engineering Administrator approval.  
 

1. To set the baseline, under the Project tab select set baseline and select Set Baseline from the 

dropdown as shown below. 

 

2. In the dialog box that pops ups, keep the default values, and click OK. 
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Re-Baselining          
If Re-baselining is needed and is approved by the Engineering Administrator, the baseline will be set in 

accordance with the following: 

1. Go to Projects > Set Baseline > Set Baseline. 

2. Then select Set Interim plan, select Baseline from the copy drop down button, then select 

Baseline 10 for the into dropdown list.  

 

3. Next, go to Project > Set Baseline> set Baseline. 

4. Then in the dialog box that pops up just click OK to save a new Baseline.  
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5. When a pop-up window asks you if you want to overwrite click yes 

 

6. After the project has been re-baselined add a note to the top left Identifier cell located in the 

Project No. row. The note should include the details outlined in the Adding Notes section. The 

recipient list should include all parties affected by the base-line adjustment.  

 

 

The project manager will be required to record the project progress by keeping an up-to-date record of the % 
complete for each task in the project.   This shall be recorded in 25% increments.   
 
The following shows how to record the progress of a task: 

1. Click on a task. 
2. Then in the task menu select the appropriate % complete as shown below: 
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Important Note:  When the task is completed, do not select 100% complete.  You will need to type in the 

actual finish date for that task.  If 100% complete is selected, Microsoft Project will calculate the actual finish 

date instead of recording the physical date the task was completed.  
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14. Electronic Engineering Data (EED) 

14.1. Introduction 

 

The purpose of this section is to provide standards and guidelines for designers to promote consistent, 
uniform, and useable deliverables for use in the construction phase of CTDOT transportation projects. It is not 
the intent of this section to add unnecessary additional responsibilities to the designer, but rather to have the 
projects delivered in a consistent manner following the best practices and industry standards used in the 
today's CAD environment.  
In all cases the EED will be issued as “For Information Only” purposes and the contract plans shall govern.   An 
EED Notice to Contractor will be issued with each contract informing the potential users of this information as 
such. 

 

CTDOT is standardizing on producing model-centric designs.  This allows for increased productivity and 
adherence to FHWA’s Every Day Counts (EDC) Innovations and Building Information Modeling for 
Infrastructure (BIMFi).  BIMFi integrates technologies and practices that use a data-centric approach to 
improve lifecycle delivery and management of highway assets.  BIMFi centers on the idea that data is an asset 
and efficiencies can be gained with this data is accessible throughout the project life cycle.   
 
Having the EED available during the construction phase of the projects allows for the following: 

• Mobile Field Inspection and Data Collection 

• AMG (Automated Machine Guidance) 

• GPS Construction Layout 

• eConstruction 

• GIS and Asset Management 

The “I“ in BIMFi is one of the most important aspects of the technology.  Bentley CONNECT Edition products 
allow designers to produce a product that retains the business data (the “I” in BIMFi) by assigning Item 
Types placed on CAD Graphics. This data can be consumed further downstream during Design Reviews then to 
Construction, Asset Management and Maintenance.  

EED refers to the Computer Aided Design (CAD) files that were used to create the pdf contract plans. 

These files include:  

• 2D geospatially located CAD Design Models 

• 3D geospatially located CAD Design Models 

o Corridor Models 

o Bridge Models 

o Site Models 

o Coordinate Geometry Models 

o Terrain Models 

o Storm Drainage Models (Structure and Pipe layout) 

The department is in the piloting stage of including asset and pay item information tagged on CAD graphics, 
including, but not limited to, signal equipment, signs, guiderail, drainage, and Illumination.  While this is not 
mandated as of now, it is direction the department will be moving to in the future. 
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In conjunction with an emerging project delivery method or technology initiative, the Department may provide 
bidders and contractors with CAD files of the Base Technical Concepts in conjunction with alternative 
contracting methods (e.g., Design-Build, Construction Manager/General Contractor, and Construction Manager 
at Risk). 

 

All 2D and 3D geospatially located graphical information placed using CAD (MicroStation based applications 
such as OpenRoads Designer and OpenBridge Modeler) will require a EED Submittal. 

 

The table below defines the Electronic Engineering Data (EED) file delivery requirements for different types of 
projects.  Note: Only DGN files needs to be submitted to the Department.  

2D Projects - No Earth Work 3D Projects – Includes Earth Work 
Structures/Bridges Structures/Bridges 

   Deck/Superstructure Replacement    Bridge Replacement W/Realignment of Approaches 

   Restoration/Rehabilitation    Retaining Walls/Slope Stabilization 

   Substructure/Superstructure Repairs Roadway 
Roadside Safety Improvements     Intersection Realignment 

   Concrete Barrier    Intersection Improvement 

   Guiderail    Realignment 

Traffic    Widening  

   Paint & Epoxy Pavement Markings     New Interchange 

   Signal Installation/System Improvement    Operational Lane 

   Signing Miscellaneous 

Miscellaneous    Drainage – Major 
   Drainage – Minor    Grade Crossing - Major  

   Grade Crossing - Minor     Bicycle/Pedestrian Facility (Multiuse Trails) 

   Landscaping Site Work 

   Illumination    Wetland Replacement/Restoration 

   Noise Barriers    Hazardous Waste Removal 
   Intelligent Trans Systems    Facility Construction 

EED Project Deliverables EED Project Deliverables 
EED Delivery Manifest R EED Delivery Manifest R 

Master Model DGN File R Master Model DGN File R 

Existing Ground DGN File(s) D 
Existing Ground DGN File(s) - containing TOPO and 
Terrain Models 

R 

Proposed Design DGN File(s) – containing 2D Models R 
Proposed Design DGN File(s) – containing 2D and/or 
3D Models 

R 

Proposed Coordinate Geometry DGN File(s) D Proposed Coordinate Geometry DGN File(s) G 

    Proposed Roadway Corridor DGN File(s)  G 

    Proposed Terrain DGN File(s) G 

    Proposed 3D Storm Drainage DGN File(s) G 

R = Required            D = Discretionary (required if used during design)   G= Recommended, but not required.   
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14.2. DGN File Quality Control Requirements 
CTDOT uses Bentley software products for all their computer aided design needs, with Bentley Software (.dgn 
format) being the foundation to all computer modeling. Therefore, it is critical that Bentley Software EED files 
be submitted to the CTDOT and conforms to the criteria outlined in this section.  In many instances dgn files 
will contain multiple design models both 2D and 3D, and in some situations, they will only have one model. 
A Quality Control Checklist Sheet in included with the EED File Manifest, the items listed on this sheet shall be 
check for consistency. 
All Design Models 

• must be compatible with CTDOT’s current CTDOT Digital Design Environment (DDE). 

• must have graphical elements placed in real world modified state plane coordinates and be 
geospatially correct. 

• must be free of all cross sections, profiles, construction lines for design purposes. 

• must be free of annotation that should reside in the cut sheets. 

• must have clean reference attachments, only needed reference files & no redundant references. 

• are Design Models only (no Sheet Models or Drawing Models are required) 

• that are 3D have lines and elements at the proper elevation (no spikes). 

 

When producing model-centric designs it is extremely important that model types be used as 
intended.  A Design Model Type will be used for all EED. 

Design Models will: 

• be geospatial 

• contain cells, shapes, and lines that represent the physical design elements 
 

Design Models will not have: 

• border cells 

• call outs and notes 

• tables 
 
The two other types of models will be used in downstream contract plan production processes and are not 
required to be submitted as part of the EED.  

• Drawing Model — Contains annotations, dimensions, and callouts. 

• Sheet Model — Contains a Border Cell, Sheet Boundary (plotting shape) and may also 
have annotations, dimensions, and callouts. 

 

This information identifies the geographic position and characteristics of natural or proposed constructed 
elements, features and boundaries and how they are positioned related to the earth’s surface. 

14.3. DGN File Details 

 

The Master Model DGN file will have all the project’s design and survey dgn files referenced in.   
Reference files may include but are not limited to: 

• Corridor Models 

• Bridge Models 

• Site Models 

https://portal.ct.gov/-/media/DOT/documents/AEC/EED/EEDFileManifest.xlsx
https://portal.ct.gov/DOT/Engineering-Applications/CTDOT---CONNECT-DDE
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• Coordinate Geometry Models 

• Existing Terrain Models 

• Proposed Terrain Models 

• Survey TOPO 

• Storm Drainage Models (Structure and Pipe Data) 

• Illumination Models 

• Traffic Models 

• Landscape Models 

 

Roadway elements include any roadway features designed in CAD software as 2D geometry, 3D geometry, or a 
combination of both. These roadway model elements are created using the CTDOT’s CAD workspace 
configuration. Items considered 2D geometry include 2D cells, alignments, lines, and polygons. Items 
considered 3D geometry include profiles, 3D break lines and surfaces created from corridor template designs, 
and 3D cells and line styles. 

3D Models 
OpenRoads Corridor Modeling tools are used to create design surfaces that represent a new roadway 
or other types of surfaces.  The 3D model is then used to create cross sections, terrain models and 
generate corridor quantities.  A corridor is created first in 2D by assigning a horizontal and vertical 
alignment to the corridor and then assigning a template to the corridor at a defined interval along the 
horizontal alignment. Once the template is assigned to the corridor a 3D model is created. 
A template represents the transverse geometry or typical section along the corridor. Templates are 
made up of points and components and are stored in a template library. When a corridor is processed 
the template points create 3D linear features (edge of pavement, shoulder, curb, sidewalk, cut/fill lines 
etc.) along the corridor and the template components create the 3D material meshes (i.e. pavement, 
shoulder, curbing, sidewalk, side slope grading etc.) along the corridor. 
3D Models can also be produces using the Apply Linear Template and Surface Template Tools. 
The information in table below provides general standards for roadway corridor modeling for final 
design deliverables.  

Situation Minimum Modeling Requirement 

Corridors Template drops: 10 feet 

Horizontal 
and Vertical 
Curves 

Stroking tolerances (feet):  
Linear stroking = 10  
Profile stroking = 0.07  
Curve stroking = 0.07  
Note: Template drops might occur too frequently depending on radii 
values. These tolerances may be modified at the discretion of the 
Engineer. 

Critical 
Locations 

Apply template drops to corridor region start/end, superelevation 
transitions, horizontal and vertical cardinal points, start/end of pavement 
tapers, start/end of side slope transitions, both sides of pedestrian 
accesses, and any additional key stations needed at the discretion of the 
Engineer.  

Intersections Apply template drops along curb returns between 2 and 5 feet, and where 
proposed pavement ties into existing conditions. 
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2D Models 
All 2D features that are to be quantified shall be included in this file (i.e. guiderail, fences, etc.).  
Including but not limited to the graphical elements (areas, lines and cells) listed below: 

• Patterned Riprap Channel Areas 

• Patterned Riprap Slopes Areas 

• Patterned Pavement Removal Areas 

• Patterned Milling Areas 

• Erosion control Matting for Channels Areas 

• Erosion control Matting for Slopes Areas 

• Processed Aggregate Areas  

• Pavement for Railing Areas 

• Sodding Areas 

• Turf Establishment Areas 

• Driveway Areas 

• Cut limit  

• Fill limit  

• Fences 

• Front face of landscape wall 

• Precast Concrete Barrier Curb 

• Sedimentation Control 

• Cut Pavement 

• Parking lot  

• Guiderail - The smart line is to be offset from EOR so it can be graphically seen (Connecticut 

Standard Details for placement will supersede plan placement).   

 

An OpenRoads Survey DGN files contains several models that each contain different types of information: 

• Existing Digital Terrain 

• Existing Ground TOPO 

• Existing Annotation 

There may be several existing survey files/models depending on the length of the project and the number of 
project site locations.   

Existing Ground TOPO Models 
All elements representing existing topography features shall be drawn according to the current CTDOT 
Survey standards.  All fieldbook data shall be brought in using OpenRoads Survey. Other needed CAD 
graphics will be placed using the CTDOT Workflow on the CTDOT Survey Ribbon.  This will ensure that 
all CAD graphics have the correct attributes (color, weight, line style, level).  These Bentley Software 
file(s) may contain both 3D and 2D elements of the existing survey.   2D elements included but are not 
limited to ROW lines and control lines.   3D element includes tangible elements such as edges of 
pavement, shoulders, curbs, gutters, sidewalks and retaining walls.   

Older V8i Files 
Projects originally processed using InRoads V8i SS2 will utilize the OpenRoads Terrain Import tools.  A 
DGN file with a 3D model will house the imported terrain data. 



Connecticut Department of Transportation – Digital Project Development Manual

203 
 

The separate TOPO dgn Ground files originally processed using InRoads V8i SS2 can be used as is. 

 

What is a Terrain Model? 
A Terrain Model is a set of three-dimensional triangles mathematically computed from point data collected on 
the surface being modeled. Terrains are used to define highly irregular surfaces, particularly the surface of the 
earth, but can be generated for proposed surfaces.  
Project model deliverables shall include both proposed and existing Terrains. Terrains are used to produce 
contours, display the existing ground lines in profile and cross sections, and in the calculation of cut and fill 
quantities.    

Proposed Terrain Models 
Proposed Terrain Models will need to be created and submitted for any surfaces used to generate the 
final contract plans.  The goal is to provide a top surface(s) for the entire project and at minimum the 
surfaces should include the roadway surface Curb to Curb.   These projects will also be the type which 
in most situations require the inclusion of Item 9.80 Construction Staking.  Proposed Digital Terrain 
Models represent the project design as generated by CAD using the horizontal alignments, vertical 
alignments, templates, roadway definitions and surfaced editing tools.  
A top surface for each corridor will need to be created representing at minimum the proposed finished 
grade curb to curb as a goal of the design data deliverables.  All proposed surfaces shall be defined by 
a breakline density interval (frequency of cutting templates) of no more than five feet, and at every 
event location.  In tightly constrained or critical drainage areas, or on the outside of sharp horizontal 
curves, the break line interval may need to be reduced to two feet or less.   
Areas within the project limits that do not have a top surface Terrain should be indicated on the EED 
Delivery Manifest.  Complex areas that were not modeled in 3D should also be indicated on the EED 
Delivery Manifest. This includes but not limited to Sidewalk Ramps and Driveways in which grading 
information can be found on Miscellaneous Details Sheets. 
Terrain Models and 3D Meshes shall: 

• have no irregular dips, spikes or voids.    

• triangles do not cross obvious breaklines such as centerlines, edges of pavement, edges of 
shoulders, etc. 

• have no vertical faces present 

• no overlaps of breaklines or visual inconsistencies of features. 

Existing Digital Terrain Models 
Existing Digital Terrain Models represent existing ground conditions at the time that surveying data 
was collected. This original ground Terrain represents the undisturbed ground surface prior to 
construction.  All new projects will use OpenRoads Survey to create existing terrain models.  

 

These files will contain models that include geometric line work such as Centerlines and proposed right of way 
lines.  This file will also include right of way dimensions and centerline annotation.   
Only final coordinate geometry alignments should be contained in these files, preliminary and alternate 
information has been removed.  The coordinate geometry alignment names and descriptions should be 
intuitive. 
The files shall: 

• include all Horizontal Alignments for all roadway centerlines/baselines 

• include all Vertical Alignments for all roadway centerlines/baselines 
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• include all Special Alignments used for drainage purposes, skewed driveways, or stage construction 

• include only final alignments (do not include preliminary or alternates information). 

• have intuitive alignments names and descriptions. 

 

Dgn files created using OpenRoads Drainage and Utilities will contain both a 2D and a 3D Model.  The 3D 
Model will automatically get populated as the Drainage Structures are placed in the 2D Model.  All 3D solids 
should be placed at the proper elevations. 
Modeling Criteria for Drainage Pipes and/or Pipe Underdrains 

• 2D Model – 2D line 

• 3D Model – 3D solid 

Modeling Criteria for Drainage Pipe End Sections 

• 2D Model – 2D Cell  

• 3D Model – 3D solid  

Modeling Criteria for Concrete Drainage Structures 

• 2D Model – 2D Cell  

• 3D Model – 3D solid 

 

The lead structural designer shall submit either 2D models and/or a 3D models of the proposed structure(s).  If 
OpenBridge was used to model a Structure in 3D to create the contract plans the 3D model will need to be 
submitted. 
Models should include the following: 

• Structure centerlines of bearings 

• Structure centerlines of girders 

• Elements shall be placed using CTDOT’s customized Bentley Software tools.  

• Components modeled using OpenBridge shall be Feature Model Elements.  

• All elements shall be geospatially correct. 

• All elements shall be placed at 1:1 scale. 

 

All Traffic models created to house the proposed signal equipment, signing and pavement markings shall be 
provided.  These models are primarily 2D and shall include all items that are to be quantified. 

 

These models could be but not limited to staging plans and or other disciplines not listed above.  These models 
are primarily 2D and shall include all items that are to be quantified. 

14.4. Submission Procedures 

 

All required EED documents shall be delivered: 

• At FDP 

• At award of Contract if files were modified by addenda 
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• After design-initiated change orders if files were modified. 

 

The EED delivery manifest & Quality Control Checklist must be delivered to the CTDOT with every EED 
submittal. A blank copy can be found by clicking on the following link: EED File Manifest.  This form will include 
general project information; the datum used for the ground survey; file names and specific information about 
each EED file being submitted.  The contact information for the lead designer and lead surveyor must also be 
provided. The lead will all also provide a link to the EED Delivery Manifest, and each unit will add their files to 
the list. A Quality Control Checklist Sheet in included, the items listed on this sheet shall be check for 
consistency. 

 

The lead discipline will create a Zip file and copy in the DGN files.  The lead can copy in the other discipline files 
or give them the link to have them copy in the files themselves.  The lead will all also provide a link to the EED 
Delivery Manifest, and each unit will add their files to the list. The Zip File will then be uploaded the proper 
Project COMPASS Site.  
…Internal Documents\240_Contract_Development\  

 

The Notice to Contractor (EED Notice to Contractor) must be filled out by the lead designer with the correct 

project number in the last line of the notice.  This NTC informs the Office of Construction and the contractors 

that the EED will be available, along with the contract plans, at advertisement.  The NTC also states that all EED 

files are for information only.  This will be submitted along with the specifications at FDP. 

 

AEC Applications (Mobile Inspection Leads) will convert Bentley Software CAD files (dgn) as required.  These 
conversions are necessary to be utilized in the GPS field equipment and automated machine guidance/control 
equipment.   It will be AECs responsibility to zip all files, both native and converted, and upload to the 
100_Contract_Plans (PDF) folder in COMPASS.  Contracts will be notified so that the EED zip file can be posted 
along with the contract plans, specifications, and estimates on the State’s contracting portal at advertisement. 
The converted data is being provided by CTDOT to ensure that inspectors and contractors are utilizing the 
same set of data. 

 

Changes to the EED that require edits to the CAD models shall be submitted along with the revised contract 
plans.  A new zip file will be created containing the renamed updated files and uploaded to COMPASS.  AEC will 
then be notified that the amended files are complete. 
  

https://portal.ct.gov/-/media/DOT/documents/AEC/EED/EEDFileManifest.xlsx
http://www.ct.gov/dot/lib/dot/documents/dcontractdev/ownedspecs/english/0.055_ntc_eed_electronic_engineering_data.doc
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15. Project Location  

A Project Polygon (geo-spatial boundary) shall be submitted to COMPASS at project milestones of DCD (Design 
Completion Date) and Construction Completion by the Lead Designer (or delegate).  The DCD submission will 
replace a cursory project polygon created at project development by the project sponsor.  The Construction 
Completion submission is required if the DCD polygon does not reflect the project’s completed limits.  The 
inspector shall obtain the DCD polygon and modify the limits to represent as-built conditions if required at 
construction completion.  
 
The Project Polygons will be used in the Department’s Project Web-GIS feature layer to identify spatial 
location, each section of State and Local Roads contained within the boundary for FHWA FMIS reporting, and 
BIM (Building Information Management) of roadway assets.  The Project Polygon will also aid in the ROW 
(Right of Way) boundary mapping process.   

15.1. Project Polygon Requirements 
Capital Projects that include Location Survey 
Note:  If a project has multiple sites, a project polygon KML file shall be created for each site.   
Project Polygon Milestone Deliveries: 
 

• DCD (Design Completion Date): 

 

o The Project Polygon shall include the entire project extents per site and include all existing and 

new project developed ROW boundaries and portions of local affected roads.  The polygon 

shall be drawn up to and following the ROW lines, then it shall cross the roads at the project 

limits.  The following figure shows a Design Approval Polygon.  Note:  The Polygon does not 

include slope limits. When Rights and/or Defined Easements extend beyond the ROW, these 

lines shall be followed.  The polygon shall cross the roads at the project limits.  

 
 

• Construction Completion: 

o The Lead Designer shall modify the limits to represent as-built conditions if required at 

construction completion.  This will be performed in ATLAS 2.0 by editing the existing work area 

polygon or replacing it with an updated KML. 
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Project Polygons will be drawn in a CAD file then exported as a KML format. The CAD Workflow is available in 
the CTDOT DIGITAL DESIGN ENVIRONMENT GUIDE - Creating a Project Polygon. 
 
KMLs shall be uploaded to ATLAS 2.0 by the Project Manager to reflect updated geometry. See Upload Shape 
for more information on uploading KMLs as geometry in ATLAS 2.0. 
  

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-016---Appendix/Section-4---Design-Submissions#PROJECT%20POLYGONS
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16. CT Asset Tracking & Location System (ATLAS) 

Proposed projects and Capital Projects shall be spatially located in CTDOT databases. The CT Asset Tracking 
and Location System (ATLAS) is the Department’s project location tool. ATLAS scans the located Project Work 
Area(s) to provide Project Managers and liaisons a comprehensive set of authoritative data that has been 
governed through the Department’s Enterprise Geospatial Information (EGIS) and Transportation Enterprise 
Data (TED) groups. 
 
This project location and scanning process, allows integration and then access to the Department’s project 
management tool COMPASS (Office 365 SharePoint). 
 
ATLAS Support Link – Use this link for any support or questions associated with ATLAS - ATLAS Support 

16.1. Authentication and Permissions 
ATLAS is an internal CTDOT application and is only accessible to CTDOT employees. Users must have 
credentials for the TED Portal to enable access to the application. 

 

Users who will be creating and managing projects will need specific permissions for full access. Complete the 
following to ensure editing permissions: 

1. Request TED Portal credentials using this link - ATLAS Permissions  
a. User must be CTDOT Employee 
b. Mark Yes – I’m creating projects for ATLAS for Question 5 to join in a creator role. 
c. If unsure about credentials, use this link to check current status. 

2. Request membership permissions in the ESRI “ATLAS” group. 
a. Use this link to access Application Request Form. 
b. Select “ATLAS 2.0” under the Application field. 

 
Users must have a creator role and be a member of the ESRI ATLAS group to create and manage projects. 
However, any user who is successfully authenticated can use ATLAS to view projects and investigations.   

 

Complete the following to access ATLAS: 
1. Open the web browser and navigate to the ATLAS homepage. 
2. The user is prompted upon opening the webpage to enter TED Portal Credentials. Enter the credentials 

and click the button to authenticate against ArcGIS portal using single sign-on. 
3. See ATLAS Web Help for more details. 

16.2. Launching the Project Wizard 
The ATLAS application is used to create new projects/proposed projects and manage existing 
projects/proposed projects. ATLAS is made up of two panels: the Project Wizard to the left and the Map 
window to the right. Within the Map are several useful widgets, including Search, Layer List, Measure, and 
Bookmarks. For more details on using these Map widgets, see the Web Map section of ATLAS Web Help. 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/9/group/25/create/102
https://ctgovexec.sharepoint.com/sites/DOTTEDEnterpriseData
https://forms.office.com/Pages/ResponsePage.aspx?id=-nyLEd2juUiwJjH_abtzi-pXEZiLU2hDgKnfSDZr-txUNllHNlg2Mkw2SUFHRUxVVk1RMUtWSjg1TS4u
https://ctgovexec.sharepoint.com/sites/DOTTEDEnterpriseData/Lists/GIS%20Credential%20List/AllItems.aspx?viewid=4d3bf0fc-43f9-4077-843f-d9a656b34328
https://ctdotcompass.atlassian.net/servicedesk/customer/portal/9/group/25/create/111
https://ctatlas.dot.ct.gov/atlas/
https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/topics/idh-topic10.htm
https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/index.htm?t=1686010828615
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The Project Wizard is the interface for building Project Work Areas, scanning assets and informational layers, 
and creating the COMPASS site. Proposed Projects and Projects are created and managed using the Project 
Wizard. Complete the following to launch the Project Wizard: 

1. Open a web browser and navigate to ATLAS. Sign in when prompted. 
2. Select an option to open Project Wizard. 

a. To create a new Proposed Project, select Create New Proposed Project. 
b. To manage a proposed or existing project, select Manage Existing Projects and Proposed 

Projects. 
3. If creating a new Proposed Project, Creating a Proposed Project 
4. If managing an existing Project or Proposed Project, Managing an Existing Proposed Project or Project. 

16.3. Creating a Proposed Project 
The Project Wizard has five pages for facilitating work area creation and compiling of related authoritative 
data. After selecting Create New Proposed Project, the user is directed to the first page. 
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The first page of the Project Wizard collects general information about the new Proposed Project. Complete 
the following to finish Page 1. 

1. Enter the Project Nickname (Optional). The project nickname is a convenient way for the user to refer 
to the proposed project. 

2. Select the Project Type. The project type will inform the prefix for the proposed project number (PPN). 
See the table below for more information on PPN. 

a. If one of the Public Transportation project types is selected, the user can choose the specific 
branch or transit district from a list. 

3. The user can add members to the project team by entering their email address in the Team Members 
box and clicking Add. Added Team Members should have ATLAS credentials to edit if necessary (See 
Section 16.1.2). 

4. Click Next when ready. 
  

Proposed Project Number Prefix Meaning Project Type 

PP001- to PP169 Town IDs Transportation (Roads, Bridges, or State Facilities)  

PP170 Statewide Transportation (Roads, Bridges, or State Facilities) 

PP171 to PP174 Construction Districts Transportation (Roads, Bridges, or State Facilities) 

PP300 to PP330 Rail Branches Public Transportation (Rail) 

PP400 to PP478 Transit Districts Public Transportation (Bus) 
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The second page of the Project Wizard is used to define one or more work areas for a project. A project can 
consist of multiple work areas created with the methods outlined below. Additional details for each method 
can be found in the next section. 
 
The table at the bottom of this Section for more detail on choosing creation 
methods. 
 
Administrative Area – Project area will cover the State, or one or more 
Construction Districts. These projects may not have clearly defined work 
areas. Examples include sign and widespread safety projects. This method 
does not allow for asset or information scanning. In some cases, a project 
may initially be assigned an Administrative Area polygon, but then be 
located using Polygon or Route/Milepoint. 
 
Related to Bridge(s) – Work area will consist of one or more bridge 
geometries. Examples include bridge and culvert repair projects. These 
project work area geometries will replicate the Bridge asset feature 
geometries.  The asset feature geometries are a polygon developed from 
each bridge’s deck area. This project location method should be used when 
bridges are undergoing work that will not require survey, staging (MPT) and 
adjacent assets like Pavement. This method is ideal for projects like 
substructure repairs, steel repairs and joint replacements.  When the 
project requires a work area footprint that is different than the deck area, 
use “Draw Polygon” to indicate the work area.  Please request support from AEC if more discussion is required. 
 
Related to Traffic Signal(s) – Work area will consist of one or more signal geometries. These project work area 
geometries will replicate the Signal asset feature geometries. The asset feature geometries are a polygon 
developed from each signal defined control area polygon. This project location method should be used when 
signals are undergoing work that will not require survey, staging (MPT) and adjacent assets like Pavement. This 
method is ideal for projects like traffic signal upgrades, timing, rehabilitation, and preservation. Please request 
support from AEC if more discussion is required. 
 
Draw a Polygon – Work areas will consist of a user-drawn polygon. The polygon may be used as representation 
of the project at its inception phase. When a project reaches Preliminary Design Approval, this inception 
polygon is to be replaced with a KML export from the design team (see ECD-2017-4 and Section 15 of this 
document). 
 
Enter Start and End Points on Route – Work area(s) will consist of buffered area(s) of a selected route segment, 
between two designated mile-points. Example projects include Pavement Preservation and Pavement Marking 
projects. 
  

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/9/group/25/create/102
https://ctdotcompass.atlassian.net/servicedesk/customer/portal/9/group/25/create/102
https://ctdotcompass.atlassian.net/servicedesk/customer/portal/9/group/25/create/102
https://portal.ct.gov/DOT/Engineering-and-Construction-Directives-and-Bulletins/-/media/DOT/documents/AEC/ECD20174pdf.pdf
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Recommended Work Area types by Project Type 

For any project types not listed in this table – contact AEC through help form. 

Administrative 
Area 

Bridge Deck 
Area 

Signal 
Control Area 

Polygon Polygon (cont’d) Route Mile 
Segment Buffered 

Traffic Safety 
Projects 

Bridge 
Restoration/ 
Rehabilitation  

Signal 
Installation 

Bicycle/Pedestrian 
Facility (Multiuse Trails) 

Facility 
Rehabilitation 
(Buildings) 

All Roadside 
Barrier 

Other Bridge 
Substructure/ 
Superstructure 
Repairs 

Signal System 
Improvement 

Bridge Replacement 
w/Realignment of 
approaches 

Grade Crossing- 
Minor 
Improvement 

Fixed Objects 
Modification 

   Drainage – Major Landscaping Intelligent 
Transportation 
System  

   Facility Construction 
(Site Work) 

Transit Noise Barrier  

   Hazardous Waste 
Removal 

Utility Projects Resurfacing by 
Contract  

   Retaining Walls/ Slope 
Stabilization 

Bridge Deck/ 
Superstructure 
Replacement 

Paint and Epoxy 
Pavement 
Markings  

   Wetland Replacement/ 
Restoration 

Illumination Signing 

   Grade Crossing – Major 
Improvement 

Widening – Major 
and Minor 

Traffic Safety 
Projects 

   Intersection 
Improvement – Minor 

Realignment  

   Intersection 
Realignment 

Operational Lane  

   New Interchange Traffic Safety 
Projects 

 

  

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/9/group/25/create/102
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16.3.2.1 Methods for Defining Work Areas 
Select a method from the dropdown list and click Create. The steps for each method are listed below. Each 
header is linked to the web-based ATLAS User Manual for additional details. 
 

 

Administrative Area 
1. Select Administrative Area from the work area list to create a state-wide or district-wide project.  

a. For district-wide projects, one or more districts can be selected for the project. 
2. After selection, click Add Work Area(s).  These administrative areas are so large, Atlas is not 

programmed to scan them for assets contained within the work area. 
3. After creating an Administrative Area project and selecting Next, the Project Wizard will skip Scanning 

and Selecting Assets, and go straight to Step 5. 
 

Related to Bridge(s) or Related to Signal(s) 
1. Select Related to Bridge(s) or Related to Signal(s) from the work area list to create one or more 

project work areas that are related to bridges or signal control areas.  A separate work area polygon 
will be created for each asset chosen. 

2. Select one or more assets from the list by selecting the checkbox. 
3. There are various tools and capabilities in the asset list: 

a. The magnifying glass icon on the left zooms the map into the asset. 
b. Left clicking a column header will sort the list by that column. 
c. Selecting the three-bar Options button in a column header opens the filter tool. The list can be 

filtered by multiple fields. 
d. Selecting the checkbox in the header bar will select or deselect all items in the filtered list. 

4. When all necessary bridges or signals are selected, click Add Work Area(s). 
 

https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/index.htm?t=1687445301711
https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/index.htm?t=1687445301711
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In this screenshot, the Asset list has been sorted by Year Built (NBI 27). Two bridges have been selected for the 
Work Areas. The Zoom button has been used to zoom to Bridge ID 00617. 
 

Draw a Polygon 
1. Select Draw a Polygon from the work area list to use the sketch tools to make a free-hand polygon 

drawing for the project work area. By default, the Draw button and Snap to “ROW Line” layer 
functionality is enabled. 

2. Click on the map when Draw is enabled to begin drawing a polygon. 

a. While drawing, clicking Undo will incrementally revert to the previous states of the polygon. 
Clicking Redo will incrementally redo the states. 

b. When Snap to layer(s) is turned on, your pointer will jump—or snap—to edges, vertices, and 
other geometric elements when your pointer is near them and within a certain tolerance. A list 
of available layers for snapping will appear under the “Snappable layers” header. Each 
snappable layer can be toggled on or off. 

https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/topics/idh-topic240.htm
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3. To complete a polygon, double-click during the draw process. After completing a work area, the Delete 

button will remove the polygon from the map. 
4. Edit the work area name if desired. 
5. If necessary, polygons can be edited after drawing and before selecting Add Work Area. 

a. Click on a completed polygon in the map. It will highlight in bright blue with an orange 
bounding box. 

b. Click the polygon again. The vertices are shaded orange and can now be adjusted. Additionally, 
new vertices can be created by selecting the white points halfway between vertices. 
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6. When the polygon(s) are complete, click Add Work Area.  
 

Enter Start and End Point on Route 
1. Select Enter Start and End Point on Route from the work area list to define a project work area based 

on a starting and ending mile-point on a route. 
2. Zoom to the desired route and click on the route. The route will populate in the application. 
3. Click on a start and end point on the map. 

a. Mileage numbers can also be input directly to the app in the Start point and End point boxes.  
Turning on the route or road mile point layers will help the user’s orientation. 

4. Define a buffer distance for the segment. The default buffer value increases with a lower Functional 
Class value. The value can be manually edited if necessary. 

5. Select from additional options if necessary. 
a. Use entire route will select the entire route rather than a milepoint-defined segment. 
b. Include ramps will include ramps within the selected segment. 
c. Include HOV Lanes will include HOV lanes within the selected segment. 

6. Click Preview to review the buffered segments. Each work area can be given a custom Work area 
name in the text box at the top. 

https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/topics/idh-topic250.htm
https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/index.htm?t=1687445301711
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7. Click Add Segment once the road segment is defined. 
8. When the road segment is acceptable, click Add Work Area to create the project work area. 
9. When adding additional noncontiguous segments, each segment should be in their own Work Area.  

Naming each Work Area with the segment name is recommended. 
 

Upload Shape 
1. Select Upload Shape from the work area list to upload a KML file that will define the project work area. 
2. Click the Select files… button to browse for the KML file on your computer, or drag and drop the file on 

the Drop files control. The KML file will define one project work area, so it must contain only one 
polygon. See Section 15 for more details on creating KMLs. 

https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/topics/idh-topic260.htm
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3. Click Add Work Area to create the project work area. 
4. When all work areas have been added, click Next. 

 

The third page of the Project Wizard is the Scan Assets Page. Work area(s) have been established and a PP 
number is listed at the top. There is also now a Share button at the top right of the Project Wizard. Clicking this 
will create a shareable link to the Project’s ATLAS Page.  User’s receiving this link must have proper credentials 
to edit (See Section 16.1.2). 
 
The Scan Assets Page allows the user to select which work areas should be scanned for assets and information.  
Any work area that has been scanned during a previous session will be unselected by default at the next 
session.  If the user hits Next, the information from the original scan will be queried and reported. A new work 
area that hasn't yet been scanned will be selected by default for a scan. 
 
To scan for assets, complete the following steps. 

1. Under Asset Layers to include in scan, select the assets to include in the scan. By default, all asset and 
informational layers that are in the Atlas base map will be selected for scanning a new work area. 

2. The Identify Scan Settings dropdown can be used to select one of the pre-defined scan settings*, 
which will scan a subset of layers for a particular project type. *This feature is under development. 

a. See the Scan Assets and Information table at the bottom of this Section for more information 
on Scan Settings. 

3. Layers to be scanned can always be checked on or off based on the needs of the project, even if a Scan 
Setting is selected. 

4. Scroll down in the Project Wizard to view all selected Assets and Information. Ensure the desired layers 
are checked and select the Next button to advance.  If you've selected work areas to scan, the scan will 
be performed when you click the Next button and you'll be shown a progress indicator while the scan 
process is running. 

https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/topics/idh-topic40.htm
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a. Clicking Previous will return the user to Step 2, where Work Areas can be added, edited, or 
removed. 

 
  



Connecticut Department of Transportation – Digital Project Development Manual

220 
 

Scan Assets and Information (Templates are Under Construction) 

 Group Asset/Informational Layer 
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CTDEEP Groundwater Quality X     
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Flood Hazard Areas X     

Flood Hazard Areas (No Digital Data) X     

EPA Sole Source Aquifers – SSA X     

CTDEEP Property X     

CTDEEP Natural Diversity Database Area X     

CTDEEP 2011 Protected Open Space View X     

CTDEEP 2011 Protected Open Space Phase 1 X     

CT Coastal Management Boundary X     
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Proposed Project Work Areas – State/District X     

Proposed Project Work Areas – Local X     

Project Work Areas – Local/Active X     

Maintenance Resurfacing Active X     

LOTCIP X     
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 Maintenance Resurfacing Program Historic X     

Legacy Projects (Pre-2011) X     

LOTCIP Projects – Completed X     
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Traffic Monitoring Data – 85% Speed X     

Scenic Roads X     

OSTA – State Highway Speed Limits X     

OSTA – School Zone Speed Limits X     

OSTA – Local Road Speed Limits X     
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The fourth page of the Project Wizard is the Select Assets Page. This page allows the user to choose which of 
the scanned assets will be added to the project. Complete the following steps to select assets for a project. 

1. Choose how to view scanned assets. 
a. By default, all assets are listed under each scanned work area. 
b. Select an Asset Type from the View Assets and GIS Info by dropdown to view assets of a 

selected type for the entire project. 
2. Select Assets to be added to the project and transported to COMPASS by checking their box. 

a. By default, state roads and all scanned assets will be selected for inclusion in the project.   
i. If the project also includes work on local roads, they can be selected here. 

ii. If Work Areas were built with the Enter Start and End Point on Route method, 
project may have routes selected that are not being worked on. Be sure to unselect 
any superfluous routes. Filtering can be used for quick results. 

b. Assets can be zoomed to using the magnifying glass icon. 
c. Fields can be sorted by left-clicking the column header. 
d. Fields can be filtered by hovering over the column header and selecting the options button on 

the right side. 
3. When all required assets are selected, click Next. 

a. Clicking Previous will return the user to Step 3, where Asset and GIS layers can be selected or 
deselected for scanning. 

 
  

https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/index.htm?t=1686661078758&context=60
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The fifth page of the Project Wizard is the Summary Page. This page displays a summary of all the project 
information before providing an option to create a COMPASS site for the project. 

1. Review the page to ensure all information is accurate. 
a. A summary of assets and GIS Info Layers returned from the project scan are displayed below 

the summarization. Assets that were included in the asset Selection step will appear with a 
read-only check box. Clicking on the magnify glass icon next to a record will zoom to it on the 
map. 

b. The View Assets and GIS Info by: dropdown allows the user to see all scanned assets or 
information of a selected type. 

c. When an asset is selected from the dropdown, a CSV of all scanned assets can be downloaded 
using the Download button. 

d. The COMPASS project link is available to navigate to the project site in COMPASS. 
e. Clicking Notify Compass that project PPxxx-xxxx has been created will send a message to the 

COMPASS to create/provision a COMPASS site for the proposed project. 
i. The provisioning of the project site can take up to an hour to complete.  

ii. Any changes to the asset selections in the ATLAS will automate a change to the 
COMPASS. For example, if a project requires adding a bridge, the bridge would be 
added to the project in ATLAS. COMPASS will see this change and update 
automatically. The same goes for removing a bridge—unselect the bridge in ATLAS, 
and it will likewise be removed in COMPASS. 

 
 

2. Clicking Previous returns the user to Step 4, where scanned assets can be selected or deselected for 
inclusion in the project. 

3. Clicking Done saves the Proposed Project in the ATLAS database and registers the selected assets as 
part of the Project.  Note clicking done does not create a COMPASS site.  The user needs to click the 
Notify COMPASS... button shown in the image above.  

 

https://ctatlas.dot.ct.gov/admin/docs/user-manual/WebHelp/topics/idh-topic270.htm
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When the ATLAS Project Creation steps are complete and COMPASS has been notified of the new project, a 
COMPASS project site will be generated. Some initial steps are required for a new Project in COMPASS. See 
Section 3 for full detail. 
 
Complete the following steps to submit a project to COMPASS. Detailed instructions are in Section 3. 

1. Create a ticket with the COMPASS Support Desk (Section 3.1). 
2. Populate the Project Staff on the COMPASS project site (Section 3.1). 
3. Add Work Types and Work Codes to assets (Section 3.2). 
4. Complete the Proposed Project Information (PPI) Form if necessary (Section 3.3). 

a. If the project does not have approved funding from the Financial Obligation Report (OBL), 
complete the PPI Form. 

b. If the project has approved funding from the OBL, a PPI form does not need to be completed. 

16.4. Managing an Existing Proposed Project or Project 
Throughout the lifespan of a project, ATLAS shall be used to manage and update geometry and/or assets. This 
section outlines moments in the project’s lifetime where ATLAS shall be used. 
 
In addition to its use in creating project work areas and completing initial asset scans for Projects and Proposed 
Projects, the Project Wizard also allows the user to update or modify the geo-spatial boundary of a project and 
add or remove assets. Projects or Proposed Projects may have their polygon edited and assets added/removed 
throughout the Project Development Process. For more information on when a project polygon may need to 
be edited or updated, see Section 15. 
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The ATLAS Project Page can be found with the ATLAS 2.0 link on the COMPASS Site or by using the Find Project 
Window options in ATLAS. 
 
From a project’s COMPASS page, navigate to the Assets tab. The ATLAS link can be found at the upper right 
corner of the page. 

 
  



Connecticut Department of Transportation – Digital Project Development Manual

225 
 

Existing projects can be found in ATLAS by selecting the Manage Existing: Projects and Proposed Projects 
option in the Project Wizard. The following outlines the process to access an existing project for management. 

1. Open a web browser and navigate to ATLAS. Sign in when prompted (See Section 16.1.3). 
2. The Project Wizard is located at the left of the page. Under “Manage Existing,” select Projects and 

Proposed Projects. 

 
 
Within the Find Project window, there are four options to find a project for management: 
 
Project Number – This option allows the user to search for a Project in ATLAS by Project Proposed Project 
Number. Complete the steps below to find a project by Project Number. 

1. Enter a full or partial project number (or proposed project number) in the input box. 
2. Click Find Project to display a list of projects matching the entered value. 
3. Select the target project from the list and click Manage Selected. 

 
My Projects – This option will display a full list of the user’s projects and proposed projects. Results can be 
sorted by clicking the header bar for a column. Selecting the three-bar “options” button in the header provides 
the option to filter by a field. Click Manage Selected to continue. 
 
My Teams Projects – This option will display a full list of the user’s projects and projects that have been shared 
within the user’s team. Results can be sorted or filtered using tools in the results table. Click Manage Selected 
to continue. 
 
By Assets – This option allows the user to search for projects that overlap a specified asset. Complete the steps 
below to find a project by Asset ID. 

1. Enter a Bridge or Signal ID number to display a list of projects that include the asset. Click Find 
Projects. 

2. Use the sort or filter tools in the result table to further narrow the results. 
3. Select the target project from the list and click Manage Selected. 
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If a Project or Proposed Project has been cancelled in COMPASS (See Section 3.4), it also must be deleted in 
ATLAS. To delete a project in ATLAS, complete the following steps. 

1. Navigate to the project page in ATLAS (See Section 16.3.1). The Project Wizard will open to Step 1: Edit 
Project. 

2. Click the red Delete Project button. Confirm the selection. 
Deleting a Project in ATLAS does not cancel the project in COMPASS or remove the project site page.  Notify 
the COMPASS team to cancel or delete a project using this form - COMPASS Support. 

 

When creating a project in ATLAS, the Project Manager creates a spatial representation of the project by 
adding Work Areas. The Project Wizard scans these Work Areas for underlying assets that may be associated 
with work in the Project. The Project Manager selects some or all these scanned assets for inclusion in the 
project before adding Work Codes and Work Types in COMPASS (See Section 16.3.4). 
 
There may be moments in the lifespan of the project where project limits change, and/or assets are added or 
removed. The Project Wizard in ATLAS is used to manage geometry and add or remove these assets to ensure 
the Assets tab in COMPASS reflects up-to-date information. 
 
When managing an existing project, complete the following steps to adjust geometry, or add an asset or 
assets. 
 

1. Navigate to the project page in ATLAS (See Section 16.4.1). The Project Wizard will open to Step 1.  
a. The Nickname and Team Members in the Edit Project page can be edited if necessary (See 

Section 16.3.1). This is also the page with the red Delete button (See Section 16.4.2). 
2. Click Next to advance to Step 2 of the Project Wizard (See Section 16.3.2). 

a. If the asset or assets to be added are contained within the existing Project Work Area limits, 
click Next to move to Step 3. 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/1


Connecticut Department of Transportation – Digital Project Development Manual

227 
 

 
 

b. If the asset(s) to be added are not overlapped by the existing Project Work Area limits, create a 
new Work Area, or edit the existing Work Area using the Project Wizard. The desired asset(s) 
to be added must be overlapped by the project limits. 

i. Work areas can be edited by checking the selection box, then clicking Edit. Clicking 

the highlighted polygon will enable the user to add or adjust vertices. When 

complete, click Update Work Area. 

 

ii. If a KML file will be replacing previously drawn geometry for a Work Area, click 

Replace to upload the KML. 

iii. A new work area can be created in the Project Wizard. Selecting Related to Bridge(s) 
or Related to Signal(s) allows the user to add polygons for specific assets. Other 



Connecticut Department of Transportation – Digital Project Development Manual

228 
 

creation methods can also be employed, but the desired assets must overlap the 
final work area. 

1. Refer to Section 16.3.2 for full details on selecting a creation method. 
2. Refer to Section 16.3.2.1 for full details on creation methods. 

 
3. When work areas are satisfactory, click Next to advance to Step 3 of the Project Wizard (See Section 

16.3.3). 
a. In the top box, select work areas which will be scanned for assets. 

i. Newly created work areas are selected by default. Work areas that have been edited 

and updated will need to be selected manually, if a rescan is required. 

b. Select layers to be scanned. Asset layers must be selected to add new assets. Informational 

and GIS layers are optional and depend on the requirements of the project. 

4. Click Next to advance to Step 4 of the Project Wizard (See Section 16.3.4). 
a. By default, state roads and all scanned assets will be selected for inclusion in the project. 

Ensure that the new assets to be added are selected for inclusion. 
5. When assets are selected, click Next to advance to Step 5 of the Project Wizard (See Section 16.3.5). 

a. Review the selected assets from the scan and ensure all necessary assets have been added. 
b. To change selection, click Previous. 
c. If all desired assets are included, click Done. 

6. Completing all five steps of the Project Wizard updates the project in ATLAS and COMPASS. The Project 
Manage must add Work Types and Work Codes for each asset in COMPASS (See Section 3.2). 

 
When managing an existing project, complete the following steps to remove assets. 
 

1. Navigate to the project page in ATLAS (See Section 16.4.1). The Project Wizard will open to Step 1. The 
Nickname and Team Members in the Edit Project page can be edited if necessary (See Section 16.3.1). 

2. Click Next to advance to Step 2 of the Project Wizard (See Section 16.3.2). 
a. If an asset (or assets) will be removed, but the Project Limits will remain unchanged, click Next 

to advance to Step 3. 

 
b. If the work area has changed, it can be edited using the tools in the Project Wizard. 
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i. Work areas can be edited by checking the selection box, then clicking Edit. Clicking 

the highlighted polygon will enable the user to add or adjust vertices. When 

complete, click Update Work Area. 

1. Refer to Section 16.3.2 for more details on editing geometry in ATLAS. 
c. When complete, click Update Work Area. 

3. When work areas are satisfactory, click Next to advance to Step 3 of the Project Wizard (See Section 
16.3.3) 

a. In the top box, select work areas which will be scanned for assets. 
b. Select asset layers to be scanned. 

4. Click Next to advance to Step 4 of the Project Wizard (See Section 16.3.4). 
a. By default, state roads and all scanned assets will be selected for inclusion in the project. 

i. If the Project Limits have changed to no longer overlap a targeted asset, the Project 

Wizard will not scan the asset. 

ii. If the Project Limits have not changed, assets can be unchecked and removed from 
the scan. 

1. By default, assets are displayed by Work Areas. They can be viewed by asset 
type using the dropdown at the top. 

2. Deselect any assets that should not be included in the project. 

 
b. Click Next when all necessary assets are selected, and all extraneous assets have been 

deselected. 
5. In Page 5 of the Project Wizard, the user can review assets selected for inclusion in the project (See 

Section 16.3.5). 
a. Ensure the list of assets included is accurate before clicking Done. 
b. To change selection, click Previous. 

6. After clicking Done, the project will be updated in ATLAS and COMPASS. Assets removed in ATLAS will 
be reflected on the COMPASS site. 
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Appendix A – Initial Bluebeam Settings 

Initial Log into Bluebeam 
These steps only need to be completed the first-time using Bluebeam or when the user logs into a new 
computer. 

1. Log into your Bluebeam account here:  Bluebeam 

2. Change your Display Name to include your first initial, last name, and unit name. 

 
  

3. Open Bluebeam by selecting the desktop icon:            

4. Then Open Bluebeam by double clicking on the shortcut. 

5. Click on REVU in the top left-hand corner and click Preferences as shown below.  If you cannot find the 
settings icon in the top right, go to the Edit menu, and select Preferences.    

https://login.bluebeam.com/prelogin?client_id=066ed4aa-7ef8-462e-8858-4ac2df36c34f&nonce=637994629627369091.YmZjN2Q4MTEtOTczZi00MDA2LThjZjctNjg0MmQwODMxYjk1MGE4ZDQxNmUtMWU4Ny00ZTU4LWIzN2ItZTcwOTgzMjczNzUw&redirect_uri=https%3A%2F%2Faccounts.bluebeam.com%2F&response_mode=form_post&response_type=code+id_token&scope=openid+profile&state=OpenIdConnect.AuthenticationProperties%3D4GaNAnuCCT7iqvGi3x8FRpqHourch3NLqbf4n8k9PeofX9HNpItaRQtP1KbJrkrvak982Nk2ya89Bh8qbpCBaCh_MzgRsrm_Yr8zsTfJV25oi4jzlVKNdk59iGoCwEPxPATQ-2kagxNlCwEeBPXP4ab97uNQCLpFJKR0B1kNYiim4gg8DZr5Ecxp5aAFNMvrAKnMQ1J6mzlK2dB8D1TWArr_7Mg&x-client-SKU=ID_NET461&x-client-ver=5.3.0.0
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6. Set the General options first. 

 
 
7. Next go to the Window option and select WebTab.  Then uncheck the box below. 
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Downloading the CTDOT Bluebeam Profile 
1. Download this file and save it to your desktop: CTDOT Bluebeam Profile 

2. Double click on the profile in the zipped folder on your desktop. 

 

Bluebeam Stamps 
The following steps are for CTDOT Engineering only.  Stamps folders are stored on each discipline’s SharePoint 
sites.   
1. Go to your discipline’s SharePoint Site and make sure you have the Bluebeam folder synced.   
2. Select Markup>Stamp>Change Stamp folder as shown below: 
3. Next browse out to Bluebeam folder that is synced from your discipline’s SharePoint site.  Below is an 

example of the Highway Operations SharePoint site that is synced.   

https://portal.ct.gov/-/media/DOT/documents/AEC/CTDOT-Bluebeam-User_profile.zip?sc_lang=en
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4. Now your unit’s stamps will be available for use when Markup>Stamps is selected: 
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Appendix B – Usability of PDF Documents 

Usability of PDF Documents  
This section contains information about viewing digital contract documents.   

Structure of Digital Plans  
Final Design Plans, Addendums, and Design Initiated Change Orders 
The contract plans are split up into discipline subsets, which are multiple sheet PDF documents digitally signed 
by the Designer.  Addendums and Change Orders are also submitted as discipline subset, with only the 
changed sheets.  For example, an Addendum that affects the 03-Bridge Subset will require the submission of a 
03-Bridge_A1 subset.    
 
Digital Plans are in the 100_Contract_Plans folder in COMPASS.   
 
As-Built’s 
As-built’s will be placed directly on the PDF Subsets using Bluebeam. 

Functionality of PDF Digital Plans 
The PDF digital plans have the following functions when the digital contract plans are created in accordance 
with this manual: 
Turn levels on and off.  
Search for all text on the documents.   
PDF plans are measurable.  

Digital Plan Levels 
The plans can have their levels turned off and on.  This can allow for easier viewing of the contract sheets.   See 
below for turning levels on and off: 
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Searching Digital Plans 
The plans can be searched for any text located on them.  This can be useful if searching for a certain pay item.   
 
See below for searching the PDF Plans for text.   
 

 
 

Measuring on the Digital Plans 
The plans can be measured in PDF.  This is helpful because a paper set does not need to be created for on desk 
measuring.   
 
See below for measuring in PDF. 
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Digital Specification 
The FDP specification package will be one PDF document and located in the 110_Contract_Special provisions 
folder.  This package includes all special provisions, Notice to Contractors, Wage information, etc.   
 
The Addendum special provisions prepared in the same way as the FDP specification package and will also be 
in the 110_Contract Special provisions folder. 
 
The Design Initiated Change Order special provisions will be contained in one PDF document located in the 
110_Contract Special provisions folder when they are released to the Contractor. 
 
Some useful features on the digital specification package are: 

• Search for any text in the document, see Searching Digital Plans 

• Bookmarks for each section in the specification package 
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Document Compare Tools 
Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay Pages.  
Compare Documents will compare two documents and create a third document that clouds all the changes.  
Overlay pages will create a third document where the pages of document A will become one color and the 
pages of document will become another color.  When the pages are overlaid, you will be able to see the 
changes from the difference in these two colors.  Both tools can be used for single and multipage PDF 
documents.  The following shows how to perform a document compare and how to use the overlay page tool. 
 
Document Compare 

1. Open the Revised document first and then open the original document that you want to compare from 
COMPASS.   

2. Next go to Document>Comparison>Compare Documents as shown below: 
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3. In the window that pops up you will notice the two documents that were just opened.  Click OK to run 
the document compare as shown below: 

 
 
Overlay Pages 

1. Open the Revised document first and then open the original document that you want to compare from 
COMPASS.  

2. Next go to Document>Comparison>Overlay pages as shown below: 
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3. In the window that pops up you will need to select which pages of each document you want to 
overlay.  To do this double click on a file, then in the window that pops up type the pages you want to 
overlay.  The example below shows pages 1-28.  Once you select the pages you want to overlay click 
OK. 
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Appendix C – Using the Set File 

See the videos on the Bluebeam website for more information on Set Files in Bluebeam.  
 
Sets | Bluebeam Technical Support 

  

https://support.bluebeam.com/blog/sets/
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Appendix D – Consultant Submittal Review Stamps 

Consultant Designers can import the Bluebeam User Profile using the following link.  This profile imports all the 
commenting tools in the correct format.   
Download the profile from this link: CTDOT Bluebeam User Profile.  Just double click on the file located in the 
zip file and the profile will be imported.   
After the profile is imported the following must be done. 

1. Delete the Submittal Review stamp that is in the tool chest as shown below: 

 
 

2. Next Consultant Designers will need to save the following stamps to their computer and edit it to add 

their company name and address.  The following will show how to do that: 

3. This file contains the Designer’s Review stamp and Action Stamp.  Save these stamp files to your 

computer in a folder somewhere called Bluebeam Stamps.  Note:  The stamp files will be a PDF- 

Consultant Submittal Review Stamp 

4. Open the stamp files using Bluebeam. 

5. Update the Company Name and Address on both the Action stamp and the Designer’s Review stamp 

as shown below: 

https://portal.ct.gov/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
https://portal.ct.gov/-/media/DOT/documents/AEC/ContractorSubmittalReviewStamps.zip
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After the company name and address is updated, it should look like the following: 

 
6. After the stamps have been updated click save.   

7. Next go to Markup>Stamp> and Select Change Stamp Folder.   
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8. Browse out to where the stamps had been saved and click OK: 

 
 

9. Now when you click on Markup>Stamp the stamps will be in the list. 

10. Next go into the tool chest and open the “Recent tools” as shown below: 
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11. Now place the stamps on any PDF document by selecting it in Markup>Stamp as shown below: 

 
 

12. After the stamps have been placed you will see them in the recent tools.  Drag them from the recent 

tools into the CTDOT Shop/Working Drawing Review Tools as shown below: 
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13. Then Save Profile so the stamps will always be in the Tool Chest. 
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Appendix E – COMPASS Resources 

COMPASS Training Resources 
Please visit the DOT COMPASS Knowledge Center to access COMPASS resources, including: 

• Compass Support Desk 

• Training Videos 

• FAQs 

• Business Workflows 

• Additional Resources  

Business Processes 
All project staff – including project managers, reviewers, designers, consultants, contractors, etc. – should 
monitor their COMPASS accounts daily to assess Ball-In-Court statuses and ensure there is no lag in reviewing 
and routing submittals. 

Naming Conventions – Contractor Submittals 
File names should not exceed 50 characters in length.  Characters include letters, numbers, symbols, and 
spaces.  Submittal and file names should not contain any of the following restricted characters:  

~ “ # % & * : < > ? / \ { | }   
 

All submittal names and file names should accurately describe the contents of the submittal. 
 
Individual file document names created by contractors should be in the following format: 
 

Project Number [####-####] Submittal Type [WD, SD, RFI ###, RFC ###, etc.] [Description] 
Examples: 

1234-5678 WD Access Platform  
1234-5678 SD Exodermic Precast Panel 

1234-5678 RFI 001 Structural Steel 
1234-5678 Letter from Smith to Jones Winter Work 

 
Preconstruction file names should accurately reflect the description of the file.   

Examples: 
1234-5678 Stormwater Permit 

1234-5678 Design Approval 
1234-5678 Calendar Day Chart 

Revising Working Drawings & Shop Drawings 
If the submittal owner returns a shop drawing submittal with different dispositions stamped on each sheet, the 
Submitter / Contractor shall revise individual sheets as needed.  When the replacement document is ready to 
submit, the Submitter / Contractor shall combine into one file the approved sheets and replacement sheets.   

Computer Requirements – Maximum File Size 
SharePoint has a maximum file size of 250 MB.  This applies to individual file attachments and documents 
uploaded directly into the Internal Documents or Documents folders.  If a document exceeds this maximum, 
the user can break it up into multiple documents contained within the same submittal. 

COMPASS Troubleshooting 

https://ctgovexec.sharepoint.com/sites/DOTCOMPASSKnowledgeCenter
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Bluebeam Studio Session Finalization Process 
To maintain the Bluebeam integration with COMPASS, Studio Sessions should only be finalized via COMPASS as 
shown below and described in the Finalize Bluebeam Studio Session section.  Bluebeam Studio Sessions should 
not be finalized directly inside the Bluebeam Studio Session. 

YES:  

  

NO:  

  

Bluebeam Studio Session Expiration Date 
A Bluebeam Studio Session created through COMPASS is set to expire by default one month after its creation.  
If additional time is needed a user can either finalize the Session and launch a new one within COMPASS or 
extend the Session’s expiration date.   
To extend the Session’s expiration date: 
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Restoring Archived Bluebeam Studio Session 
Only the user who started a Bluebeam Studio Session can restore the Session if it becomes archived.  The 
below information is only applicable within 30 days of a Session being archived.  Bluebeam fully purges Studio 
Sessions from its server that have been closed more than 30 days. 

1) Hover of the document link in COMPASS to identify the Bluebeam Studio Session ID. 
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Navigate to https://studio.bluebeam.com and enter the Session host’s log-in credentials. 

 
 

2) Locate and click on the archived Studio Session. 

 
 

3) Change the status to Active, then Update data. 

Now the Session can be finalized inside COMPASS and the document in COMPASS will reflect any changes 

made in the Session. 

Incorrect Owner 
Q:  I was incorrectly assigned Owner of a submittal.  What should I do? 
A:  The two most common reasons a submittal is assigned improperly are that the project PM incorrectly 
completed the Approval Matrix, or the Submitter / Contractor selected the incorrect Submittal type in the 
Document Submittal page.  If this occurs, do not Start the review session.  First, check with the PM to ensure 
the Approval Matrix is properly set-up.  If this is confirmed, press Revise and Resubmit and communicate with 
the Contractor to correct the Type selection.    

Incorrect Information 

https://studio.bluebeam.com/
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Q:  Information in COMPASS is incorrect.  How do I fix this data? 
A:  Alert the project PM to the incorrect information.  Take screen shots if possible.  Most of the data found in 
COMPASS (e.g., finances, schedules, ROW, etc.) is pulled from source locations such as CORE.  The Staff names 
and Approval Matrix are manually inputted by the PM.  If there are errors in the data, the PM needs to correct 
manually inputted information or request a correction in the data source from which COMPASS is pulling 
information. 

Following Project Sites 
To follow a COMPASS Submittal / Transmittal Pilot Project Site: 

1. Navigate to the Submittal / Transmittal page of the given pilot project. 

2. In the upper right-hand corner of the screen, click Follow. 

 
 

3. When accessing the SharePoint Online dashboard, the project site will be listed in the Following 

section.  Clicking on the project number will route the user directly to the pilot project S&T page. 
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Appendix F – References – CTDOT Bulletins and Directives 

A sample of CTDOT Directives and Bulletins referenced in this manual are provided below.  See Engineering 
Information Resources for a comprehensive list of all current CTDOT Engineering and Construction Directives 
and Bulletins.   
 
Referenced Bulletins: 
ECB-2023-6 Digital Project Development Manual 
ECB-2023-5 Implementation of Traffic Signal Assets in Project Asset Form 
ECB-2023-4 Implementation of Bridge Assets in Project Asset Form 
EB-2023-3 Doing Business with CTDOT 
 
Referenced Directives: 
ECD-2023-9 Project Asset Form - Identifying Work Types and Work Codes by Asset 
ECD-2022-1 Project Document Control 
ED-2021-1 Design Phase Scheduling 
ECD-2020-1 Contractor Submittals 
ECD-2019-12 Managing Project Staff in COMPASS 
 
  

https://portal.ct.gov/DOT/Engineering-and-Construction-Directives-and-Bulletins/Engineering-Information-Resources
https://portal.ct.gov/DOT/Engineering-and-Construction-Directives-and-Bulletins/Engineering-Information-Resources
https://portal.ct.gov/-/media/DOT/documents/AEC/ECB-2023-6_Digital_Project_Development_Manual_final_jaf.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ECB-2023-5_Eng-Cons_Bulletin_PAF_Traffic_Sig_jaf.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ECB-2023-4_Eng-Cons_Bulletin_PAF_Bridge_2023_10_01_final_jaf.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/EB-2023-3-Doing-Business-with-CTDOT_2023-08-08_rmb.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2023-9_Eng-Cons_Dir_PAF_final_sah.pdf
https://portal.ct.gov/DOT/Engineering-and-Construction-Directives-and-Bulletins/-/media/DOT/documents/AEC/ECD-2022-1_Project_Document_Control_.pdf
https://portal.ct.gov/DOT/Engineering-and-Construction-Directives-and-Bulletins/-/media/DOT/documents/AEC/ED-2021-1_Design_Phase_Scheduling.pdf
https://portal.ct.gov/DOT/Engineering-and-Construction-Directives-and-Bulletins/-/media/DOT/documents/AEC/ECD-2020-1_Contractor_Submittals.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/ECD-2019-12_Compass_updated_2023_08_10.pdf
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Appendix G – Submittal Transmittal Form for Facilities Projects 

Please see next page for the Facilities Submittal Transmittal Form to be used by Construction Contractors.  See 
COMPASS Contractor's User Manual for instructions provided to contractor.  
 
 
 
 

https://portal.ct.gov/-/media/DOT/documents/AEC/COMPASS-Contractors-User-Manual.pdf?la=en


Submittal No.: CSI Spec or Special Provision No.:

Name: Contractor Representative

Comments:

Additional Submittal Disposition Stamps*

Comments:

Comments:

-Contractor to populate.

Additional disposition stamps and/ or comments may 

Contractor Certification:  "Having reviewed this submittal, I certify that it is complete, accurate, coordinated in all aspects of the item 

being submitted and conforms to the requirements of the Contract in all respects, including all federal requirements such as the 'Buy 

America Act (BAA)' and the “Build America, Buy America (BABA) Act,” except as otherwise noted."

Submittal Disposition Stamp

Submittal Transmittal Form

Contactor:

Address:

Telephone No.:

Project No.:

Description:

be within submittal.  Review complete returned submittal.

*- if necessary
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